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Notices

BioTek Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

All Rights Reserved

© 2014, BioTek® Instruments, Incorporated.  No part of this publication may be
reproduced, transcribed, or transmitted in any form, or by any means electronic
or mechanical, including photocopying and recording, for any purpose other
than the purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and MultiFlo™ FX Multi-Mode Dispenser is a
trademark of BioTek Instruments, Inc.

Microsoft®, Internet Explorer®, Windows®, Windows 7, Windows 8, Windows
Vista®, Windows XP, and Excel® are either registered trademarks or trademarks
of Microsoft Corporation in the United States and/or other countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a
commitment by BioTek Instruments, Inc. Changes made to the information in
this document will be incorporated in new editions of the publication.  No
responsibility is assumed by BioTek for the use or reliability of software or
equipment that is not supplied by BioTek or its affiliated dealers.
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Global Service and Support

BioTek instrument service and repair is available worldwide at several of BioTek’s
International Service Centers and in the field at your location. Contact the office
nearest you to arrange service or to get answers to your technical questions, call the
Technical Assistance Center (TAC) at 802-655-4740 in the US.

BioTek World Headquarters US BioTek China

Mailing Address:
PO Box 998, Highland Park
Winsooki, VT 05404-0998 United States

Service Shipping Address:
15 Tigan Street
Winooski, VT 05404 United States

Room 304, Tower D
Ocean International Center
62 Middle 4th East Ring Road
Chaoyang District
Beijing 100024
P.R. China

Phone: (800) 242-4685
Fax: (802) 654-0638

Phone: +86 (10) 85865569
Fax: +86 (10) 85861829

Email: TAC@biotek.com
Website: www.biotek.com

Email: infochina@biotek.com
Website: www.biotekchina.com.cn

BioTek Germany Service Center
& European Coordination Center

BioTek Instruments SAS
Bureau de liaison France

Kocherwaldstrasse 34 D-74177
Bad Friedrichshall
Germany

50 avenue d’Alsace
68025 Colmar Cedex
France

Phone: +49 (0) 71369680
Fax: +49 (0) 7136968111

Phone: +33 (3) 89206329
Fax: +33 (3) 89204379

Email: info@biotek.de
Website: www.biotek.de

Email: info@biotek.fr
Website: www.biotek.fr

BioTek India BioTek Singapore

Unit 223, Linkway Estate
New Link Road, MaladWest
Mumbai 400064
India

20 Science Park Road#01-08A
Teletech Park
Singapore 117674

Phone: +91 (22) 28789966
Fax: +91 (22) 28759944

Phone: +65 65922100
Fax: +65 67772611

Email: biotek@biotek.in Email: singapore@biotek.in

BioTek Instruments, Inc.
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BioTek India BioTek Singapore

Website: www.biotek.in Website: www.biotek.com

BioTek South Korea BioTek Switzerland

3F, Gyungnam building, 830-48
Yeoksam-dong, Gangnam-gu
Seoul, South Korea (135-936)

Zentrum FanhÖfli 8
6014 Luzern
Switzerland

Phone: +82 (0) 2-562-4740
Fax: +82 (0) 2-562-4750

Phone: +41 (41) 2504060
Fax: +41 (41) 2505064

Email: korea@biotek.com
Website: www.biotekinstruments.co.kr

Email: info@biotek.ch
Website: www.biotek.ch

BioTek United Kingdom (UK) BioTek Japan

6 Bull Street
Potton, Bedfordshire SG19 2NR
United Kingdom

8F Andoh Building
2-7-1 Taito, Taito-ku
Tokyo 110-0016 Japan

Phone: +44 (1767) 262000
Fax: +44 (1767) 262330

Phone: +81 (0)3 5812 8109
Fax: +81 (0)3 5812 8115

Email: info@biotek.uk.com
Website: www.biotek.uk.com

Email: infojapan@biotek.com Website:
www.biotek.com/ja

Revision History

Rev Date Changes

A 10/2013 First Issue

B 5/2014 The manual was updated to add RAD Technology content
throughout. Syringe dispenser installation steps were updated to
add the "Import from USB" calibration data feature. Added
references to new Peri-pump cassette types and new Syringe
dispenser manifolds. Added references to and some instructions
for running the BioStack 4 to process microplates with lids.
Updated the contents of the Cassette Calibration folder to match
improvements made to its separately purchased accessory kit:
PN 7170017. Refined the procedure to remove proteins from the
tubing by emphasizing the need to flush first with buffer.
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Document Conventions

This manual uses the following typographic conventions:

nThis note format calls attention to important information.

Warnings are presented in this style to call attention to potential hazards and
other safety concerns.

This icon calls attention to important safety information.

Tips and suggestions for improving performance are formatted this way.

Navigation instructions: how to get to the function being described

Intended Use Statement

l The MultiFlo™ FX Multi-Mode Dispenser provides microplate priming and dispensing, and
when equipped, washing, for ELISA™, fluorescence and chemiluminescence
immunoassays, cellular and agglutination assays.

l If the instrument has an "IVD" label it may be used for clinical and non-clinical purposes,
including research and development. If there is no such label the instrument may only be
used for research and development and non-clinical purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct Quality Control checks could result in
erroneous test data.

BioTek Instruments, Inc.
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Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your
product. Please also register your product with BioTek to ensure that you receive
important information and updates about the product(s) you have purchased.

You can register online through BioTek’s Customer Resource Center (CRC) at
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

Dispense Cassette Warranty

The Peri-pump dispense cassettes are backed by BioTek's Confidence-Plus lifetime
warranty. For the lifetime of the cassette, BioTek guarantees the cassette
components (Tip Holder, Center Holder, Tube Tensioner, and Tube Organizer) will
withstand steam autoclave conditions of 121°C and 1 bar (750 mmHg) without
adversely affecting dispense performance. In the event of a failure of any cassette
component previously listed, BioTek will replace the cassette components free of
charge.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact BioTek
for a Return Materials Authorization (RMA) number and use the original packing
materials. Other forms of commercially available packaging are not recommended
and can void the warranty. If the original packing materials have been damaged or
lost, contact BioTek for replacement packing.

Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.
When operated in a safe environment, according to the instructions in this
document, there are no known hazards associated with the MultiFlo FX.
However, the operator should be aware of certain situations that could result in
serious injury; these vary depending on the instrument type. See Hazards and
Precautions.

Strict adherence to instrument maintenance and qualification procedures is
required to ensure accurate dispense volumes and risk-free operation.

MultiFlo™ FX Multi-Mode Dispenser
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power cord must
be connected to a power receptacle that provides voltage and current within the
specified rating for the system. Use of an incompatible power receptacle may
produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a plug adapter to connect primary
power to the external power supply. Use of an adapter disconnects the utility
ground, creating a severe shock hazard. Always connect the power cord directly
to an appropriate receptacle with a functional ground.

Warning! Service. Only qualified technical personnel should perform service
procedures on internal components.

Warning! Accessories. Only accessories which meet the manufacturer’s
specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate carrier or
carrier track. Lubricant on the carrier mechanism will attract dust and other
particles, which may obstruct the carrier path and cause the instrument to
produce an error.

Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or instrument
damage. If a spill occurs while a program is running, abort the program and
turn the instrument off. Wipe up all spills immediately. Do not operate the
instrument if internal components have been exposed to fluid.

Warning! Unspecified Use. Failure to operate this equipment according to
the guidelines and safeguards specified in this manual could result in a
hazardous condition.

Warning! Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software parameters and
establishing washing or dispensing methods. Failure to conduct quality
control checks could result in erroneous test data.

Warning! Internal Voltage. Always turn off the power switch and unplug the
power supply before cleaning the outer surface of the instrument.

BioTek Instruments, Inc.
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Warning! Potential Biohazards. Some assays or specimens may pose a
biohazard. Adequate safety precautions should be taken as outlined in the
assay’s package insert. This hazard is noted by the symbol shown here. Always
wear safety glasses and appropriate protective equipment, such as chemically
resistant rubber gloves and apron.

Warning! Pinch Hazard. Some areas of the instrument or its components can
present pinch hazards when the instrument is operating. Depending on the
instrument or component, these areas are marked with the symbol shown here.
Keep hands/fingers clear of these areas when the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek authorized
service personnel. Only qualified technical personnel should perform
troubleshooting and service procedures on internal components.

Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may result in
a loss of warranty and potentially impair instrument performance or cause
damage to the instrument.

Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, ambient temperatures should
remain within the range listed in the Specifications section. Performance may
be adversely affected if temperatures fluctuate above or below this range.
Storage temperature limits are broader.

Caution: Sodium Hypochlorite. Do not expose any part of the instrument to
the recommended diluted sodium hypochlorite solution (bleach) for more than
20 minutes. Prolonged contact may damage the instrument surfaces. Be certain
to rinse and thoroughly wipe all surfaces.

Caution: Buffer Solution. Although many precautions have been taken to
ensure that the instrument is as corrosion-proof as possible, the instrument is
not sealed and liquids can seep into sensitive components. Make sure that any
spilled buffer solution is wiped off the instrument. Prolonged exposure to salt
solution may corrode parts of the microplate carrier, movement rail, springs,
and other hardware.

Caution: Chemical Compatibility. Some chemicals may cause irreparable
damage to the instrument. The following chemicals have been deemed safe for
use in the instrument: buffer solutions (such as PBS), saline, surfactants,
deionized water, 70% ethyl, isopropyl, or methyl alcohol, 40% formaldehyde,
and 20% sodium hydroxide. Never use acetic acid, DMSO, or other organic
solvents. These chemicals may cause severe damage to the instrument.

MultiFlo™ FX Multi-Mode Dispenser



Hazards and Precautions| xv

Contact BioTek for more information and prior to using other questionable
chemicals.

Caution: Bovine Serum Albumin. Solutions containing proteins, such as
bovine serum albumin (BSA), will compromise the instrument’s performance
over time unless a strict maintenance protocol is adhered to. See
Maintenance procedures regarding BSA.

Caution: Power Supply. Only use the power supply shipped with the
instrument. Operate this power supply within the range of line voltages listed
on it.

Caution: Disposal. This instrument contains printed circuit boards and wiring
with lead solder. Dispose of the instrument according to Directive 2002/96/EC,
“on waste electrical and electronic equipment (WEEE),” or local ordinances.

Caution: Warranty. Failure to follow preventive maintenance protocols may
void the warranty.

Caution: Shipping Hardware. All shipping hardware (e.g., shipping bracket
etc.) must be removed before operating the instrument and reinstalled before
repackaging the instrument for shipment.

Caution: Do not run the Peri-pump without a cassette installed on the pump.

Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the user’s
responsibility to ensure that a compatible electromagnetic environment for this
instrument is provided and maintained in order that the device will perform as
intended.

Caution: Electromagnetic Compatibility. Do not use this device in close
proximity to sources of strong electromagnetic radiation (e.g., unshielded
intentional RF sources), because these may interfere with the proper operation.

BioTek Instruments, Inc.
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CE Mark

Based on the testing described below and information contained
herein, this instrument bears the CE mark.

nNote: See the Declaration of Conformity for specific information.

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing
laboratory and found to meet the requirements of EN 61326-1: Class A for
Radiated Emissions and Line Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011
(CISPR 11) Class A. In a domestic environment it may cause radio interference,
in which case, you may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing
laboratory and found to meet the requirements of EN 61326-1 and EN 61326-2-6
for Immunity. Verification of compliance was conducted to the limits and
methods of the following:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was
found to meet the requirements of this Directive. Verification of compliance was
conducted to the limits and methods of the following:

MultiFlo™ FX Multi-Mode Dispenser
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EN 61010-1, “Safety requirement for electrical equipment for measurement,
control and laboratory use. Part 1, General requirements.”

EN 61010-2-081, “Particular requirements for automatic and semi-automatic
laboratory equipment for analysis and other purposes.”

Directive 2002/96/EC: Waste Electrical and Electronic Equipment

Disposal Notice: This instrument contains printed circuit boards and wiring with
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on
waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

l Product registration with competent authorities.
l Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101 Particular requirements for in vitro diagnostic (IVD) medical
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference, in which case the user
will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be
used with this equipment. Operation with non-approved equipment or
unshielded cables is likely to result in interference to radio and television
reception.

BioTek Instruments, Inc.
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Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant
les limites applicables aux appareils numerique de la Class A prescrites dans
le Reglement sur le brouillage radioelectrique edicte par le ministere des
Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet
the requirements of the following:

l Underwriters Laboratories UL 61010-1 “Safety requirements for electrical
equipment for measurement, control and laboratory use; Part 1: general
requirements.”

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1 “Safety
requirements for electrical equipment for measurement, control and
laboratory use; Part 1: general requirements.”

l EN 61010 Standards, see CE Mark on page xvi.

MultiFlo™ FX Multi-Mode Dispenser
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Both direct and alternating current
Courant continu et courant alternatif
Gleich - undWechselstrom
Corriente continua y corrientealterna
Corrente continua e
correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

Earth ground terminal
Borne de terre
Erde (Betriebserde)
Borne de tierra
Terra (difunzionamento)

On (Supply)
Marche (alimentation)
Ein (VerbindungmitdemNetz)
Conectado
Chiuso

Protective conductor terminal
Borne de terre de protection
Schutzleiteranschluss
Borne de tierra de protección
Terra diprotezione

Off (Supply)
Arrêt (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto
(sconnessionedallaretedialimentazio
ne)

Caution (refer to accompanying
documents)
Attention (voir documents
d’accompanement)
AchtungsieheBegleitpapiere
Atención (vease los
documentosincluidos)
Attenzione, consultare la doc annessa

Warning, risk of electric shock
Attention, risque de choc électrique
Gefährlicheelektrischeschlag
Precaución, riesgo de
sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

Warning, risk of crushing or pinching
Attention, risqued’écrasement et
pincement
Warnen, Gefahr des Zerquetschens
und Klemmen
Precaución, riesgo del
machacamiento y sejeción
Attenzione,
rischiodischiacciareedintrappolarsi

Warning, hot surface
Attention, surface chaude
Warnen, heißeOberfläche
Precaución, superficiecaliente
Attenzione, superficiecalda

Warning, potential biohazards
Attention,
risquesbiologiquespotentiels
Warnung!
MoeglichebiologischeGiftstoffe
Atención, riesgosbiológicos
Attenzione, rischiobiologico

In vitro diagnostic medical device
Dispositif médical de diagnostic in
vitro
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnóstico in

Separate collection for electrical and
electronic equipment
Les équipements électriques et
électroniques font l’objet d’une
collecte sélective
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vitro
Dispositivo medico diagnostico in
vitro

Getrennte Sammlung von Elektro-
und Elektronikgeräten
Recogida selectiva de aparatos
eléctricos y electrónicos
Raccolta separata delle
apparecchiature elettriche ed
elettroniche

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso
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Introducing the MultiFlo™ FX Dispenser

The MultiFlo FX offers several devices in one instrument: one or two peristaltic
pump dispensers called the Peri-pump, a dual Syringe pump dispenser, and either
a strip Washer or a single-channel Random Access Dispenser (RAD) module. The
MutliFlo FX is available in multiple configurations to support numerous
microplate geometries.

Device/Component Description

1 Peri-pump Dispenser Peristaltic, 8-channel dispenser with entirely visible fluid
path.

2 Dispense arm Holds the Peri-pump Tip Holder(s), the Syringe dispenser
manifolds and the washer dispense manifold, when
applicable.

MultiFlo™ FX Multi-Mode Dispenser
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Device/Component Description

3 Aspirate/RAD arm Washer and RAD models only: holds the strip washer's
aspirate manifold or the RAD cassette's tip holder.

4 Priming trough Waste reservoir for collecting or disposing of priming fluid.
Priming trough inserts, for collecting fluid, are shown in this
image.

5 Plate Carrier Holds standard microplates for processing.

6 Touch screen One of two ways to control the MultiFlo FX; the other way is
LHC.

7 Strip Washer An external module containing a syringe-pump dispenser
and vacuum aspiration pump.

8 Syringe Dispenser Another external module with two distinct syringe-pump
dispensers that support a variety of manifold types to
process standard and low-density microplates.

9 Peri-pump Dispenser Secondary or external Peri-pump dispenser (required for
RAD models).

See Plate Types Table on page 9 to review the plate types supported by each
device.

Features of the MultiFlo FX

l Supports all microplate-based assays, including ELISA, fluorescence,
chemiluminescence, RIA, DNA probes, and cellular assays.

l A variety of solutions, including buffered saline and reagents can be dispensed.

l The intuitive onboard software allows you to create and store wash and dispense
protocols. BioTek provides numerous predefined protocols for maintenance and
instrument qualification purposes.

l Two USB flash drive ports facilitate file transfer and storage.

l A low-maintenance design, the result of BioTek’s long history with liquid-handling
instruments.

l Compatible with BioTek’s BioStack™ Microplate Stacker for automated plate processing.

l A robot-accessible carrier that can be interfaced into some robotic systems.

l Computer control using BioTek’s Liquid Handling Control™software (“LHC”).

Washer

BioTek Instruments, Inc.
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l Programmable dispense volumes, and a wide range of wash options, from gentle
washing for cellular assays to vigorous washing for ELISA.

l A “bottom washing” routine to lower the background absorbance and “crosswise” or
secondary aspiration to reduce residual volumes.

l Supports Wash, Prime, Dispense, and Aspirate steps.

l Several predefined protocols are provided to simplify preventative maintenance, which
should be performed regularly to ensure optimum washer performance.

Peri-pump Dispenser

l A peristaltic pump with eight individual tubes transfers fluid from a supply bottle, or up
to eight different supply bottles, to various vessels. The pump has four rollers over which
the tubing is stretched.

l The tubing is contained in an easy to load and unload cassette that is attached to the
pump head. The pump’s protective cover must be in place to run a dispense routine.

l Three tubing sizes are available: 1 µL, 5 µL, and 10 µL for the most precise dispensing of
volumes from 1 to 30,000 µL and 0.5 µL dispenses when using a 1 µL cassette.

l RAD™ Technology models support "random access dispensing" with several single-
channel cassette options, including a bulk dispensing cassette (8 tubes to one chute) with
flow tracking to minimize turbulence in the wells.

l Autoclavable tubing (steam temperatures and pressures of 121° C and 1 bar
(750 mmHg)) is compatible with 70% ethyl or isopropyl alcohol and 0.5% sodium
hypochlorite (bleach) solution for easy maintenance.

Syringe Dispensers

l The Syringe dispenser has a long-lasting seal that ensures precise and accurate fluid
delivery, as well as reproducibility for repeated dispenses.

l Two syringe pumps support distinct fluid sources and dispense manifolds:
o 16-channel: one tube per well for 384-well plates and two tubes per well for 96-
well plates.

o 32-channel: one tube per well for 1536-well plates.

o 8-channel (two manifolds in one block): one tube per well for both 96- and 384-
well plates.

l Autoclavable components can be used with organic solvents and provide easy
maintenance.

l Does not require recalibration

Low-density Microplate-specific Syringe Manifolds

Plate-specific dispense manifolds with angled dispensing for cellular assays:

MultiFlo™ FX Multi-Mode Dispenser
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l 6-well plate: 8-channel dispense manifold (4 tubes/well).

l 12-well plate: 9-channel dispense manifold (3 tubes/well).

l 24-well plate: 8-channel dispense manifold (2 tubes/well).

l 48-well plate: 12-channel dispense manifold (2 tubes/well).

Liquid Handling Control™ (LHC) Software

BioTek’s Liquid Handling Control (LHC) software lets you control the instrument
from your computer. You’ll enjoy the convenience of programming assay-specific
wash and dispense protocols in a familiar Windows environment (Microsoft®
Windows® 7, Windows 8, and Windows XP).

For high-throughput applications, the LHC supports BioStack™ integration.

Please refer to the LHC Installation Guide and Help system to learn about:
o Installing the LHC software on the controlling computer

o Running Maintenance protocols

o Running Qualification protocols

o Special considerations when operating with the BioStack Microplate Stacker

RAD™ Technology Features

Random Access Dispensing or RAD models offer the most gentle dispensing
possible to support sensitive cellular assays. The single-tube cassettes are ideal for
reagent preservation, hit-picking or partial plate filling. The 8-to-1 channel bulk -
dispensing cassettes are designed to preserve cell monolayers in low-density
plates. An external Peri-pump powers the RAD cassettes, which are not compatible
with the internal Peri-pump.

At a glance:

Features Single-tube 8-to-1 tube

Plate
Types

6- to 384-well 6-, 12-, 24-well

Cassette
tubing

1 µL, 5 µL, or 10 µL 5 µL only

Primary
Uses

Random dispensing in 48-,
96-, and 384-well plates

Fast but gentle dispensing with "Tip Tracking"

Example
Application

Dispensing costly reagent -
lowest dead volume

Media addition to cells in low-density plates

BioTek Instruments, Inc.
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Features Single-tube 8-to-1 tube

Other Hit picking: fast, intuitive
selection of individual
wells, rows, or columns;
Access and preserve more
reagent: single tube can
handle minute quantities of
reagent.

Tip Tracking: gradually raises the tip chute as
fluid is dispensed to the well to ensure the least
disturbance possible. See RAD Tip Tracking on
page 156.

cell monolayer is preserved

MultiFlo FX Models

Model Internal Peri-pump Strip Washer RAD Technology

MFX

MFXW X

MFXP X

MFXPW X X

MFXR X

MFXPR X X

The Syringe and secondary Peri-pump dispensers are ordered separately. Except
RAD models include the external Peri-pump.

MultiFlo™ FX Multi-Mode Dispenser



MultiFlo FX Dispenser Comparison | 7

MultiFlo FX Dispenser Comparison

Counting the washer as a potential dispenser, the MultiFlo FX offers three distinct
dispensers. Here is a comparison of the devices:

nFor precious reagents use the Peri-pump to preserve unused fluids. It has
the shortest, most visible fluid path, and a Purge capability to reverse the fluid
flow to recover fluid from the tubing. Another advantage is the ability to
dedicate a dispense cassette to use with one reagent only, reducing the
amount of priming required prior to use. And, you can shorten the tubing to
further reduce the dead volume: See Shorten the Dispense Cassette
Tubing on page 61.

nRAD Technology offers the best tools for preserving cells and reagents.

nAll MultiFlo FX devices are capable of dispensing up to 30,000 µL. BioTek's
recommended maximum dispense volumes are cited here.

Device
Volume
range
µL/well

Precision Accuracy Approximate Dead
volume

Peri-pump 0.5‡, and
1-3000*

<10% CV
@ 1
µL/well
(typical
<3% CV)

+/-10%
(typical
+/-3%) @
1 µL/well

Cassette Type:

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

RAD
Technology

0.5‡, and
1-
30,000*

<10% CV
@ 1
µL/well
(typical
<3% CV)

+/-10%
(typical
+/-3%) @
1 µL/well

Type Dead Vol.

1 µL 150 µL

5 µL 530 µL

10 µL 920 µL

Syringe 8-
tube/6-well

10-3000 <5% CV @
20 µL/well

±2 µL @
10
µL/well

For all manifold types:
12 mL

Syringe 16-tube 5-3000 <10% CV
@ 5
µL/well

±2 µL @
10
µL/well

Syringe 12-/24- 5-30,000 <3% CV @ ±2 µL @

BioTek Instruments, Inc.
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Device
Volume
range
µL/well

Precision Accuracy Approximate Dead
volume

/48-well certain
µL/well

any
µL/well

Syringe 32-tube 3-3000 <12% CV
@ 6
µL/well 

±5%@ 6
µL/well

Strip Washer 20 –
30,000

≤3.0 - 5.0
% CV¥

≤±3.0% 12 mL

*1 µL cassettes' maximum recommended dispense volume is 50 µL/well.
‡ 0.5 µL dispensing is supported when using a 1 µL cassette.
¥ Depending on wash manifold,See Performance Specifications on page 21.

BioTek recommends priming a dispenser with three times its dead volume to
prepare it for accurate dispensing.

Processing Time §

Protocols were optimized for speed to obtain the following processing times,
including the fastest flow and travel rates. Some of these parameters are listed in
the Parameters column of the table. Only standard, non-RAD Peri-pump
cassettes are referenced here.

Device Plate
Type

Volume
(µL/well)

Parameters Time in
seconds ¥

Peri-pump - 5 µL 96 10 High flow rate 3
Peri-pump - 1 µL 384 1 High flow rate 6

1536 1 High flow rate 21
Syringe 8-tube 96 20 Flow rate 1 6.5
Syringe 16-tube 96 20 Flow rate 1 5.25

384 20 Flow rate 1 14
Syringe 32-tube 1536 3 One SB manifold 16.5

1536 14 One LB manifold 27
Strip Washer 96 300 3 cycles <105

§ Review the Specifications for more details.

¥ Excluding plate carrier and manifold homing movements.

SB = small bore Syringe manifold; LB = large bore manifold.

MultiFlo™ FX Multi-Mode Dispenser
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Plate Types Table

Only the Peri-pump can process all plate types. Washer manifolds are named for
plate types they process. Only the 32-tube Syringe dispenser manifolds and the
Peri-pump can dispense to 1536-well plates.

Plate Type
Columns x
Rows

Plate
Height Default Aspirate &

Dispense Heights

mm Washer Dispensers

96 Well 12x8 14.35 84 336

96 Deep Well 12x8 41.50 N/A  929

 96 Half Well^ 12x8 14.20 84  332

96 Mini Tubes 12x8 49.53 N/A 1105

384 Well 24x16 14.22 64 333

384 Deep Well 24x16 44.08 N/A 986

384 PCR 24x16 9.50 6 230

1536 Well 48x32 10.41 N/A 250

1536 Flanged‡ 48x32 10.26 N/A 196

N/A = Plate washing not supported for this plate type.

Low-Density Plates: Peri-pump (non-RAD), Strip Washer, Syringe

Plate
Type

columns
x rows

Plate Ht.
(mm)

Dispense Ht.
(steps)

PP tubes/
well

Washer/Syringe¥
tubes/well

6 Well 3x2 20.20 465 4* 4

12
Well

4x3 20.20 460  2* 3

24
Well

6x4 20.50 452 2 2

48
Well

8x6 20.10 460  1* 2

Aspirate Ht. default setting = 51 steps (2.07 mm) for all these plate types.

^ Syringe dispenser requires standard 8-channel manifold; washer manifoldmust be 96/384-well.
‡ Only 1536 Flanged (153F) plates have a "flange height" greater than zero. These plates require

BioTek Instruments, Inc.



10 | Chapter 1: Introduction

special handling.
¥Plate-type specific manifolds: The correct volume-per-tube tomeet the specified per-well volume is
dispensed. (Does not apply to non-RAD Peri-pump cassettes!)

*Important: when dispensing to 6-, 12-, 24- and 48-well plates (with a non-RAD cassette) some
dispense tubes must be removed from the Peri-pump's fluid supply vessel.See Handling Special
Plates and Mini-tubes on page 134.

Plate Geometry Diagram

l Plate height = physical measurement

l Default Dispense Height = (plate height - flange height + 1.0 mm)

l Travel Height = (plate height - flange height + Plate Clearance)

n If the Dispense Height is greater than Travel Height, the travel height is
changed to match the dispense height.

BioStack Compatibility

The MultiFlo FX is compatible with BioTek’s BioStack Microplate Stacker. The
BioStack can rapidly transfer microplates one-at-a-time to and from the instrument,
and includes:

l Removable stacks (one input and one output).

l Optional restacking of plates to maintain correct sequencing.

l The ability to continue processing plates following the aborting/failure of
one plate.

l The ability to pause processing to allow the user to add more plates to the

MultiFlo™ FX Multi-Mode Dispenser
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input stack or to remove some from the output stack.

l De-lidding and re-lidding capability with BioStack 4.

If you have purchased the BioStack to operate with the MultiFlo FX, refer to the
BioStack Operator’s Manual for instructions on configuring the MultiFlo FX to run
with the BioStack. To help you get started: See Operating with the BioStack on
page 124.

If you are interested in purchasing the BioStack, contact your local BioTek dealer
for more information or visit our website at www.biotek.com.

BioTek Instruments, Inc.
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Package Contents

nPart numbers and package contents are subject to change and vary according
to instrument model. Please contact BioTek Customer Care if you have any
questions.

Description PN

Power cord (part numbers vary by country of use) Varies

Power supply 76077

RS-232 serial cable 75034

USB cable (USB Virtual COM Port Driver Software & instructions) 75108

Microplate carrier 7170501

Priming trough insert (1 or 2) for Peri-pump 7182043

Priming trough insert for Syringe dispensers (2) and Strip washer
or RAD dispenser

7182044

Strip plate (12x1) 98265

Screwdriver, Phillips 98268

Accessory kit 1260004

Stylus: for cleaning washer and Syringe manifold dispense tubes 2872304

10 cc syringe and tubing for Peri-pump cassette maintenance 7210021

Shipping brackets (2) - model dependent 1262010
1262011
1262115

Hex wrench: 7/64" for removing shipping brackets 48169

Peri-pump Reservoir Holder (2 holders + 4 straps) 7212034
7212035

MultiFlo™ FX Getting Started Guide (and operator’s manual on USB
- PN 1261000)

1261006

nSome components are model specific, they ship only with certain instrument
models.

MultiFlo™ FX Multi-Mode Dispenser
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Optional Accessories

nPart numbers and package contents are subject to change and vary according
to instrument model. Please contact BioTek Customer Care if you have any
questions.

General Instrument Accessories

Description PN

BioTek liquid testing solutions for
instrument qualification tests

Wetting
Agent

7773002

Blue Test
Dye

7773001

Special plate carrier for mini-tubes 7212042

Liquid Handling Control™ Software LHC2

BioStack™ Microplate Stacker and integration kit Biostack

Installation-Operational-Performance Qualification (IQ-
OQ-PQ) package

1260521 

Peri-pump Optional Accessories

Secondary Peri-pump assembly: PN 7210010

Dispense cassettes and accessories:

Cassette Type Cassette Tips Replacement
tubing kit*

Tubing
extension

kit

1 µL plastic tips 7170012 7172150

7170009 71700221 µL 1536-well, plastic tips 7170018 7172150

1 µL sapphire jeweled
stainless steel tips*

7170015 48692

1 µL 1536-well, sapphire
jeweled stainless steel tips*

7170016 48692

BioTek Instruments, Inc.
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Cassette Type Cassette Tips Replacement
tubing kit*

Tubing
extension

kit

5 µL plastic tips 7170011 7172059 7170008 7170021
5 µL stainless steel tips 7170014 7172128

5 µL plastic, large bore tips 7170024 7172039

10 µL plastic tips 7170010 7172059 7170007 7170020
10 µL stainless steel tips 7170013 7172128

10 µL plastic, large bore tips 7170024 7172039

*Save your stainless steel tips for reuse with a replacement kit, they ship with plastic tips.

RAD‡ Technology Cassettes PN

10 µL Single molded tip 1260015

5 µL Single molded tip 1260016

1 µL Single molded tip 1260017

10 µL Single steel tip 1260018

5 µL Single steel tip 1260019

1 µL Single steel tip 1260021

10 µL Large-bore single molded tip 1260020

Bulk dispenser: 8 tube to 1 chute (5 µL
tubing, molded tips)

1260022

‡Random Access Dispenser (RAD)

Accessory PN

Cassette Calibration Kit 7170017

Peri-pump Reservoir Holder 7210509

40 mL Priming Trough Insert 7182109

Syringe Dispenser Optional Accessories

Accessory PN

Autoclavable Syringe Dispenser Module: 16-Tube Manifold (2) 7180006S

MultiFlo™ FX Multi-Mode Dispenser
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Accessory PN

Non-Autoclavable Syringe Dispenser Module 7210009

Autoclavable Syringe Dispenser Module 7210008

8-Tube (2 x 8 channel) Manifold (1) 7180548S

16-Tube Manifolds (2) 7180543S

32-Tube Small Bore (SB) Manifolds (2) 7180533S

32-Tube Large Bore (LB) Manifolds (2) 7180534S

6-Well-Plate Manifold: 8-tubes (4 tubes/well) 1260537S

12-Well-Plate Manifold: 9-tubes (3 tubes/well) 1260536S

24-Well-Plate Manifold: 8-tubes (2 tubes/well) 1260535S

48-Well-Plate Manifold: 12-tubes (2 tubes/well) 1260534S

Stylus – for cleaning 8-/16-tube dispense manifold tubes 2872304

Stylus – for cleaning 32-tube LB dispense manifold tubes 7182095

Stylus – for cleaning 32-tube SB dispense manifold tubes 7182102

Inline Filters (2) 48705

Hex wrench: 3/32” for removing syringe pumps 48570

Hex wrench: 1/16” for removing magnets from dispense manifolds 48713

Spare tubing sets (2 - 1/dispenser), autoclavable 7183006

DMSO- & Acetonitrile-safe tubing sets (2 - 1/dispenser) 7183002

Special large-bore 8-tube manifold for 96-well plates 7180549S

Strip Washer Optional Accessories

Accessory PN

Fluid Supply Kit 1263007

Waste Bottle and Tubing Kit 1263001

Waste Bottle with Sensor 4070545

BioTek Instruments, Inc.
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Accessory PN

Spacer Block (substitute for Syringe manifolds) 1262038

Muffler 4073009

Thumb screws 01262

Vacuum Line Filter 48146

Tubing Bracket 1262066

Washer Manifold Kits

Manifold Type Accessory PN

96/384-Well
Accessory Kit 1260013

Dispense Manifold 1262028

Aspirate Manifold 1262029

6-Well Accessory Kit 1260009

Dispense Manifold 1262052

Aspirate Manifold 1262053

12-Well Accessory Kit 1260010

Dispense Manifold 1262050

Aspirate Manifold 1262051

24-Well Accessory Kit 1260011

Dispense Manifold 1262048

Aspirate Manifold 1262049

48-Well Accessory Kit 1260012

Dispense Manifold 1262046

Aspirate Manifold 1262047

Magnetic Bead Assay Accessories

Accessory PN

Magnet Adapter (to support the magnet on the plate carrier) 1262063

Magnets:

MultiFlo™ FX Multi-Mode Dispenser
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Accessory PN

384-well Flat Magnet 7103017

384-well Ring Magnet 7102215

96-well Flat Magnet 7103016

96-well Ring Magnet 7102216

BioTek Instruments, Inc.
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Physical Specifications

Labware

Microplates 96-well, 384-well, and 1536-well that comply with ANSI/SLAS
microplate standards 1-2004, 2-2004, 3-2004, and 4-2004. 96-well
standard, half-height, deep; 384-well standard, deep, PCR; 1536-
well standard and flanged. The Peri-pump and plate-type specific
washer and syringe manifolds also support 6- (Corning® 3516), 12-
(Corning 3513), 24- (Corning 3524), and 48- (Corning 3548) well
plates when special handling instructions are followed. Corning 96-
Well Cluster Tubes (PN: 4410, 4411), called Mini-tubes in this
application, are supported using a special plate carrier.

Microstrips 1 x 8, 1 x 12

Microwells Flat, round, "V” bottom

Hardware & Environmental

User Interface 5.7" touch screen

Power Supply The instrument uses two internal power supplies: 24-volt 60 watt and
48-volt 60 watt. These supplies are compatible with 100-240 V~; 50-
60 Hz.

Dimensions
(W x D x H)

Approximately 17.19 x 11.75 x 8.0 inches (44 cm x 29 cm x 20 cm)
base model (without strip washer, external Peri-pump, or Syringe
dispenser).

Weight (≤) 19.5 lb (8.8 kg)

Operating
Conditions

10° - 40°C (50° - 104°F)

Relative Humidity The instrument should be operated in a non-condensing humid
environment having a maximum relative humidity of 80% at
temperatures up to 31°C decreasing linearly to 50% relative humidity
at 40°C.

Peri-Pump

Peristaltic pump: Positive-displacement peristaltic pump with 4 rollers that stretch
the 8 tubes (one per channel) to deliver fluid.

MultiFlo™ FX Multi-Mode Dispenser
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Cassette
Types

Dispense
range Cassette Life Dead Volume

1 µL 0.5, 1 - 30,000
µL

1000 384-well plates @ 5
µL/well

1.2 mL

5 µL 5 - 30,000 µL 1000 96-well plates @ 50
µL/well

4.2 mL

10 µL 10 - 30,000 µL 1000 96-well plates @ 100
µL/well

7.4 mL

RAD ™ technology cassettes

Single-tube
(any µL)

0.5*, 1 - 30,000
µL

1 µL: 16,000 wells @ 5 µL Type Dead Vol.

1 µL 150 µL

5 µL 530 µL

10 µL 920 µL

5 µL: 12,000 wells @ 50 µL

10 µL: 12,000 wells @ 100 µL

8-to-1 tubes
(5 µL)

5 - 30,000 µL N/A 4.2 mL

* Requires 1 µL tubing

Syringe Dispenser

Two external positive-displacement syringe pump dispensers which support
various manifold types.

Manifold Type

8-Tube 2 x 8-channel non-autoclavable manifold with replaceable stainless
steel tubes to process 96- and 384-well plates.

16-Tube 1 x 16-channel autoclavable manifold with replaceable stainless steel
tubes to process 96- and 384-well plates.

32-Tube 1 x 32-channel manifold cannot be autoclaved, and does not support
non-factory tube replacement. An inline 90-micron filter is included
to minimize clogs. For 1536-well plates only. Two models: large bore
(LB) and small bore (SB).

Plate-Type-Specific Manifolds:

6-Well 1 x 8-channel autoclavable manifold (4 tubes/well) with replaceable
stainless steel tubes to process 6-well plates. Tubes are angled 7
degrees to minimize turbulence in the wells.

12-Well 1 x 9-channel autoclavable manifold (3 tubes/well) with replaceable

BioTek Instruments, Inc.



20 | Chapter 1: Introduction

Manifold Type

stainless steel tubes to process 12-well plates. Tubes are angled 7
degrees to minimize turbulence in the wells.

24-Well 1 x 8-channel autoclavable manifold (2 tubes/well) with replaceable
stainless steel tubes to process 24-well plates. Tubes are angled 7
degrees to minimize turbulence in the wells.

48-Well 1 x 12-channel autoclavable manifold (2 tubes/well) with replaceable
stainless steel tubes to process 48-well plates. Tubes are angled 7
degrees to minimize turbulence in the wells.

Supply bottle volume Two 1L bottles: glass for autoclavable models or plastic for
non-autoclavable.

Strip Washer

The external strip washer module uses a non-autoclavable positive-displacement
syringe pump to dispense fluid and a vacuum pump to aspirate fluid. Its dual-
action design uses separate, plate-type-specific manifolds for aspirating and
dispensing.

Manifold Type

96/384-Well 1 x 8-channel dispense and aspirate manifolds to process 96- and
384-well plates.

48-Well 1 x 12-channel dispense manifold (2 tubes/well) and 1 x 6-channel
aspirate manifold to process 48-well plates.

24-Well 1 x 8-channel dispense manifold (2 tubes/well) and 1 x 4-channel
aspirate manifold to process 24-well plates.

12-Well 1 x 9-channel dispense manifold (3 tubes/well) and 1 x 3-channel
aspirate manifold to process 12-well plates.

6-Well 1 x 8-channel dispense manifold (4 tubes/well) and 1 x 2-channel
aspirate manifold to process 6-well plates.

Waste bottle volume One 2L vessel; optional accessory includes a waste sensor.

Supply bottle volume Two 2L plastic bottles (non-autoclavable).

MultiFlo™ FX Multi-Mode Dispenser
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Performance Specifications

Peri-Pump Dispenser

Precision is measured for a whole 96-well or 384-well plate (12- or 24-well plate for RAD
technology) using room-temperature deionized or distilled water with 0.1% Tween 20 with
FD&C #1 blue dye. Precision is measured for 1536-well plates by dispensing to 384 wells, 12
columns with a 15% isopropyl alcohol solution. The absorbance of the solution is read at 630
nm and 450 nm reference. Specifications apply to volumes that are full unit increments for the
cassette to which they apply, except the 1 µL cassette also supports 0.5 µL increments when
dispensing this volume. For example: the precision specification for a 10 μL cassette is valid
at 10, 20, 30, ..., 3000 μL; the 1 µL cassette precision specification is valid at 0.5, 1, 2, 3, ...,
30,000 µL.

Accuracy is measured gravimetrically when dispensing room-temperature deionized water.
Specifications apply to volumes that are full unit increments for the cassette to which they
apply. For example: the accuracy specification for a 10 µL cassette is valid at 10, 20, 30, ...
30,000 µL.

Cassette Precision Accuracy

1 µL 10%CV  @ 1 µL per well ± 10%@ 1 µL per well

5%CV  @ 2 µL per well* ± 5%@ 2 µL per well*

10%CV  @ 0.5 µL per well n/a

5 µL 5%CV  @ 5 µL per well ± 4%@ 5 µL per well

2.5%CV  @ 10 µL per well* ± 2%@ 10 µL per well*

10 µL 4%CV  @ 10 µL per well ± 4%@ 10 µL per well

2%CV  @ 20 µL per well* ± 2%@ 20 µL per well*

* These specifications are for these dispense volumes and higher.

Exception: the accuracy specs above apply to the RAD technology bulk-dispensing cassette, 8
tubes-to-1 (chute) with 5 µL tubing for volumes that are 8 times the full unit increments for
the cassette, e.g. valid at 40, 80, 160, ... 30,000 µL:

l ± 4% when volume is 40 µL/well

l ± 2% when volume is ≥80 µL/well.
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Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL

With strict adherence to best practices and maintenance recommendations, this is
the typical longevity of the dispense cassettes.

Syringe Dispensers

Precision is measured for a whole 96-well or 384-well plate using room-temperature
deionized or distilled water with 0.1% Tween 20 with FD&C #1 blue dye. Precision is
measured for 1536-well plates by dispensing to 384 wells, 12 columns with a 15% isopropyl
alcohol solution. The absorbance of the solution shall be read at 630 nm and 450 nm
reference.

Accuracy is measured gravimetrically when dispensing room-temperature deionized water.

Dispense Precision

8-Tube ≤ 2% CV when dispensing 100 µL/well
≤ 5% CV precision at 20 µL/well
≤ 5% CV precision at 40 µL/well **
** Tested in-house to <4.0% CV.

16-Tube ≤ 2% CV when dispensing 100 µL/well
≤ 2.5% CV precision at 80 µL/well***
≤ 5% CV precision at 20 µL/well
≤ 10% CV precision at 5 µL/well*
*unspecified for non-autoclavable syringe pumps.
*** Tested in-house to <1.6% CV.

32-Tube < 12% CV when dispensing 6 µL per tube

Dispense Accuracy

8-Tube For all volumes 2 µL or 1%, whichever is greater, at flow rate 2.

16-Tube For all volumes 2 µL or 1%, whichever is greater, at flow rate 2.

32-Tube ± 5% when dispensing 6 µL/well at flow rate 3.
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Low-Density-Plate-Specific Manifolds

Dispense Precision

Refer to the values below for dispense precision when measured in full plates with the
specified volume of deionized water with 0.1% Tween 20 and FD&C#1 blue dye solution
and read at 630 nm/405 nm.

Plate Type Performance Volume (µL/well)

6-Well ≤5.0% CV 5560

12-Well ≤3.0% CV 2240

24-Well ≤3.0% CV 1120

48-Well ≤3.0% CV 560

Dispense Accuracy is measured gravimetrically when dispensing any volume of room-
temperature deionized water using Flow Rate 2. For all plate-specific manifolds, dispense
accuracy shall be 2 µL or 1%, whichever is greater.

Strip Washer

Residual Volume (Evacuation Efficiency)

96-
Well

Average residual of ≤2.0 µL per well after a 3-cycle wash when dispensing 300
µL per well using a bottom-touching well aspiration and a solution of deionized
water with 0.1% Tween® 20 or equivalent buffer solution. (The aspirate height
adjustment should be optimized for the plate prior to testing.)

6-, 12-,
24-,
48-
Well

Refer to the table below to determine the average residual volume per well after
dispensing the specified µL-per-well using a bottom-touching well aspiration and
a solution of deionized water without Tween in flat-bottomed plates. (The
aspirate height adjustment should be optimized for the plate prior to testing.)

Washer Manifold Volume (µL/well) Travel Rate Residual Volume (µL/well)

6-well 5560 0 CW 600

12-well 2240 0 CW 150

24-well 1120 0 CW 50

48-well 560 0 CW 25
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Dispense Precision

Refer to the values below for washer dispense precision when measured in full plates with
the specified volume of deionized water with 0.1% Tween 20 and FD&C#1 blue dye
solution and read at 630 nm/405 nm.

Plate Type Performance Volume (µL/well)

96-Well ≤3.0% CV 300

6-Well ≤5.0% CV 5560

12-Well ≤3.0% CV 2240

24-Well ≤3.0% CV 1120

48-Well ≤3.0% CV 560

384-Well ≤3.0% CV 80

Dispense Accuracy

Washer dispense accuracy shall be ≤±3.0% when deionized water with 0.1% Tween 20
(and FD&C#1 blue dye) solution. The weight of the fluid dispensed shall be measured
gravimetrically.

Plate Type Volume (µL/well)

96-Well 300

6-Well 1120

12-Well 2240

24-Well 1120

48-Well 560

384-Well 80
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Space Requirements

The Physical Specifications on page 18 describe the width (W), depth (D) and height
(H) of the base unit of the MultiFlo FX without an external Peri-pump, Syringe
dispenser, or Washer installed. Likewise, the space required for the bottles, tubing
and power cables is omitted.

Beginning with the base unit dimensions, add space for accessory devices and vessels:

l Expect a depth of 20" (51 cm) when installing a Strip washer and/or Syringe dispenser to
the back. Similarly, expect to add 8" (20 cm) to the depth when installing the RAD
technology dispenser.

l Add 4"-5" to the depth or width for fluid supply and waste bottles, depending on
placement.

l Plan on a height of approximately 12" (31 cm) when installing the washer: the waste
bottle is the tallest accessory, or (if the waste bottle resides elsewhere) at least 10" to
accommodate the washer tubing bracket.

l When an external Peri-pump or Syringe dispenser is installed on top, the height
increases to about 10", which is required for RAD™ technology.
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l Increase the width requirement to include the side tubing bracket and/or supply vessels.

l BioStack integration requires a width of at least 34" in the standard 90° interface. Find
more details in the BioStack Operator's Manual.

BioTek's Customer Resource Center

BioTek's Customer Resource Center (CRC) continues our tradition of superior
service and support. After an easy registration process, you can access lots of
useful information about your BioTek microplate instrumentation and software. On
the secure CRC website, you can:

l Track orders

l Access warranty information, user manuals and software updates

l Download technical and application information

l Maintain equipment inventory (product registration)

l Request service and technical support

l View service history

l And much more!

Register at https://customer.biotek.com

nDispense cassette data sheets are available for download at the CRC.

MultiFlo™ FX Multi-Mode Dispenser
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Installation

This chapter provides detailed installation instructions.
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Unpack and Inspect the Instrument

Important: Save all packaging materials. If you need to ship the instrument or
accessories to BioTek for repair or replacement, you must use the original packaging.
Using other forms of commercially available packaging is not recommended and can void
the warranty. Improper packaging that results in damage to the instrument may lead to
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of
damage.

If the MultiFlo™ FX Multi-Mode Dispenser is damaged, notify the carrier and your
BioTek representative. Keep the shipping cartons and packing material for the
carrier’s inspection. BioTek will arrange for repair or replacement of your
instrument immediately, before the shipping-related claim is settled.

1. Unpack the boxes containing the instrument and other equipment:

l MultiFlo™ FX Multi-Mode Dispenser and accessories

l Strip Washer and accessories

l Dual Syringe Dispenser and accessories

l Additional Peri-pump Dispenser and accessories, including RAD™
technology components, if applicable.

2. Place all packing materials back into the shipping boxes for reuse if necessary.
3. Syringe Dispenser models: when the Syringe dispenser is a component of your

instrument, review the placement options for it (as described on page 63) and decide
which one best suits your lab before proceeding with the installation.

Refer to the Package Contents on page 12 to make sure you have all expected
equipment.
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Install the Waste Tubing

A length of tubing and a bracket to hold it is provided to drain the priming trough
into a waste container. It's safer to perform this task before removing the shipping
hardware.

Underside of MultiFlo showing priming trough waste tubing

Important note: The waste
tubing must lay flat to
properly drain the priming
trough. The side bracket
provided with the instrument
supports this goal, but it may
not be needed in your lab,
depending on where you
position the dispenser and its
waste receptacle.

You will need:
l Philips head screwdriver (small)

l Waste tubing: 4' provided (PN 7213010)

l Possibly scissors or knife to cut tubing to desired length

l Side bracket provided

l Waste vessel: to capture discarded fluid

To install the tubing:

Install Side Bracket for Waste Tubing
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1. Turn instrument onto its back to access its
underside.

2. Remove the two screws in the lower left
corner. You will use them to install the
bracket.

3. Align the side bracket with the screw holes
so its hook opens towards you and use the
screws to install the bracket.

You may or may not use the side bracket, depending on where you place the waste
vessel.

Attach the Tubing to the Priming Trough

1. Thread the waste tubing under the
bracket and onto the priming trough's
spout.

Remove the bracket and/or use water or
alcohol to help the tube slide onto the spout.

2. Snake the tubing around the
instrument to the side bracket.

3. Return the instrument to normal
position.

Position Waste Container and Tubing

When all the installation steps are completed:

1. Place the waste container under the instrument's work surface.

2. Position the waste tubing to drain into the waste container, cutting it to the
optimal length, if necessary.

Next, remove the shipping hardware.
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Remove the Shipping Hardware

Two shipping brackets (and a rubber band when a Peri-pump is included) protect
the MultiFlo FX during shipping. After installing the waste tubing for the priming
trough, place it upright on a level work surface to remove the shipping hardware.
(Store the shipping brackets on the back of the instrument in slots provided for this
purpose.)

You will need:
l Allen (or hex) wrench taped to plate carrier.

The shipping hardware is slightly different than shown above for MultiFlo FX
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without a washer or RAD technology:

For these
MultiFlo FX
models:
l MFX

l MFXP

First remove the
plate carrier
shipping bracket
and then remove
the dispense arm
bracket.

Reverse this
order when
reinstalling the
brackets (before
shipping): put the
dispense arm
bracket on the
post first.

Remove shipping brackets:

1. Remove the plate carrier shipping bracket: use the Allen wrench to remove the
two screws that hold it to the plate carrier. Tilt the bracket downwards slightly,
and release it from the post.

2. Remove the dispense arm shipping bracket: use the Allen wrench to remove the
two screws that hold the bracket to the instrument.

3. Attach the shipping brackets to the back of the instrument for storage. They will
be needed if the dispenser must be shipped in the future.
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Dispense-arm bracket for
MultiFlo FX without a washer or
RAD technology

4. Insert the brackets into their respective slots on the back of the instrument, in
lower right corner. Slide the plate-carrier bracket's longest arm into the slot and
use the Allen wrench to screw it in place. (Exception: The dispense-arm bracket
for MFX and MFXP models does not fit into a slot. Attach it with one screw so
the short end projects out from the instrument. You must first remove the large
support bracket attached to the back panel that is used for an external Peri-
pump. Insert the second screw next to the bracket.)

Store the Allen wrench for future use.
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Set up the Strip Washer

Perform these steps:
l Attach washer module and connect its cable on the facing page,

l Install the tubing bracket on page 37,

l Install the Fluid Supply on page 38,

l Install the Waste Bottle on page 39,

l Install the muffler on page 41,

l Install Washer Manifolds on page 41.

Strip Washer accessories

Provided with the strip washer module:

Part Part Description Part
Number

Aspirate manifold: install on dedicated
aspirate arm. Press the stainless steel tab on
the front of the arm to install (and to remove)
the manifold.

Install this manifold last, after installing
items on the dispense arm.

See Install Washer Manifolds on page 41

1260510
for 96/384-
well
(shown)

Dispense manifold: install on the dispense
arm after installing either the Syringe
dispenser manifolds or the spacer block.

nSeveral plate-type-specific
manifold sets are offered.

1260511
for 96/384-
well
(shown)
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Part Part Description Part
Number

Muffler: install on exhaust tubing to reduce
instrument noise. Finger-tighten only.

4073009

Spacer block: to properly position washer
manifolds when the dual Syringe dispenser is
not installed. Put the spacer on the dispense
arm before installing the washer dispense
manifold (in lieu of Syringe dispenser
manifolds).

1260522

Thumb screws: to secure dispense manifold
to dispense arm. Especially useful when
performing magnetic bead assays. See
Special Procedure for Magnetic Bead
Assays on page 151.

01262

Tubing bracket: to hold tubing in place. 1262066

Vacuum Line Filter: cut the vacuum line
tubing and install the filter to prevent
contaminates from clogging the vacuum pump.

48146

See also Strip Washer Optional Accessories on page 15 for part numbers for
plate-type-specific washer manifolds.

Attach washer module and connect its cable

The MultiFlo FX's optional strip washer is positioned on posts and attached to the
back of the instrument. A bracket holds the fluid supply and waste tubing, keeping

BioTek Instruments, Inc.



36 | Chapter 2: Installation

the tubing secure and away from moving parts.

You need a Philips screwdriver.

1. First, remove the screws and
washers that will attach the washer
to the back panel.

2. Align the slots on the side of the
washer module with the two posts
near the base. Simultaneously,
align the screw holes on the top of
washer unit.

3. Use the screws removed in the first
step to attach the module to the
instrument.

4. Connect the serial cable from the
washer module to its port on the
back of the instrument.

back panel
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The washer module functions as a shelf for a Syringe dispenser, if desired.

Install the tubing bracket

A stainless steel bracket to keep the tubing away from
moving devices is provided with the washer and RAD
models.

Attach the bracket to the back of the instrument: near the
top, center of the instrument, slightly left of the aluminum
mounting plate as you face the back panel.

You need a small Philips screwdriver.
1. First, remove the two screws you will use to attach

the bracket. Refer to the photo below to locate the
screws on the back of the instrument.

2. Align the bracket to the holes and use the screws to
attach it.
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The tubing bracket is designed to snugly hold the check valves of the fluid supply
tubing and the waste tubing's rigid valve.

Install the Fluid Supply

The strip washer's fluid supply
system (PN 1263007) uses a
two-liter plastic supply vessel
and two tubes with check valves,
powered by a non-autoclavable
syringe pump.

1. Locate the tubing with the Luer fitting on one end. Gently screw the Luer fitting
into its connection on the top of the supply bottle. Finger-tighten only.

2. Attach the other end of the fluid supply tubing to the bottom port of the washer
pump. Make sure the arrow on the check valve points towards the pump.

3. Connect the tube without fittings to the top port of the washer pump. Make
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sure the arrow on the check valve points away from the pump.

4. Connect the other end of the tube to the dispense manifold.

Fluid supply installed

When you're ready, snake the tubing from the devices mounted on the
back of the instrument to the manifolds on the front: put the supply
tubing check valves and the rigid fixture of the waste tube in the
center of the bracket.

As part of the setup: Install Washer Manifolds on page 41.

Install the Waste Bottle

The washer collects waste fluid during aspiration. The waste bottle is connected to
the vacuum pump (inside the washer module) and the aspirate manifold to
perform this function.

An inline vacuum filter (not shown) is optional but strongly recommended because
(1) the filter prevents waste material aerosols from being released into the air, and
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(2) the filter serves as a temporary fluid barrier in the event that the waste bottle is
allowed to overfill. (The filter part number is 48146.)

An optional Waste Sensor bottle, PN 4070545, alerts users to the need to empty the
waste container, preventing overflow problems.

1. Remove the waste bottle cap and replace it with the stopper from the waste
tubing set (PN 1263001).

2. Connect the tube without a fitting to the aspirate manifold.

3. Install the inline vacuum filter on the tubing with a Luer fitting:
o Cut the tubing about two inches from the Luer fitting,

o insert the filter to reconnect the tubing.

4. Gently screw on the Luer fitting to the port labeled Vacuum.

5. If applicable, connect the waste sensor cable to the Waste Sensor port and
enable the sensor:

Using the Touch screen Using the LHC

1. Select Instrument>Washer. 1. Select Tools>Instrument

MultiFlo™ FX Multi-Mode Dispenser



Set up the StripWasher | 41

Using the Touch screen Using the LHC

2. Touch the field to enable Waste
detection under Sensors Enabled.

3. Press the Home button.

Utilities.

2. Under Strip Washer, fill the
checkbox to enable Waste
Detection.

3. Click Send, and then, Exit.

Install the muffler

Install the optional vacuum pump muffler (PN 4073009) to reduce noise during
operation: Connect the muffler's Luer fitting to the Exhaust port. Finger tighten,
only.

Install Washer Manifolds

The strip washer has two distinct manifolds: the dispense manifold resides on the
dispense arm, along with the Peri-pump cassette's Tip Holder and the dual Syringe
dispensers manifolds, if equipped. The aspirate manifold resides on its own
dedicated aspirate arm.

Important: Either the dual Syringe dispenser manifolds or the spacer block must be
installed on the dispense arm before the washer dispense manifold can be installed. And,
the washer dispense manifold must be installed before the aspirate manifold is installed.

1. Turn off the MultiFlo FX, if
necessary.

2. Connect the fluid supply tubing
to the dispense manifold.

Install the Fluid Supply on page 38

Install the Waste Bottle on page 39
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3. Connect the waste vessel tubing
to the aspirate manifold.

4. Lower the aspirate arm to gain
access to the dispense arm, if
necessary, i.e. move it out of the
way.

5. First, install either the Syringe
dispenser manifolds or the
spacer block on the dispense
arm:

l orient the block so its lip
points down and abuts the
dispense manifold;

l position the Syringe
manifold's tubing closest to
the instrument.

Typically, magnets hold them
securely.

6. With its supply tube closest to
the instrument, guide the
dispense manifold onto the
dispense arm. Its magnet will
hold it securely. Alternatively,
especially when running
magnetic bead assays, remove
the magnet and use the thumb
screws provided. Special
Procedure for Magnetic Bead Assays
on page 151.

7. Lift the aspirate arm to its
highest position. Align the two
pins on the aspirate manifold
with the holes on top of the arm,
and press the "Aspirate arm
release tab" to install the
aspirate manifold.
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Install the
Syringe
Dispenser
manifolds on the
dispense arm
instead of the
"Spacer block,"
if applicable.

To remove the washer manifolds:
Reverse the order of the installation steps, i.e. first remove the aspirate manifold: press
the release tab. Then, remove the dispense manifolds.
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Set Up the Peri-pump Dispenser

Install these items to use the Peri-pump dispenser:
l Install the external Peri-pump, if applicable

l Install RAD Technology Components

l Or, attach the Peri-pump cover panel

l Dispense cassette

l Fluid supply vessel

l (Optional) Prime trough insert

Attach the Peri-pump Cover Panel

Optionally, if you are not installing an external (or secondary) Peri-pump, install
the cover panel provided to conceal the primary Peri-pump.

Install the cover panel using the two hex screws and the Allen wrench shipped with
the MultiFlo FX.
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MultiFlo FX with closed Peri-pump cover panel
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Install the Secondary Peri-Pump

An optional secondary or external Peri-pump dispenser is available for the
MultiFlo FX. It ships as a kit with its own accessories and it is required for RAD™
technology. Inspect and unpack the shipping container and follow these installation
instructions if applicable. Otherwise, skip this part of the installation process.

The secondary Peri-pump is designed to sit on top of the MultiFlo FX, above and
slightly right of the internal Peri-pump.
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Kit components include:
l 1 - additional Peri-pump
l 2 - small tab to secure unit to the instrument
l 3 - additional dispense cassette bracket
l 4 - interface cable to connect unit to the instrument
l 5 - MultiFlo FX Only: extra stainless-steel bracket to replace #2
l Also note the screwdriver, Allen (hex) wrench, and shoulder screw shipped with
the accessories.

You will need:
l Second Peri-pump Kit components (shown above)

l Philips head screwdriver (small)

l Small flat screwdriver

Install the additional Peri-pump:

MultiFlo FX ONLY: Change the bracket on the
front of the Secondary Peri-pump unit:

l Remove the black plastic tab and replace
it with the stainless-steel bracket
shipped in the kit, using the same
screws. (See #5 above.)
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1. First, remove the support bracket
stored on the back of the instrument.
It will be used to secure the
dispenser on top of the instrument.
Remove the two screws holding the
bracket in place.

2. Two more screws needed for the
installation are shipped on the back
of the Peri-pump unit. Remove the
two screws and keep with the
bracket.

3. Place the second Peri-pump unit on
top of the dispenser.

4. Position the dispenser so the screw
hole in the small tab or stainless-
steel bracket attached to its front
aligns with the right-hand screw
hole on the primary Peri-pump or
cover plate.

5. Use the Philips screwdriver to fully
tighten the shoulder screw to ensure
the unit is secured.

6. On the back of the instrument,
secure the Peri-pump unit in place

The support bracket can be installed two
ways, to provide foot holds for a Syringe
dispenser module, or not.
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with the support bracket and the
four screws removed from the
instrument earlier. Partially tighten
the screws until all 4 are in place,
then tighten all the screws.

Hide the bracket's foot holds inside the case
when a Syringe dispenser will not be
installed on top of the second Peri-Pump.

Install the additional dispense cassette bracket:

This task is easier to perform when the cassette bracket is well lit. It's a tight space and
the second cassette bracket fits snugly onto the original bracket.

1. First, remove the four screws and
washers from the additional cassette
bracket using the small Allen
wrench supplied in the kit.

2. Slide the plate carrier to the left, out
of the way. Lower the dispense arm
to a workable position.

3. Use the text on the front of the
additional cassette bracket to orient
it correctly and place it around the
original bracket.

4. Use the four screws to secure the
bracket over the existing bracket.
Place and partially tighten the
screws until all four are in place,
then tighten all the screws.
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Install cable to connect the dispenser:

1. On the back of the instrument,
connect the interface cable to the
Peri-pump Dispenser port on the
back of the instrument and to the
port on the back of the Peri-pump
unit. Use the small flat screwdriver
to secure the cable.

n If you are installing a Syringe dispenser also, you may find it easier to
complete that installation before connecting the cable, turning on the
instrument, and installing the dispense cassettes.
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Install RAD Technology Components

Perform these installation steps for the RAD technology Peri-pump dispenser, if
applicable. Otherwise, skip this section.

RAD™ Tech-
nology Com-
ponents

1 - Secondary
or external
Peri-pump
2 - RAD
dispense head
(with ribbon
cable)
3 - RAD
module and
thumbscrew
4 - Tubing
bracket
5 - Cables (2)

RAD technology uses the secondary or external Peri-pump dispenser, a tubing
bracket, and a dedicated dispense head. After removing and storing the shipping
hardware, install these components:
l Install the Secondary Peri-Pump on page 46

l Install the Tubing Bracket and RAD Module below

l RAD: Plug in the cables on page 53

l Install RAD Dispense Head on page 53

l Install RAD Technology Cassette on page 58

Install the Tubing Bracket and RAD Module

First, install the tubing bracket and then attach the small RAD module with a serial
port to the bracket.
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Install the tubing bracket

A stainless steel bracket to keep the tubing away from
moving devices is provided with the washer and RAD
models.

Attach the bracket to the back of the instrument: near the
top, center of the instrument, slightly left of the aluminum
mounting plate as you face the back panel.

You need a small Philips screwdriver.
1. First, remove the two screws you will use to attach

the bracket. Refer to the photo below to locate the
screws on the back of the instrument.

2. Align the bracket to the holes and use the screws to
attach it.

Attach the RAD Module to the Tubing Bracket

View of inside the tubing bracket
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1. First, remove the thumbscrew and bolt shipped on the tubing bracket.

2. Use the thumbscrew to attach the RAD module to the tubing bracket.

RAD: Plug in the cables

Plug the cables into their respective ports:

l RAD module toWasher Module port

l Peri-pump to Peri-Pump Dispenser
port

Install RAD Dispense Head

The RAD dispense head resides on the dedicated Aspriate manifold/RAD arm. Its
ribbon cable plugs into the RAD module (installed in earlier step).

1. Align the two pins on the dispense
head with the two holes on the
RAD arm, and press the Release Tab
(on the front of the arm) to install the
dispense head.
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2. Plug the ribbon cable on the dispense
head into the RAD module (installed
on the tubing bracket).

Next, install the RAD cassette: Install RAD Technology Cassette on page 58.

Dispense Cassette Diagram

1 - Tip Holder
2 - Center Holder
3 - Tube Tensioner
4 - Tubing Organizer
5 - Tip Guard
(remove before use)
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Tubing Cassette Diagram

RAD™ Technology tips replace #1 Tip Holder when installing the
cassette.

1. Tip Holder: The cassette’s easiest part to identify, the tip holder fits into the
dispense arm to the right of the pump for positioning above the plate. Except
RAD technology cassette tips fit into a dedicated dispense arm.

2. Center Holder: The center holder is labeled to identify the size of the cassette
tubing. It also has a serial number for tracking purposes. It slides into grooves
on the underside of the pump.

3. Tube Tensioner: The transparent 5-mm scale on its front surface identifies the
tube tensioner. It has internal screws for stretching the tubing, one for each
tube. The tube tensioner’s scale is useful when calibrating the cassette.

4. Tube Organizer: At the opposite end of the cassette from the tip holder, the
tube organizer holds the 8 tubes together for inserting into the fluid vessel.
Except it is omitted from the single-tube cassettes.

5. Tip Guard: Remove the tip guard before installing the cassette. The tip guard
protects the tips during shipping. It is not a permanent part of the cassette. The
RAD single-tube cassette also ships with a tip guard.
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Install the Dispense Cassette

Prerequisites:
o Review the Dispense Cassette Diagram on page 54 to learn the names of the
components.

o Move the Pump Cover away from the pump to its OFF position.
o When you have two Peri-pumps installed, put the Primary pump's Tip Holder in the
left bracket and the Secondary pump's Tip Holder in the right bracket.

o Release the pump’s stainless steel plate: Use your right hand to release the
spring-loaded cassette latch (on the right side of the caution symbol on the pump)
and use your left hand to lift the stainless steel plate up and out.

The BioTek logo on the Tip Holder faces the Peri-pump. The logo on the Center Holder
faces down, away from the pump.

Note: See Install RAD Technology Cassette on page 58 for single-tube and bulk
cassette instructions.
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1. Slide the Tip Holder into the
dispense arm. The Tip Holder’s
front plate with the BioTek logo
or steel plate faces the pump.
Make sure the tip holder is level
and snapped into place.

l Two Peri-pumps: use left bracket for
Primary, right bracket for
Secondary.

l RAD technology exception: attach
the tip holder to the dedicated
dispense head.

2. Extend the rest of the cassette
under the Peri-pump, so you
can slide the Center Holder into
its slot on the underside of the
pump. A tab on the back of the
center holder fits into a notch
on the pump. The label on the
center holder faces down.

3. Align the Tube Tensioner with
the stainless steel plate as it
wraps around and up against
the pump. Be sure the knobs on
top of the tensioner fit correctly
into the grooves in the stainless
steel plate as you move both
parts up and around the pump
and click the steel plate into
place.

4. Return the Pump Cover to its RUN position covering the pump.

5. Lift the Tube Organizer over the pump cover. Place it in the fluid vessel, when
you’re ready.
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Install RAD Technology Cassette

RAD technology's single-tube and 8-to-1 bulk dispensing cassettes are installed like
standard cassettes with one difference, the tip holder is installed on the dedicated
RAD dispense head. Install the RAD cassettes on the external or secondary Peri-
pump only! They are not designed for use on an internal Peri-pump.

Follow instructions to Install the Dispense Cassette on page 56 skipping the first step.

Magnets on the dispense head hold the cassette tip(s) in place:

Single tube RAD cassette 8-tube-to-1 Bulk RAD cassette

Align the two pins with the holes (above and below the magnets) on the dispense
head.

nYou must create a protocol to successfully use the RAD 8-to-1 bulk-dispensing
cassette. It is not compatible with Quick Dispense.
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Prime Trough Inserts

The MultiFlo FX ships with special reservoirs that fit into the dispensers’ priming
trough to capture expensive reagent after priming, rather than discarding it.

Three types of Prime Trough Inserts may be provided:

l PN 7182043 for the Peri-pump dispenser, holds approximately 12 mL (1 per
dispenser)

l PN 7182044: 2 for the Syringe dispensers, 1 for the washer, holds
approximately 6.5 mL

nWithout the prime trough insert, the priming trough empties into the regular
waste bottle.

Important: Remove the priming trough inserts when using the 8-to-1 RAD cassette.
The chute will collide with both the RAD priming cup and the Syringe dispenser insert if they
are left in the priming trough.
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Peri-pump Reservoir Holder

Peri-pump Reservoir Holder attached to Peri-pump

MultiFlo FX models with a
Peri-pump dispenser
include the convenient Peri-
pump reservoir holder (PN
7210509). The simple bracket
clips onto the front of the
Peri-pump to hold a variety
of vessels.

You can significantly reduce
the dead volume, saving
precious fluid, by cutting
the cassette tubing to make a
shorter fluid path. See
Shorten the Dispense
Cassette Tubing on the
facing page.

The reservoir holder has two components, a bracket and
a strap.

1. Clip the bracket onto the front of the Peri-
pump. When properly installed the bracket
hides the hazard label.

2. Place the supply vessel (reservoir) on the
bracket and wrap the strap around both the
vessel and the bracket: fit the strap's molded
balls into the round slots.

Depending on the size of the vessel, it may be necessary to tuck the ends of the
strap into the bracket, too, to keep the slack out of the way.

n Important: Always remove the tubing from the fluid before releasing the
tension on the cassette or changing cassettes.
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Shorten the Dispense Cassette Tubing

Shortening the fluid path reduces the dead volume when dispensing, which helps
preserve expensive reagents. BioTek offers the Peri-pump Reservoir Holder on the
previous page as an accessory to the Peri-pump dispenser for this purpose. The
cassette tubing can be shortened by as much as 12 inches (30.48 cm) when using the
reservoir holder.

Recommendations for cutting the tubing:

l Prepare a clean, lint-free work area to lay out the cassette;

l Remove the Tube Organizer (not applicable to RAD single-channel cassette);

l Use a ruler as a guide to determine where to cut the tubing;

l Cut one tube at a time using a razor blade, Exacto® knife, or sharp scissors; make as
clean a cut as possible;

l Cut the tubing as evenly as possible, limiting the difference between the tubes to less
than 1/4" (6.35 mm) (not applicable to RAD single-channel cassette).

To may make this job easier, use the cassette’s packaging to hold the cassette parts,
keeping them out of your way.

Dead Volume Reduction: If you cut the Peri-pump tubing (and use the reservoir
holder), you can reduce the dead volume:

Standard and RAD 8-to-1 Cassettes

Cassette Std length tubing Cut tubing by 12"

1 uL 1.20 mL 0.96 mL

5 uL 4.23 mL 3.38 mL

10 uL 7.36 mL 5.89 mL

RAD Single-tube Cassettes

Cassette Std length tubing Cut tubing by 12"

1 µL 150 µL 90 µL

5 µL 530 µL 320 µL

10 µL 920 µL 555 µL
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Install the Syringe Dispenser Component

The Syringe dispenser is an optional component and ships separately. Inspect and
unpack the shipping container. Skip this part of the installation process if it is not
applicable.

l 1 - Syringe Dispenser module (autoclavable)
l 2 - interface cable
l 3 - tubing bracket
l 4 - priming trough inserts
l 5 - dispense manifolds
l 6 - shelf
l 7 - supply bottles and tubing with check valves
l Not shown: thumbscrews (2) and a USB flash drive.

Review the placement options for the Syringe dispenser and follow the applicable
instructions:
Syringe Dispenser Placement Options on the facing page

MultiFlo™ FX Multi-Mode Dispenser



Install the Syringe Dispenser Component | 63

Syringe Dispenser Placement Options

There are two
major placement
options for the
dual Syringe
dispenser
module. First,
behind the
instrument on a
shelf provided for
the purpose or
similarly, on top
of the washer
module. The
second option is
on top of the
instrument, itself.

When installing
the Syringe
dispenser on top,
placement of the
tubing bracket
varies slightly
depending on
how many other
dispensers are
installed.

Follow the
installation
instructions for
your preferred
placement of the
dispenser:

Install the Syringe Dispenser on Back Shelf on the next page (or on
top of the washer)

Install the Syringe Dispenser on Top on page 65
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Install the Syringe Dispenser on Back Shelf

Follow these instructions to install the dual Syringe Dispenser module on a shelf
attached to the back of the MultiFlo FX or on top of the washer module.

MultiFlo FX Only: The washer module functions as
a shelf for the syringe dispenser: skip this step,
and use the washer as a shelf, if applicable.

First, reposition the shelf's feet:

1. Remove the shelf shipped with the
Syringe dispenser from its plastic bag
(PN 7212038).

2. Unscrew the rubber feet that are
shipped in the wrong position.

3. Install the feet in the correct position:
screw the feet into the two outer holes
on the bottom of the shelf. (The third
hole is for BioStack integration.)

4. Remove the two screws on the left side
of the back of the instrument.

5. Use the screws to install the shelf.
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Note: For MultiFlo FX washer or RAD
models, use the stainless steel tubing
bracket rather than the black plastic
bracket provided with the Syringe
dispenser.

6. Install the tubing bracket (using the
black-capped screws) in the two holes
next to the shelf. First insert the bottom
screw part way. Position the bracket
over the screw and tighten both screws.

7. Put the syringe pump module on the shelf or the washer module.

8. Plug the serial cable into the back panel of the MultiFlo FX in the port labeled
Syringe Pump Dispenser. Plug the other end into the syringe pump unit.

Next steps:
l Update the instrument to use the Syringe Dispenser on page 74

l Install Tubing and Manifolds for Syringe Dispenser on page 68

Install the Syringe Dispenser on Top

Follow these instructions to install the dual Syringe dispenser module on top of the
instrument.
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Syringe dispenser on top of secondary Peri-pump

Support bracket with foot holds
for the Syringe dispenser.

The MultiFlo FX ships with a support bracket attached to the back of the
instrument. The support bracket has foot holds for the Syringe dispenser. The
bracket's flexible design supports either one or two devices, the secondary Peri-
pump and the Syringe dispenser, alone or in combination.

1. Remove the support bracket from the back of the instrument by releasing the
two screws that hold it in place.

2. Align the bracket with the screw holes on the back of the instrument so that the
foot holds sit above the instrument or second Peri-pump's top.

3. Install the tubing bracket in the appropriate location using the two black-capped
screws:

Tubing Bracket

When installing the Syringe dispenser on top of the
instrument, the placement of the tubing bracket
varies slightly depending on how many other
dispensers are installed. Always position the
bracket as close as possible to the syringe pump
unit.
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1 Peri-pump:
Install the bracket using the two
empty screw holes on top of the
Peri-pump.

2 Peri-pumps:
Install the bracket using the
screw holes on top of the
secondary Peri-pump, the
pump closest to the Syringe.

Syringe Only
(no Peri-pump)
Remove the two screws in the
filler plate on the front of the
instrument and replace them
with the tubing bracket.

4. Plug the 26-pin high-density cable into the back panel of the MultiFlo FX in the
port labeled Syringe Pump Dispenser. Plug the other end into the syringe
pump unit.

Next steps:
l Update the instrument to use the Syringe Dispenser on page 74

l Install Tubing and Manifolds for Syringe Dispenser on the next page
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Install Tubing and Manifolds for Syringe Dispenser

For each dispense pump, a set of two tubes with check valves and two supply
bottles are provided. The 32-tube dispense manifolds also ship with an optional
inline filter.

nThe supply bottles have Luer fittings. Finger-tighten only!

l Place the supply bottles on the same horizontal plane as the instrument. This
ensures optimum pump performance.

l Make sure the tubing is not crimped during installation.

Perform these steps twice, first for Syringe A and then for Syringe B:

1. First install the inline filter for 32-
tube dispensers, if applicable, (as
described on page 71). Locate the
tubing with a Luer fitting on one
end. Gently screw the Luer fitting
into the top of the supply bottle.
Finger-tighten only.

2. Attach the other end of the tubing
from the supply bottle to the bottom
port of one of the Syringe pumps.

nMake sure the flow-direction arrows point in the direction that the fluid moves.
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3. With the check valve’s flow-direction arrows pointing away from the pump,
connect the other tube (without fittings) to the top port of the Syringe pump.

4. Slide the manifold onto the
two posts on the dispense
arm with the tubing end
closest to the instrument.
Except for the dual 8-
channel manifold that has
two manifolds in one
block, install Syringe A’s
manifold first. Syringe B’s
manifold must be installed
after Syringe A’s.

5. Connect the supply tube to
the dispense manifold.

n Images of syringes on the instrument, labeled A and B, indicate the placement
of each dispenser’s manifold: A slides on first, then B.

nSpecial procedure required for magnetic bead assays! A magnet holds
the two manifolds in place on the dispense arm. You can remove the magnet
when necessary for certain assays (as described on page 151).
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You can install the tubing bracket:

on the front near the Peri-pump on the back next to shelf or share washer/RAD bracket

6. Make sure the manifold has enough slack in the tubing to move down to the
priming trough and then press the tubing into the tubing bracket to keep the
tubing out-of-the-way.

nWhen the Syringe is installed on the back shelf, you must temporarily move
the pump unit to get access to the tubing bracket.

nWhen the Syringe in installed on top of the washer, use the washer's tubing
bracket, instead.

7. Repeat the tubing and manifold installation for Syringe B.

8. (Optional) Insert the thumbscrews into the posts that hold the manifolds.
(Magnets keep the manifolds attached to the dispense arm. The thumbscrews
are provided in case the magnets interfere with operation, e.g. for magnetic
bead assays.)

n Important! You must Update the instrument to use the Syringe Dispenser on
page 74.

Syringe Dispenser Check Valves
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Note the flow direction arrows on the check valves. Some are harder to see than
others. The flow direction arrows are engraved valves into the translucent plastic.
l PN 68083 — Autoclavable valves for use with non-organic substances. The direction
arrows are difficult to see.

l PN 68073 — Check valves recommended for use with organic substances. They cannot be
autoclaved. Direction arrows are easy to see.

nNote: If the check valves are replaced, it may be necessary to recalibrate the
syringe backlash to achieve optimum accuracy performance. See Calibrate
the Backlash for Syringe Dispenser on page 212 for instructions.

Make sure the flow-direction arrows on the check valves point toward the pump
from the supply vessel, and towards the dispense manifold from the pump. 

Install Inline Filter for 32-Tube Dispensers

BioTek ships two 90-micron inline filters with the 32-tube dispense manifolds to
reduce the chances of clogging the dispense tubes. It is especially important for the
SB – small bore models.

To install the filters:

1. Locate and layout the length of tubing that goes between the supply bottle and
the Syringe pump; it has the Luer fitting on one end.

2. Cut the tubing approximately one to two inches (3-5 cm) above the Luer fitting.

3. Slide the filter’s nozzle ends into the two ends of the tubing, reconnecting it.

Install Software/Connect to Computer

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the
MultiFlo FX using your personal computer (PC), please refer to the LHC
Installation Guide for complete installation and setup instructions.
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Connect to Host Computer

Two cables are shipped with the MultiFlo FX:

If using the serial cable: Plug one end into the RS232 serial port on the
instrument and the other end into an available port on the computer.

If using the USB cable: Plug one end into the USB port on the instrument and
the other end into an available port on the computer.

l If the computer is connected to the Internet, turn on the instrument. Let
Windows® automatically locate and install the necessary USB drivers (follow
the online instructions), if applicable or open the link below to download the
drivers.

l Virtual Com Port (VCP) drivers for all Windows operating systems are
available at http://www.ftdichip.com/Drivers/VCP.htm

l If the computer is NOT connected to the Internet, install the drivers using the
supplied “Virtual USB Com Port” driver software CD.

nThe Home screen must be displayed for the LHC to communicate with the
instrument.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the MultiFlo FX to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Connect Power Cable

Warning! Power Rating. The MultiFlo FX must be connected to a power
receptacle that provides voltage and current within the specified rating for the system.
Use of an incompatible power receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to
connect primary power to the MultiFlo FX. Use of a two-prong adapter disconnects the
utility ground, creating a severe shock hazard. Always connect the system power cord
directly to a three-prong receptacle with a functional ground.

MultiFlo™ FX Multi-Mode Dispenser

http://www.ftdichip.com/Drivers/VCP.htm


Define Instrument Settings  | 73

The MultiFlo FX supports voltage in the range of 100-240 V~ at 50-60 Hz. 

1. Connect the power cable to the power supply.

2. Plug the power supply cable into the power socket in the side panel of the
MultiFlo FX.

3. Insert the three-prong plug into an appropriate receptacle.

Define Instrument Settings

LHC Users Only

When using the LHC to control the MultiFlo FX, an important first step is
defining your instrument’s settings. After installing the LHC, you can use the
desktop icon or the Windows Start button to launch the LHC:

> All Programs> BioTek> Liquid Handling Control

1. Click the Name link on the main page and, if required, select the MultiFlo FX.

2. Specify the COM Port used to connect the MultiFlo FX to the computer (use
the drop-down list to select the port) and click Test Communication.

o Pass: proceed to the next step.
o Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

3. In the Target Instrument Settings dialog that opens, click Get actual settings
now, and click OK.

Enable Waste Sensor

Wash models only: If you purchased the optional waste sensor accessory, enable
the waste sensor:

Using the Touch screen Using the LHC

1. Select Instrument>Washer.

2. Touch the field to enable Waste
detection under Sensors Enabled.

3. Press the Home button.

1. Select Tools>Instrument
Utilities.

2. Under Strip Washer, fill the
checkbox to enable Waste
Detection.

3. Click Send, and then, Exit.
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Update the Instrument to use the Syringe Dispenser

An important part of installing the dual Syringe
Dispenser is updating the instrument's basecode
(internal software) with its calibration data. A data
sheet is affixed to the bottom of the Syringe pump
unit and to the front page of the installation
instructions.

Touch screen users: Use the USB flash drive and
enter both data sets, for the 8- and 16-Tube
Manifolds.

USB Flash Drive: plug in the USB flash drive
containing Syringe calibration data to update the
MultiFlo FX automatically.

LHC Touch screen

1. Connect the syringe pump unit
to the instrument with its serial
cable.

2. Turn on the instrument, launch
the LHC and make sure it is
communicating with the
MultiFlo FX (define the correct
COM port).

3. Select Tools>Instrument
Utilities>Syringe Dispenser.

4. Under Syringe Dispenser
Assembly, specify the type of
pump and the installed
manifold type and click Send to
download the data to the
instrument.

5. In the Calibration Data section,
enter the data points on the
label in the corresponding
fields, including the Serial
Number or plug the USB flash

1. Connect the syringe pump unit
to the instrument with its serial
cable.

2. Turn on the instrument, and
press Instrument.

3. Select Syringe and specify the
installed manifold type.

4. Under Calibration Data from,
press the link for each
manifold, one at a time, and
either Import from USB
or enter the Serial Number (SN)
and all the data points by
pressing each field to open the
number pad.

nEnter both data sets.

5. Press Save this Data when
done and confirm that the
Checksum displayed onboard
matches the Checksum on the
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LHC Touch screen

drive into your computer and
select Import from a file. Lastly,
click Send.

6. Wait for the confirmation
message and verify the
Checksum displayed matches
the Checksum on the label. This
ensures the data was input
correctly.

l Click Retrieve at any time to
check the Checksum.

label. This ensures the data
was input correctly.

nImportant: If the Checksum does not match there was a data input error and
dispense accuracy will be compromised. Redo the procedure, carefully
comparing the data points on the label to the values entered. When importing
data from the USB flash drive, confirm the serial number on the USB matches
the one on the Syringe unit.

Change the Syringe Dispenser Manifold

Changing the Syringe manifold requires two steps:
l Physically changing the Syringe dispenser manifold: See Install the Syringe
Dispenser Component on page 62.

l Updating the instrument's manifold setting; as described below.

After physically changing the manifold, perform these steps to tell the instrument
which manifold is installed.

1. LHC: Select Tools> Instrument Utilities> Syringe Dispenser
Touch screen: Select Instrument> Syringe> Manifold

2. Choose the option that represents the installed manifold. Look at the top of the
manifold to identify its type, which is engraved on the top:
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8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel.

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB).

8-tube 6-well plates only; 4 tubes per well.

9-tube 12-well plates only; 3 tubes per well.

8-tube 24-well plates only; 2 tubes per well.

12-tube 48-well plates only; 2 tubes per well.

3. LHC: Click Send to send this setting to the instrument.

Change the cassette type setting

The Peri-pump Cassette Type setting must be correct.

Note: Internal and External Peri-pump Dispensers: When the MultiFlo FX has an internal
or built-in peristaltic pump it is called the Primary Peri-pump and an external pump is
called the Secondary Peri-pump. When an instrument has only one pump, either internal
or external, it is called Primary.

LHC Touch screen

1. Select Tools>Instrument
Utilities

2. Select the Peri-pump tab.

3. Select the correct button for the
Cassette Type installed for the
primary or secondary Peri-
pump, if applicable.

4. Click Send to update the
instrument.

1. From the home screen, select
Instrument>Peri-pump.

2. Select the Cassette Type for
each dispenser: Primary and
Secondary, as applicable.

Tip: You may want to employ the Cassette Requirement Mode feature (as described
on page 158) to automatically update the instrument's Cassette Type setting when you run
a protocol. For advanced users with well organized procedures, the MultiFlo FX provides the
ability to change the cassette type setting on-the-fly. It uses the "Require a specific
cassette" parameter in a Peri-pump step to automatically change the cassette type setting
if it does not match the required cassette.
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Setting the Time and Date

Set the time and date to permit the MultiFlo FX to record "last run" and "last
modified" data for each protocol. Only the U.S. date format is available
(MM/DD/YYYY). An internal battery keeps the time and date valid when the
instrument is turned off. Always set both the time zone and the actual time, i.e.
selecting the time zone does not synchronise the time setting.

1. Select Instrument from the Home screen, press Next and then, Other.

2. Select Set Time and Date.

3. Update the time zone, date, and time:

l Time Zone: Touch the Select Time Zone button and select the option that
matches your location. GMT = Greenwich Mean Time.

l Time: Touch the time field to open a number pad. Enter the current hour and
minutes to set the 24 hour clock. Touch the number field to put it in edit
mode.

l Date: Touch today's date on the calendar to select it. Press the previous or
next arrows (up or down) to scroll to the correct month.

4. Press Save.

5. Restart the instrument.

Remember to update the time in accordance with annual time shifts, like Daylight
Savings Time, if applicable.

Note: The sort order of the protocol list on the Home screen determines which date is
displayed. When "Last run" is selected, this date is shown, when the list is sorted
"Alphabetically" the last modified date is displayed. Select Instrument>Preferences to
change the sort order.

Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a
New Protocol template and use it at startup.

Create a protocol template

1. Click the New button or select File>New.

2. Click Name. Select the MultiFlo FX and define its Port and Settings.
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3. Highly Recommended: select the Plate Type, fill in the text fields, and add any
steps that you want all new protocols to include.

4. Click Save and assign a unique name, e.g. Template.LHC.

5. Select Tools>Preferences>New Protocol.

6. Select the button for Protocol selected below to use as a template.

7. Click selected and select the protocol you created as a template.

Define startup behavior:

8. After completing the steps above, select the Startup Options tab.

9. Select the button for New Protocol.

10. Click OK to save your new preferences.
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Verify Performance

Before using the MultiFlo FX for the first time, verify that it is operating properly.
l When using the LHC, make sure the MultiFlo FX is connected to the PC and both are
powered up.

l When running standalone, turn on the MultiFlo FX.

Using the touch screen:

Press Instrument>About >Self-Check.

Using the LHC:

1. Click the Name link on the main page and, if required, select the MultiFlo FX.

2. Define the COM Port used to connect the MultiFlo FX to the computer and
Test Communication.

3. In the Target Instrument Settings dialog that opens, click Get actual settings
now, and click OK.

4. Select Tools>Instrument Utilities

5. On the General Settings tab, click the Perform Self-Check link.

Test results:
l Pass: no error message is displayed.

l Fail: an error message is displayed. If this happens, note the error code and refer to
Troubleshooting on page 272 to determine its cause. If the problem is something you can
fix, turn off the instrument, fix the problem, and then turn the instrument back on.
Otherwise, contact BioTek’s Technical Assistance Center.

nNote: An instrument qualification package (PN 1260521) for the MultiFlo
FX is available for purchase from BioTek. The package contains thorough
procedures for performing Installation Qualification, Operational Qualification
and Performance Qualification (IQ/OQ/PQ) and preventive maintenance (PM).
Extensive Checklists and Logbooks are included for recording results.

nImportant! Before operating the instrument, review Optimize Performance
on page 98. The guidelines include necessary steps to perform before running
a protocol, and issues to consider when creating or editing protocols.
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Verify the Peri-Pump Dispenser

1. Fill the Peri-pump’s supply bottle with approximately one liter of deionized
water.

LHC Touch screen

1. Select File > Open.

2. Open the MultiFlo FX and
Maintenance Protocols folders, and
then open P-xUL_CASS_RINSE.LHC*

You may need to reset the Com Port.

3. When ready, click the Run button to
prime the tubing and manifold with
deionized water.

4. When finished, close the program.

1. Select Quick at the Home screen.

2. Select Device Prime and set the
Device to the Peri-pump
Primary.

3. Press the PRIME button.
Repeat for Peri-pump Secondary, if
applicable.

4. When done, press the Home
button.

*Verify both a standard cassette and a RAD technology cassette, if applicable.

If leaks were detected, tighten all tube fittings and re-run the program. If leaks are
still detected, contact BioTek’s Technical Assistance Center.

Verify the Syringe Dispensers

1. Fill the supply bottles with approximately one liter of deionized water, one for
each syringe pump.

LHC Touch screen

1. Select File > Open.

2. Open the MultiFlo FX and
Maintenance Protocols folders, and
then open S-DAY_RINSE_A&B.LHC

You may need to reset the Com
Port.

3. When ready, click the Run button
to prime the tubing and manifold
with deionized water.

4. When finished, close the program.

1. Select Quick at the Home screen.

2. Select Device Prime and set the
Device to the Syringe Both.

3. Press the Start button.

4. When done, press the Home
button.
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If leaks were detected, tighten all tube fittings and re-run the program. If leaks are
still detected, contact BioTek’s Technical Assistance Center.

Verify the Washer Component

1. Fill the washer’s supply bottle with approximately one liter of deionized water.

LHC Touch screen

1. Select File > Open.

2. Open the MultiFlo FX and
Maintenance Protocols folders and
then open W-DAY_RINSE.LHC

You may need to reset the Com
Port.

3. When ready, click the Run button
to prime the tubing and manifold
with deionized water.

4. When finished, close the program.

1. Select Maintenance at the Home
screen.

2. Select W-Day_Rinse and press
Start.

3. When the protocol is completed,
press the Home button.

If leaks were detected, tighten all tube fittings and re-run the program. If leaks are
still detected, contact BioTek’s Technical Assistance Center.
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Repacking the MultiFlo FX

Prior to sending your instrument to us for repair, log into the Customer Resource
Center (www.biotek.com) to submit a Service Request for a Return Material
Authorization (RMA). Your serial number is needed to process an RMA.

nFailure to comply with the following instructions will void the instrument’s
warranty.

nDecontaminate the instrument before returning it: See Decontamination on
page 205.

If the original packing materials have been damaged or lost, contact BioTek to
order replacements. Part Numbers: 7213006 for the main instrument, 1263003 for the
washer, and 7213008 for the secondary Peri-pump and 1263004 for other
accessories, if applicable.

Prepare the instrument for shipping bracket installation: 

1. Remove the Peri-pump dispense cassette and the Syringe dispenser and washer
manifolds, if applicable.

2. Uninstall and repack separately the Syringe pump and its accessories, and the
strip washer and its accessories, if applicable.

3. Slide the plate carrier into position next to the dispense arm. It will be secured
in place by one of the shipping brackets.

View the illustrations provided:
l Repacking Secondary Peri-pump: it ships with the instrument (if applicable).

l Repacking the instrument: put the instrument (and accessories) into shipping boxes.

l Repacking the Syringe Dispenser (if applicable).

l Repacking the Strip Washer (if applicable) .

Obtain an RMA number:
l Contact BioTek TAC to obtain a Return Materials Authorization number,

l Write "RMA" on the shipping box in large, clear letters,
l And, include the RMA number in the shipping address label:

BioTek Instruments, Inc.
ATTN: RMA# xxxxx
15 Tigan Street
Winooski, Vermont 05404 USA

MultiFlo™ FX Multi-Mode Dispenser
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Install the Shipping Hardware

Install the two shipping brackets to protect the MultiFlo FX during shipping.

You will need:
l Allen (or hex) wrench provided with the instrument.

l The shipping brackets removed from their storage slots on the back of the instrument.

Reverse the process of "Removing the Shipping Hardware."

The shipping hardware is slightly different than shown above for MultiFlo FX
without a washer or RAD technology:
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For these
MultiFlo FX
models:
l MFX

l MFXP

First remove the
plate carrier
shipping bracket
and then remove
the dispense arm
bracket.

Reverse this
order when
reinstalling the
brackets (before
shipping): put the
dispense arm
bracket on the
post first.

Install shipping brackets:

1. First, remove the dispense cassette, Syringe dispenser manifolds or spacer block
and washer manifolds, as needed.

2. Lower the aspiration arm as far as it will go and raise the dispense arm. (Does
not apply to MFX and MFXP models.)

3. Secure the dispense arm with its shipping bracket, aligning it with its screw
holes, and use the Allen wrench to install the two screws that hold it to the
instrument.

4. Slide the plate carrier to the left, positioning it below the dispense arm.

5. Insert the plate carrier shipping bracket: rest the bracket on its post and align it
with the screw holes; use the Allen wrench to insert the two screws to hold it to
the plate carrier.

With the shipping hardware installed, you are ready to pack the instrument in its
shipping container.
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Repacking the Secondary Peri-pump

nThe instrument’s packaging design is subject to change over time. If the
instructions in this section do not appear to apply to the packaging materials
you are using, please contact BioTek’s Technical Assistance Center for
guidance.

Multiple accessory modules are available for the MultiFlo FX. Foam blocks are
used as space fillers in the packing containers when the modules, like the
secondary Peri-pump, are not shipped.

Uninstall the Secondary Peri-pump

1. Reverse the installation procedure:
Install the Secondary Peri-Pump on page
46 to remove the Secondary Peri-
pump from the top of the MultiFlo
FX.

2. Wrap a rubber band around the pump
itself.

3. Place the module in the plastic bag
and put it in its shipping box.

RAD™ Technology Components

1. Put the RAD components into their
respective plastic bags and then into
the small shipping box included with
the Secondary Peri-pump.

2. Tubing bracket: insert the thumb
screw into the bracket.

3. Put the ribbon and serial cables in the
cardboard tray that fits on top of the
other RAD components.

4. Tape the accessory box closed.
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Put it all together

1. Pack other accessories and the power
cord in the box.

2. Repack the cardboard and foam
shipping materials to secure the items
in place.

3. Tape the box closed. This box will fit
into the box with the instrument.

MultiFlo FX Repacking

1. Reverse the
steps
described to
Remove the
Shipping
Hardware.
First remove
the two
shipping
brackets from
the back of the
instrument,
then install
them.

2. Put a rubber
band around
the Peri-
pump.
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3. With the
shipping
hardware
installed, sit
the instrument
in the foam
edged box
bottom.

4. Place the end
caps on either
side and put
all items
inside the
interior
shipping box.

5. Place
accessory
boxes inside
interior box.

6. Tape the box
closed.
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7. Put the eight
foam corner
blocks on the
interior box
and put it
inside the
outer box.

8. Tape the outer
box closed.

9. Write "RMA"
in large, clear
letters on the
outer box.

10. Include the
RMA number
in the address
label.
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Repacking the Syringe Dispenser

After preparing the instrument for shipping, and reversing the installation steps,
pack the Syringe dispenser as shown here:

Fill the foam tray with
the Syringe dispenser
accessories and place
the tray on top of the
inner foam box
containing the pump
and supply bottles.
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Repacking the Strip Washer

nThe instrument’s packaging design is subject to change over time. If the
instructions in this section do not appear to apply to the packaging materials
you are using, please contact BioTek’s Technical Assistance Center for
guidance.

Uninstall the strip washer:

1. Reverse the installation
procedure: (as described on page
35) to detach the strip washer
from the MultiFlo FX.

2. Separate the manifolds from their
tubing and allow all fluid vessels
to completely dry.

3. Pack the washer module and its
accessories in the shipping
container.

4. Repack the cardboard and foam
shipping materials to secure the
items in place.

5. Tape the box closed.
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Operation

This chapter provides instructions for controlling the MultiFlo
FX.
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Touch Screen Basics

Home screen
l Fast, Light Touch: a light, quick tap on the screen produces the best results. Use your
fingertip or a pointing device like a pen tip. The touch screen does not support gestures,
like swiping and zooming, that are common to smart phones.

Do Don't

Do use your fingertip
(precise selection)

Don't use your finger pad
(uncertain selection)

l Wash/Dispense Protocols: Touch a protocol on the Home screen to run it. All
saved/predefined protocols appear on the Home screen.

Numbers: Touch any field that requires a numeric value to open a field-
sensitive number pad. Use the number pad to specify volume, times, and
other values. To enter negative numbers use the down (decrement) arrow.

Pick Lists: touch a field with a down arrow to open a pick list to select an
option.

Text: Touch any text field or comments box to open a keyboard. Use the
keyboard to name protocols, input runtime prompts, enter comments, etc.
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Scrolling: Press the down or up arrows to scroll a list with more items
than fit on the screen.

Quick access to prime the washer/dispenser, wash a plate, dispense to or
aspirate from a plate, depending on the devices installed.

To create and modify protocols.

To run maintenance and quality control protocols.

To change instrument settings, obtain protocols from a memory stick, etc.

Home: Press the home button to return to the Home screen at any time.

Previous: Press the previous button to go to the previous screen.

Help: To learn more about a screen, press its Help button.

Green buttons make the MultiFlo FX perform.

Quick Prime

At the Home screen select Quick>Device Prime

Priming removes air bubbles from the tubing, ensuring optimal performance. Fluid
is dispensed to the priming trough. You can use Quick Prime to comply with the
daily maintenance recommendations.

Quick Prime works best immediately prior to running a protocol to correct for
evaporation, i.e. to normalize the dispense tips and remove any air from the tubing.
Run a Maintenance protocol (multiple times, if necessary) when changing fluids to
more quickly and thoroughly flush the system.
l Recommended prime volumes for the Peri-pump on page 99

l Recommended prime volumes for the Syringe dispensers on page 101

l Recommended prime volumes for the Strip Washer on page 99
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nNote: the washer aspirates fluid during the prime step, but it does not fully
evacuate the priming trough insert.

Quick Dispense

Quick Dispense uses default values for all parameters except those available for
modification. To alter the flow rate, dispense height, and other parameters, you
must define a protocol. The Magnet Adapter Height and Plate Clearance instrument
settings apply to the Quick Dispense runs.

Important: Always prime the dispenser before dispensing! This Quick Dispense begins
with two pre-dispenses to prime the tips, to correct for evaporation. But, pre-dispense is
insufficient for removing air bubbles from the tubing.

nQuick Dispense is not recommended when using the 8-to-1 bulk-dispensing
cassette. See RAD Tip Tracking on page 156

1. Press Device (if necessary) to select the dispenser you want to use.

l When using the Peri-pump, make sure its Cassette Type setting matches the
currently installed cassette: See Change the cassette type setting on page
76. Refer to instructions for physically changing the cassette: Install the
Dispense Cassette on page 56.

n0.5 µL dispensing is not an option via the Quick menu. You must
define a protocol to dispense half-microliter (500 nL).

l Press Volume to define the per well dispense volume in microliters (µL).
Depending on the device and the plate type, multiple dispense tubes per
well may be used. The washer and Syringe dispenser calculate the correct
volume per tube to meet the specified per well dispense volume. (The Peri-
pump does not! See below.)

2. When the desired values are entered, put a plate on the carrier and press Start
to run the routine.

n 1536F: For best performance with this plate type use Syringe-BOTH
(both Syringe A and B) and remove the Peri-pump dispense cassette, or
remove the Syringe manifolds when dispensing with the Peri-pump.

n*Important: when dispensing to 6-, 12-, 24- and 48-well plates (with a non-
RAD cassette) some dispense tubes must be removed from the Peri-pump's
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fluid supply vessel. See Handling Special Plates and Mini-tubes on
page 134.

Quick Wash

Home>Quick>Basic Wash

Quick Wash uses default values for all parameters except those available for
modification: volume, plate type, number of cycles. Quick Wash is useful when
you do not need to retain protocol parameters for future use or reference. The
Magnet Adapter Height and Plate Clearance instrument settings apply to the Quick
Wash to accommodate non-standard plates.

Define a Quick Wash

1. Touch the field you want to change for a pick list of options or a number pad.

2. Make your selections, put a plate on the carrier, and press Start to wash the
plate.

Learn more:
l Create a protocol to save a record of the wash parameters, to confidently repeat the
wash procedure and/or to modify wash parameters to improve performance.

l See Wash Parameters Table on page 108 to review options available in a wash protocol.

l See About the Wash Step.

Add protocols to the Home screen

The MultiFlo FX puts all saved protocols on the Home screen for easy retrieval.
Create and save a protocol to add it to the Home screen listing.

Create or Modify a Protocol on page 102.

Remove protocols from the Home screen

All saved protocols appear on the Home screen. To remove a protocol from the
Home screen listing:

1. Select Protocols at the Home screen.

2. Highlight the protocol you want to remove and press Delete.

The protocol file will be permanently deleted.
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nTo delete a locked protocol, first unlock it.

Locked files: you can "unlock" a protocol by replacing it using the Protocol Transfer
control. Upload the protocol to a USB stick, make sure "Lock files" is disabled and re-
transfer the protocol. It will overwrite the existing file.

Get protocols from a memory stick - USB drive

Important: Put the protocols you want to transfer to the washer in a folder called
Protocols. The MultiFlo FX expects to find a Protocols folder on the memory stick.

You can exchange MultiFlo FX protocols with other users, copy protocols from one
washer to another, or obtain sample protocols from BioTek's website using a
USB stick:

1. Insert the memory stick into the USB port on top of the washer.

2. Select Instrument>Next>Other from the Home screen.

3. Press Transfer Protocols.

4. Choose the File Source: USB to copy protocols from it to the washer.
(Conversely, choose Internal to copy protocols to the USB flash drive to share
them with another instrument.)

5. Optionally, apply the Lock files option to prevent users from changing the
protocols.

6. Select files individually by highlighting them (touch) or transfer all protocols
simultaneously.

Locked files: you can "unlock" a protocol by replacing it using the Protocol Transfer
control. Upload the protocol to a USB stick, make sure "Lock files" is disabled and re-
transfer the protocol. It will overwrite the existing file.

Hardware Change Detected

The MultiFlo FX displays a message at start up when it detects a configuration
change, e.g. a dispenser is unplugged.
l At installation: Syringe Dispenser users must enter calibration data. See Update the
instrument to use the Syringe Dispenser on page 74.
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l Ongoing operation: Check your instrument setup for any unintended changes: are the
serial cables properly connected to the back of the MultiFlo FX?
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Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the
Recommended Maintenance Schedule on page 176. Enable AutoPrime to keep tubes
from clogging.

Prime the tubing to remove air bubbles
l See Recommended prime volumes for the Peri-pump on the facing page

l See Recommended prime volumes for the Syringe dispensers on page 101

l See Recommended prime volumes for the Strip Washer on the facing page

Best Practices for all MultiFlo FX Devices
l Fill the supply bottles with sufficient fluid.

l Make sure the bottles, solutions, and tubing are clean and do not contain any particles or
mold. Solutions that are recycled over several days will grow algae, bacteria, molds, or
other undesirable organisms.

l Prime before dispensing. Priming the tubing is the most critical factor in assuring optimal
performance.

l Check the external tubing connections for kinks and clogs.

l Put microplates on the carrier with well A1 in the left rear corner as you face the
instrument, and firmly seat the plate in the carrier.

l To more quickly dispense to 384- and 1536-well plates, use the Instrument Utilities to
change the Dispense Pattern to Row. If precision is more important than speed, keep
the pattern set to Column.

Before using the Peri-pump
l See Release the tension on the dispense cassette on page 154.

l For top performance and to preserve precious fluids, Purge the fluid at the end of a
dispense run and Prime the tubing before dispensing. The tubing is permeable to air.
When 20 minutes or more have elapsed between dispenses, or less than 20 minutes
when using 1 µL cassettes, it is important to thoroughly prime the tubing before
dispensing.

l Use the priming trough insert to capture expensive reagents for reuse. The Peri-
pump’s insert can hold up to 12 mL.

l Filter the dispense fluid to 50 microns before dispensing with the 1 µL cassettes. The
dispense tips are very small. Filtering the fluid helps prevent clogging.

MultiFlo™ FX Multi-Mode Dispenser



Optimize Performance | 99

l Select the right cassette for the job: match your desired dispense volume to the
recommended cassette. The smallest recommended volume for a cassette type is one
aliquot. An aliquot matches the cassette type, 1 µL for the 1 µL cassette, 5 µL for the 5 µL
cassette, and 10 µL for 10 µL cassette. Except the RAD technology 8-to-1 cassette with 5
µL tubing, one aliquot is 5 X 8 = 40 µL.

l Dedicate cassettes for specific fluids or applications. Reserving specific cassettes
for specific uses avoids contamination.

l When the dispenser is idle, release the Tube Tensioner element of the cassette from
its place on the pump to minimize unnecessary stretching of the tubing. This is especially
true for the 1 µL tubing. The best practice is to unload the 1 µL cassette when dispensing
is completed.

Important: Remove the priming trough inserts when using the 8-to-1 RAD cassette.
The chute will collide with both the RAD priming cup and the Syringe dispenser insert if they
are left in the priming trough.

Before using the Syringe Dispenser
l Sufficiently prime the Syringe dispenser to ensure precision and accuracy: increase the
number of prime cycles to adequately remove all air bubbles from the tubing.

l Use the priming trough insert to capture expensive reagents for reuse. Each Syringe
dispenser’s insert can hold up to 6 ½ mL.

Recommended prime volumes for the Strip Washer

The predefined maintenance protocol for the strip washer fully primes the system,
pumping 40 mL through the tubing and pump:
l W-DAY_RINSE - recommended for daily maintenance and when changing fluids.

l Quick Prime: 5,000 µL is dispensed each time the quick prime is run. Recommended
for conditioning the dispense tips to correct for evaporation immediately prior to plate
washing.

l See also Minimum Prime Volumes for the Strip Washer on page 114.

nNote: the washer aspirates fluid during the prime step, but it does not fully
evacuate the priming trough insert.

Recommended prime volumes for the Peri-pump

Generally, the recommended prime volume is three times the dead volume, where
dead volume is the total internal volume of the fluid path. However, a primary
advantage of the Peri-pump dispenser is its entirely visible fluid path. This allows
you to prime the tubing until all visible signs of air bubbles are dissipated.
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Cassette Type Dead Volume

1 µL 1.20 mL

5 µL 4.23 mL

10 µL 7.36 mL

RAD technology single-tube cassettes have the lowest dead volume:

Type Dead Vol.

1 µL 150 µL

5 µL 530 µL

10 µL 920 µL

Use BioTek's Peri-pump Reservoir Holder on page 60 and Shorten the Dispense Cassette
Tubing on page 61 to significantly reduce the dead volume to preserve expensive reagents.

At the start of the day:

Prime the tubing to prepare for a dispense run.

1. Reload the cassette and fill the supply vessel:
l When dispensing solutions not effected by water, prime with the dispense fluid.

l When dispensing protein solutions, first prime the tubing with a buffered saline
solution to remove any traces of water in the tubing, then, prime with the dispense
fluid.

2. Press the Prime button until fluid flows into the priming trough and all visible
air bubbles have been removed.

At the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime the tubing to flush it
clean.

1. Press the Purge button until the tubing appears empty.

2. Replace the supply vessel with the appropriate rinse fluid:
l When dispensing water soluble solutions, use deionized or distilled water.

l When dispensing protein solutions, first prime the tubing with a buffered saline
solution to remove protein particles, then, prime with deionized or distilled water.

3. Press the Prime button:
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l 1 µL cassette = 5 seconds

l 5 µL cassette = 7 seconds

l 10 µL cassette = 10 seconds.

The MultiFlo FX will prime for this duration each time, which dispenses fluid
approximately equal to the dead volume for the cassette type.

Recommended prime volumes for the Syringe dispensers

The predefined maintenance protocols for the syringe dispensers fully prime the
system, pumping 40 mL through the tubing and pump:
l S-DAY_RINSE_A&B - to fully prime both Syringe systems with 40 mL each

l S-DAY_RINSE_A or _B - defined for each Syringe

Modify these protocols as needed when changing fluids and performing other
tasks. Edit the protocol to add another prime cycle when changing fluids to make
sure all previously used fluid is expelled and replaced with the new liquid.

Quick Prime: 5000 µL is dispensed each time the quick prime is run.

The approximate dead volume for each Syringe dispenser system is 12 mL. Generally,
three times the dead volume completely primes the system. When using precious fluids,
e.g., expensive reagents, you can change the prime parameters: reduce the volume or
number of cycles specified in the predefined protocols or create your own protocols. Use
the priming trough inserts to capture expensive reagents when priming.

Optimize protocols to improve evacuation

When a wash protocol leaves too much residual fluid in the wells, optimize the
protocol with these recommendations:

l Add a secondary aspiration to a wash cycle below, including Final Aspirate,

l Decrease the aspirate Travel Rate,

l Add a Delay to the Aspirate and/or Final Aspirate step ,
l Lower the aspirate height (Z-axis position).

Add a secondary aspiration to a wash cycle

When too much residual is left in the wells during a wash cycle, you can add a
secondary aspiration to reduce it. Secondary aspiration can be performed
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immediately after each aspiration in a wash cycle and/or after the final aspiration
step.

nSecondary aspiration is also called Crosswise aspiration because it is typically
performed in a different location within the well. Reposition the tubes by
defining different X-, Y-, and/or Z-axis positions when enabling the secondary
aspiration for the most effective evacuation of the wells.

Edit the Wash step or stand-alone Aspirate step to add a secondary aspiration:

LHC Touch screen

1. Double click the step in the
protocol to open it for editing.

2. Click Advanced Options (for
Aspirate) and enable Perform
Secondary Aspirate.

3. Apply a second aspiration to the
Final Aspirate, also, for best
evacuation results.

4. Optionally, adjust the position of
the manifold as it addresses the
wells.

1. Edit the Wash step or stand-alone
Aspirate step: Protocols>Edit.

2. Select Advanced Options (for
Aspirate) and enable Perform
Secondary Aspirate.

3. Use the Align tool to define a
crosswise aspirate position.

4. Apply a second aspiration to the
Final Aspirate, also, for best
evacuation results.

For example, you may want to adjust the X- or Y- axes to get to hard-to-reach areas
of certain types of wells. Or, you may want to lower the height (reduce the Z-axis),
to better evacuate fluid.

Create or Modify a Protocol

Home> Protocols

To create or edit a protocol:

1. Select Protocols at the Home/Maintenance screen.

2. Press Create or highlight the protocol and press Edit.

3. Name:
o New protocols: Touch the name field to open a keyboard. Enter
a unique name for the protocol.

o Editing protocols: Press the Info button and touch the name
field to change the protocol name. This will create a new copy of
the protocol you are editing. Later you can delete the original
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file, if desired.

4. Plate Type:
o New protocols: If needed, touch the plate type field to select a
different plate type.

o Editing protocols: Press the Info button and touch the Plate
Type field to change the plate type.

5. Add/Edit steps:
o New protocols: Add a step to the
protocol (touch the Add button), select
a step and define its parameters.

o Editing protocols: Highlight a step
and press Edit to modify its
parameters.

o Adding steps: Highlight the <end of
steps> or a step to be preceded by the
new step, and press Add and the action
button to insert a step.

Copy a similar protocol and then edit it to meet different requirements or to test
different parameters.

When editing a protocol, cut and paste steps to move them to the correct position.

6. Continue adding or editing steps, as needed.

7. Press Save to save the protocol. All saved protocols are put on the
Home screen for easy retrieval.

Optionally, do a test run to verify the protocol performs as
expected. Test Run executes the protocol. Fill vessels with
water or disconnect them if you want to preserve reagent.

Especially when creating complex BioStack protocols, use the
Validate button to check the order of the protocol steps.

Protocol Parameters Tables

For Wash step parameters see Wash Parameters Table on page 108.

Peri-pump Parameters
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Step Option Description/Values range Default
values

Prime To remove air from the tubing.

Volume: 1-3000 µL 300

Duration: 1-300 seconds 3

Dispense

Volume The per-well volume to dispense: 10

Up to
30,000 µL
per well is
supported.

1 µL cassette = 1 - 50 µL and 0.5 µL (HLF-D) for some
models*

5 µL cassette = 5 - 2500 µL

10 µL cassette = 10 - 3000 µL

Flow rate: The rate, μL/second/tube, that fluid is dispensed for
each cassette type:

Cassette Type 1 μL 5 μL 10 μL

(μL/sec/tube)

Low 50 120 140

Medium 60 140 160

High 64 160 180

RAD technology: Single-channel cassette flow rates
match the standard cassettes and the 8-to-1 cassette
matches the 10 µL flow rates.
When dispensing 0.5 µL with the 1 µL cassette the
average flow rate values are:

1 μL Cassette 0.5 μL Dispense

(μL/sec/tube)

Low 52

Medium 54

High 56

High

Cassette
type
require

To require a specific cassette type for this protocol. If
yes, select the type, if no, select ANY. See Peri-
pump Settings to learn more.

ANY
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Step Option Description/Values range Default
values

d?:

Plate
type:

Select the plate type, and optionally, limit the
columns dispensed to. For high density plates,
skipping certain "Rows" sections is supported, see 8-
Channel Dispenser Dispense Pattern on page 139.

96

Position: X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted to improve performance. X- and Y-
axes default to 0 steps for all plate types.

Z = plate
type
dependen
t

Pre-
dispense:

Also called "tip priming," pre-dispense normalizes the
tips to ensure precise fluid distribution. Pre-dispense
is recommended for most applications. Set volume
and number of pre-dispenses, except, when
dispensing 0.5 µL, the volume is preset: 0.5 µL for 4
cycles by default.

10 µL
2 cycles

Purge To preserve fluid in the tubing by pumping it back into
the supply vessel, i.e. reverses the flow direction.

Volume: 1-3000 µL 300

Duration: 1-300 seconds 3

Note: *Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested.
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it.
Only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for example. Perform
two dispense steps, one for the half microliter and another at a full increment to achieve
these volumes.

Important: Remember that the Peri-pump, the Syringe dispenser and Washer manifolds
travel on the same dispense arm. Keep this in mind when adjusting the Z-axis or
Dispense Height of any dispenser. A too low setting can cause a dispenser to crash into
the plate.

Uninstall the dispense cassette, if it is not required by a protocol, to prevent collisions
when trying to position the Syringe or Wash dispenser as close as possible to the wells.
And/or, consider increasing the Plate Clearance Height setting to increase the travel
height.
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Syringe Dispenser Parameters

Step Option Description/Values range Default
values

Prime

Flow rate: 1-5 (See dispense step description below) 5

Volume: 80-8000 µL. To remove air from the tubing. 5000

Syringe: A or B A

Cycles: Number of prime cycles to perform 2

Pump
delay:

0-5000 msec. 0

When dispensing highly viscous fluids, the tubing's
check valves perform more slowly. Delaying the
syringe pump sufficiently to allow the specified
amount of fluid to pass through the check valves
before being pumped into the syringe has been shown
to improve dispense accuracy.
Begin by setting the delay to 500 msec. Experiment
with different settings to determine the optimal value
for your fluid.

Submerge
tips:

To soak dispense tubes in the priming fluid for a
specified duration for cleaning or maintenance
purposes. If yes, set duration, up to 24 hours, in
minutes. See Syringe Prime Step on page 161 to
learn more.

0

Dispense

Flow rate: Rates 1-5 are dependent on the volume and plate
type, except for 1536-well plates. See below.

2

Dispense
Volume:

5-30,000 µL depending on the plate type. 10

Syringe: A or B or Both A

Columns: Select the plate type, and optionally, limit the columns
dispensed to.

96

Pump
delay:

(Same as Prime step description above.)

Position: X- and Y- horizontal axes, and dispense height (Z- or
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Step Option Description/Values range Default
values

vertical axis) can be adjusted to improve
performance. Default values are plate type
dependent, and position the manifold at least 1 mm
above the plate.

Pre-
dispense:

When enabled, dispenses into the priming trough
immediately before filling the plate. Pre-dispense is
recommended for most applications. It normalizes the
tips to ensure precise fluid distribution. Set volume
and number of pre-dispenses.

10 µL
2 cycles

Syringe Dispenser Flow Rates:

Rates are volume and plate-type dependent:

For example, rate 1 must be used when dispensing between 10-19 µL to a 96-well
plate. When dispensing 20-49 µL to a 96-well plate, you can use rates 1 or 2. And,
when dispensing 50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so
on, as shown in these tables.

96-well plate 16-Tube 8-Tube

Volume
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350
80-3000 1-5 1000 420

384-well plate

Volume
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450
40-1500 1-5 500

nNote: For 16-channel syringes the µL/sec/well rate accounts for 2 tubes/well
when addressing 96-well plates and one tube/well for 384-well plates.
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1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do
not have minimum volumes.
The µL/sec/well for each type of
manifold, Small Bore (SB) and Large
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3.

Low-density-plate manifolds

Like the standard manifolds described above, for these plate-type-specific
manifolds the flow rate is defined as µL/sec/well and the minimum volumes are
cumulative, i.e. any rate can be used to dispense Rate 5's minimum.

Manifold Flow/Minimum
Volume Rate 1 Rate 2 Rate 3 Rate 4 Rate 5

6-Well Flow 560 836 1116 1400 1680

Min Vol 40 80 200 240 320

12-Well Flow 420 627 837 1050 1260

Min Vol 30 60 140 160 220

24-Well Flow 280 418 558 700 840

Min Vol 20 40 100 120 160

48-Well Flow 279 372 560 600 800

Min Vol 40 80 200 240 320

Wash Parameters Table

See Protocol Parameters Tables on page 103 for Peri-pump and Syringe
Dispenser parameters. See Plate Types Table on page 9 for default Z-axis values
or dispense heights.

Minimally, a wash step includes an aspirate step followed by a dispense step.
Select and define each option to customize the parameters for your assay.
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Option Description/Values range Default
values

Number of wash
cycles

Each wash cycle first aspirates and then dispenses
fluid to and from the plate.

3

Aspirate

Travel Rate The rate at which the washer manifold travels down
into the wells. The selection range is 1 to 5 for non-
cell-based assays, from slowest to fastest. With
these rates, the tubes slow their descent as they
approach the defined aspirate height (Z Position) to
aid complete evacuation of the well.

3

For delicate, cell-based assays, the range is 1CW
(cell wash) to 4CW and 6CW. These rates minimize
turbulence in the wells. The tubes descend at a
constant rate to the specified height. Rate 6CW
creates the least disturbance and performs fastest.

Delay Amount of time the tubes stay at the aspirate height
before lifting out of the wells. Define a delay
between 0 - 5000 ms. Increasing the delay may
improve evacuation of the wells.

0

Positioning X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted to improve performance. The
default Z-axis setting is plate dependent. See Z-
Axis: Default Dispense and Aspirate Heights.

Z = 91 for
96-well
plates;
X & Y = 0

Secondary aspirate Also called Crosswise Aspiration. First, the wells are
aspirated using the position defined above. The
aspirate tubes rise and then descend to the
secondary position to aspirate again. Employ this
option to improve evacuation.

No

Final Aspirate A final aspiration is the last action performed to
completely evacuate the wells. Same parameters as
regular aspirate step.

Yes

Dispense

Flow Rate The rate at which the fluid is dispensed from the
tubes. For cell-based assays, use rate 1 or 2 for
gentle washing. For normal dispensing, the range is
3-11, 3 is slowest and 11 is fastest.

5

Volume µL/well dispensed: See Washer Flow Rate on page
111.

Plate type
specific
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Option Description/Values range Default
values

Positioning X- and Y- horizontal axes, Z- height (vertical) axis
can be adjusted to improve performance. See Z-
Axis: Default Dispense and Aspirate Heights.

Z = 336 for
96-well plate
X & Y = 0

Vacuum Delay Suspends the vacuum pump until a certain volume is
dispensed. This feature is critical to cell wash
operations. It delays normal aspiration until the
specified volume has been dispensed to the wells.
The range is 0 to 30,000 µL/well.

0

More Options

Pre-dispense Quick, small prime to condition the tips before
dispensing.

No

Bottom wash Bottom washing adds an initial wash cycle to the
specified number of cycles. Fluid is simultaneously
dispensed and aspirated to create cleaning
turbulence (at the specified height). The manifold
descends to aspirate again and ends with a final
dispense to fill the wells.

No

Between cycles:

Shake To mix the contents of the plate. No

Duration From one second to one hour. 5 sec.

Intensity Intensity Variable cycles through the other
levels of intensitySlow

Medium
Fast

Medium

Soak Delays wash for the duration to allow fluids in the
plate to steep or incubate.

No

Duration From one second to one hour. 30

Home carrier To perform the shake or soak in the home position
or not. But, the plate carrier is moved home when
the total duration of the shake and/or soak exceeds
1 minute. The vacuum pump is turned off in this
scenario. Moving the plate home prevents
contaminating it with drops from the manifold.

No

Pre-dispense
between cycles

To wet or condition the manifold tubes between
cycles, which is only needed after a long soak.

No
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Option Description/Values range Default
values

Same parameters as regular pre-dispense.

Wash format Manner of processing large-format plates Plate

Strip Performs the entire wash step on one section of the
plate before it moves to the next section.

Plate Performs each cycle on the entire plate before it
starts the next cycle. All wells in the plate are
aspirated, then dispensed to, and so on.

Washer Flow Rates

The default setting for flow rates is 5, in the middle of the range. Rates increase
from the slowest to fastest (11). Slower rates are recommended for viscous fluids.
Rate 1 is designed for cell wash assays, causing the least disturbance in the wells.

Rate µL/tube/second

Cell Wash 1 123

Cell Wash 2 140

3 210

4 252

Default 5 279

6 348

7 422

8 595

9 643

10 791

11 992

Note that flow rates are per tube. Depending on the wash manifold and plate type
there may be multiple tubes in a well.
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Minimum Dispense Volumes (µL/well) per Manifold

Rate 96/384-well 6-well 12-well 24-well 48-well

1 CW 40 155 105 80 60

2 20 65 60 40 60

3 20 65 60 40 60

4 30 120 60 60 60

5 20 120 80 60 60

6 40 150 80 80 60

7 55 225 100 110 70

8 50 225 140 105 70

9 60 225 160 120 100

10 100 400 260 200 105

11 110 450 290 220 150

Aspirate Travel Rates

Rate mm/sec

0 CW 1.0 for 6-, 12-, 24-well
plates

1 4.1 +1 Slowest

1 CW 4.1

2 5.0 +1

2 CW 5.0

3 7.3 +1 Default rate

3 CW 7.3

4 9.4 +1

4 CW 9.4

5 9.4 +2 Fastest

6 CW 14.7 Recommended rate
for Cell Wash
protocols
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Rate mm/sec

7 CW 30.0

CW rates are specially designed travel rates that minimize turbulence in the wells
for Cell Wash protocols. 6 CW is recommended for cell-based and magnetic-bead
assays. Alternatively, use 7 CW if loosely adherent cells are damaged by rate 6 CW,
to further reduce turbulence in the wells. Expect a larger residual volume in the
wells when using rate 7 CW. Exception: choose rate 0 CW when using 6-, 12-, and
24-well plates.

Standard rates (1-5) show two speeds as they approach the well because they slow
down to 1 or 2 mm/sec before reaching the aspirate height to provide more time to
aspirate the fluid, improving evacuation. Conversely, the CW rates do not change
speeds, they move into and out of the well as quickly as possible to limit
turbulence.

Pre-Dispense

Wash and Dispense Step option

Also called Tip Priming.

About the Pre-Dispense Options

Enable the Pre-dispense options to condition or normalize the dispense tubes
before dispensing fluid. This is recommended for precise dispensing to mitigate
evaporation or any potential fluid imbalance at the ends of the tubes.

The pre-dispense options are not intended to fully prime the tubing, for example,
when changing fluids. Be sure to fully Prime the device to remove all air from the
tubing before commencing a dispense step. Use the Pre-dispense feature to quickly
prime the tubes or tips between runs.

When a Pre-dispense is enabled, the MultiFlo FX moves the plate to the home
position to allow the manifold to dispense into the priming trough.

How to condition the tips before dispensing
l In a stand-alone Dispense step: select the Advanced Options link and fill the Pre-
dispense checkbox;

l In a Wash step, select the Show Wash Options link and fill the Pre-dispense checkbox.
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Minimum Prime Volumes for the Strip Washer

Flow rate: Wash Manifold Type

6-Well 12-Well 24-Well 48-Well 96/384-Well

1 310 315 320 360 320

2 130 180 160 360 160

3 80 180 80 360 80

4 240 180 240 360 240

5 240 240 160 360 160

6 300 240 320 360 320

7 440 300 440 420 440

8 400 420 400 420 400

9 400 480 480 600 480

10 800 780 800 630 800

11 880 870 880 900 880

Bottom Wash

Bottom washing adds an initial dispense/aspirate sequence to the protocol. Fluid
is simultaneously dispensed and aspirated to create cleaning turbulence (at the
specified height). The manifold descends to aspirate again and ends with a final
dispense to fill the wells.

Designed for strongly bound molecules in assays that require vigorous washing,
e.g. ELISA, adding a bottom wash to the protocol has shown reduced background
noise without increasing the number of wash cycles.

Adjust the Z-axis setting to position the manifold deep in the well to target the
solid phase of coated assay plates.

BottomWash Volume: Enter the volume of wash solution to dispense per well
during the bottom wash.

Flow Rate: Select a rate between 3-11 for best results. Cell wash options are
designed for gentle washing, while bottom wash is designed for vigorous washing.
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Advanced Options

Parameters Description

BottomWash
Height:
Z-axis Position

The distance between the bottom of the aspirate
tubes and the carrier surface. The value in mm is
displayed on screen.

Horizontal X-
axis Position

The left and right position of the dispense tubes
when the carrier is beneath the manifold.

Horizontal Y-
axis Position

The front-to-back carrier position (or Y axis) to align
the microplate with the manifold tubes during a
dispense.

Delay start of
Vacuum

until dispensing this volume.

Change the Plate Type

Edit a protocol to change its plate type:

1. Select Protocols at the home screen.

2. Highlight the protocol and press Edit.

3. Press the Info button on the step definition screen and touch the Plate Type
field to change the plate type.

4. Press OK to save the change. Press Save at the step definition screen to save the
protocol.

Rename a protocol

There are two ways to rename a protocol, edit the name or make a copy and
rename the copy. The MultiFlo FX behaves like Windows' Save As function,
creating a copy of the protocol file when it is renamed.

To change the protocol name:

1. Select Protocols at the Home screen.

2. Highlight the protocol and press Edit.

3. Press Info and touch the Name field.

4. Press OK and Save the protocol when you're done.

You can delete the originally named protocol to remove it from the Home screen.
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Shake/Soak Step Parameters

Select the action to perform:
l Move carrier to home position first.
Regardless of selection, the plate carrier is moved home during a stand-alone shake step
and when the total time of the shake and soak durations exceeds 1 minute. The vacuum
pump is turned off in this scenario. Moving the plate home prevents drops from
contaminating the plate.

l Shake settings:

l Duration: enter numeric values to shake the plate for up to 1 hour.

l Intensity: use the drop-down list to select a shake intensity. "Variable" cycles
through the other levels of intensity.

Choose the intensity that most closely matches your assay kit instructions.

Magnetic Bead Assays: Set the shake intensity to Slow when using a magnet
on the plate carrier.

l Soak: allows buffer/dispense fluid to remain in wells for the specified duration, i.e.
processing is delayed:

l Duration: enter values to stop processing the plate for up to 1 hour (59
minutes, 59 seconds).

nSoak is not the same as "submerge" the tips. You must define a prime step or
use the AutoPrime feature to soak the tips in the priming trough.

nSoak is equivalent to incubating the plate at room temperature or delaying the
protocol.

nShaking and soaking the plate is also an option when defining a Wash step.

Repeat steps in a Loop

Add a Loop to the protocol to repeat one or more steps a fixed number of times.
The Loop is a step container. First, add the Loop step to the protocol and then put
the action steps between the loop start and end steps.
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How to use a Loop:

1. Highlight a step or <end of steps> placeholder and select the Loop button,

2. Enter the number of times to perform the steps in the loop. The Loop # times
start and Loop end steps are added, with the end step highlighted.

3. Add the steps and define their parameters.

4. When all the protocol steps are defined, select Validate to make sure the
instrument can perform them.

5. Save the protocol.

Make sure the steps to be performed are inside the Loop's start and end steps.

Delay the Protocol

Use this control to temporarily delay the procedure. It adds a delay step to your
protocol. You can set:
l an indefinite delay, which must be manually ended during operation;

l a fixed duration or timed delay, which can be manually overridden when necessary;

l or, for more precise control, a timer to launch a protocol step. This "timer activated"
delay lets you apply a uniform processing time to each plate in a multi-plate run.

Delay Type 

Indefinite: to delay the procedure until the operator manually restarts the run. A
message box will open with a Continue button. Any Prompt text will be displayed
on-screen. The run will be paused until the operator clicks Continue.

Fixed-duration: to pause the protocol for a certain length of time. Specify the delay
duration in the time control. At the start of the delay, a message box will open with
a Continue button and any Prompt text. The operator can override the delay at any
time by clicking the Continue button. Otherwise, the protocol will not resume until
the specified time has expired. The maximum length of a fixed delay is 23:59:59 (23
hours, 59 minutes, 59 seconds).
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Timer-activated: use this option to control the start time of a protocol step. This
option is most useful in complex protocols that use the BioStack or another robot to
process multiple plates. You can make sure that each plate is processed at a precise
time.

Delay Behavior

Sound alert at start of delay: de-select this option to silently display the message
box at the start of the delay. The audio volume is controlled under
Instrument>Preferences. It chimes one time only at the start of the delay
concurrent with an opening message.

Prompt: enter text, if desired, to display in a message box that opens during
runtime at the start of the delay.

Timer Activated Delay

To gain precise control over your chemistry in complex protocols, consider using
the Timer Activated delay option to specify when to launch a protocol step. You
can make sure processing time is the same for every plate, to ensure, for example,
that reagent remains in every plate for a minimum or uniform time period.

This is especially beneficial when designing a multi-step BioStack protocol that is
run with varying numbers of plates in the stack. If the timer is not used in this
scenario, assay performance could be significantly different in a run of 30 plates
versus a 10-plate run.

nImportant: if the timer activated interval elapses before the steps in the step
container are completed, there will be no delay, i.e. all steps will be executed
without timed control.

A Timer-Activated Delay puts start and end steps in the protocol, similar to the
BioStack loop. To remove the delay from the protocol, you must delete both steps.

Examples:

nThese examples show protocols for an EL406 Washer Dispenser, but the same
principles apply to the MultiFlo FX.

Simple Delay

To use the timer successfully, you must first determine the approximate duration
of your protocol steps. Specify a sufficient time lapse to both complete the steps
and to delay the process to suit your assay.
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When a 'timer activated' delay is defined, Delay start and end events are added to
the protocol. The start and end events create a step container, similar to a Loop or
BioStack run.

The example above shows how to manage the start time of two sequential
operations, or steps. In this example, the timer is started prior to the Peri-pump
dispense operation and ended prior to the Syringe pump dispense operation. The
specified 5-minute delay is much longer than the duration of the Peri-pump
dispense operation.

Nested Delays

The timer activated delay can be nested within another time controlled series of
protocol steps. This may be necessary to specify multiple processing start times for
a complex series of steps, including loops and BioStack steps.

This example uses a BioStack rack of plates. The process requires that each plate in
the rack be filled with 250 µL from the Peri-pump and then, after 1 hour, the plate
is washed. The protocol will fill each plate in the rack, restack the plates, and then
wash each plate 1 hour after it was filled. The dispense and wash activities are each
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performed within a 1 minute processing window created by the timers. This timer
configuration ensures that the timing of washing after dispensing is identical for
every plate.

Once again, make sure there is sufficient time to process all the steps within the
step containers, and to incorporate any desired incubation or rest periods when
defining the timer-activated time period.

RUN: Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument
in top condition and for qualifying its performance. Review the Predefined
Protocols on the facing page.

To run a defined protocol:

LHC Touch screen

1. Select Open and locate the
MultiFlo FX folder.

2. Open the MultiFlo FX folder to
access the more folders.

Important: Be sure to Customize the
Predefined Protocols below

1. Touch a protocol on the Home or
Maintenance screen to select it.

2. Press Start to run it.

LHC Users Only: Customize the Predefined Protocols

BioTek provides predefined protocols for maintenance routines and instrument
qualification tests. You can quickly customize the protocols for regular use.

The LHC keeps track of the last-used COM port for an instrument type. For example,
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406
is used, the LHC applies the same COM port setting. You can disable this feature by defining
your Ports preference: select Tools>Preferences>Ports.
To correct the COM port for the current protocol, click the Port link and use the drop-down
list to select the correct value. The LHC stores the COM port value in the protocol file.

With the MultiFlo FX connected to and communicating with the host computer
(i.e. make sure the instrument is turned on and not busy):
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1. Click the Open button, locate the MultiFlo FX folder and click Open.

2. Open the Maintenance or other folder and select the desired protocol.

3. Change the COM port if necessary: click Port and enter the correct value
or select from the drop-down list.

4. Click Settings, which opens the Instrument Settings dialog.

5. Under Get settings from: click the instrument link.

6. Click Validate.

A "Validation successful" message is displayed unless the protocol cannot be
run on your instrument. See LHC Protocols Explained.

7. Save the protocol.

Predefined Protocols Listing

Maintenance Protocols

Daily
Maintenance Description

W-DAY_
RINSE

Simple one-step protocol to fully flush the system with water or reagent to
keep the manifold tubes clog-free. 40 mL total volume.

S-DAY_
RINSE_A&B

Two-step protocol to flush tubing for both syringe pumps, (A & B). 40 mL
per syringe. Similar protocols with one step for each individual syringe are
also provided: S-DAY_RINSE_A or_B.

P-#UL_CASS_
RINSE

Where # matches the cassette type in use and RAD refers to
RAD technology cassettes. Simple one-step protocol to flush Peri-pump
tubing. (P2 protocols are for the secondary Peri-pump.)

W-
OVERNIGHT_
LOOP

Protocol designed to keep the manifold in a wetted condition overnight or
for a long downtime period; manifold tubes are submerged in fluid for 4-
hour intervals between primes in this virtually endless loop.

W-RINSE_
AND_SOAK

Identical to W-DAY_RINSE with one addition, the manifold tubes are
submerged and soaked for 5 minutes in the fluid.

Periodic Maintenance

W-Decontaminate Two stage protocol to decontaminate the washer, first flushing lines
with disinfectant and then rinsing them with deionized or distilled
water. Prompts guide the user through the process.
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Periodic Maintenance

S-Decontaminate Includes prompts for first running disinfectant and later running water
through the system. It can be easily modified to suit any major
cleaning effort. The A or B suffix identifies the syringe the protocol is
designed for.

W-LONG_
SHUTDOWN

Helps implement the recommended procedure for preparing the
instrument for storage. This protocol includes prompts for running
disinfectant, then water, and lastly, air through the system.

S-LONG_
SHUTDOWN

Prepares the instrument for long-term storage. This protocol includes
prompts for running disinfectant, then water, and lastly, air through
the system. Defined to use Syringe A or B. 

W-PRIME_40 Simple prime routine.

QC (Quality Control) Protocols

Manifold-Specific

QC_96_DISP_TEST Dispense precision test protocol for 96-well wash manifold.

QC_96_EVAC_TEST Evacuation efficiency test protocol for 96-well wash manifold.

QC_SA-1536_
DISP_TEST

Dispense precision test protocol for 32-tube Syringe A manifold.

QC_SB-1536_
DISP_TEST

Dispense precision test protocol for 32-tube Syringe B manifold.

QC_P-1536_DISP_
TEST

Dispense precision test protocol for Peri-pump 1 µL cassette and
1536-well plate. (P2 protocols are for the secondary Peri-pump)

Predefined Sample Protocols

The "Sample" protocols are provided to facilitate learning. Some samples are model
specific. "P2" protocols are copies of the primary protocol but defined for the
Secondary Peri-pump.

LHC users: You may need to customize the protocols (as described on page 120) to
match your instrument's settings.

Serial dilutions

P-96_
DILUTION

Peri-pump serial dilution protocol dispenses 20 µL to 240 µL in 20 µL
increments to each column of the plate. 20 µL to column 1; 40 µL to
column 2; 60 µL to column 3; and so on till 240 µL to column 12.
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P-384_
DILUTION

Serial dilution protocol dispenses 2 µL to 94 µL in 2 µL increments to
each column of the plate. 2 µL to column 1; 4 µL to column 2; and so on
till 94 µL to column 24.

S-96_
DILUTION

Syringe dispenser serial dilution protocol dispenses 240 µL to 20 µL in
20 µL increments to each column of the plate. 240 µL to column 1; 220
µL to column 2; 200 µL to column 3; and so on till 20 µL to column 12.
Defined for Syringe A.

S-384_
DILUTION

Serial dilution protocol dispenses 98 µL to 6 µL in 4 µL increments to
each column of the plate. 98 µL to column 1; 94 µL to column 2; 90 µL
to column 3; and so on till 6 µL to column 24. Defined for Syringe A.

Cell Wash

W&P-96_
CELL_WASH

Cell wash-dispense protocol uses the special low-flow tubing, optimal
dispense and aspirate heights, and vacuum delay during the wash step.
Following the wash, the Peri-pump dispenses 200 µL to each well.

Microplate Manufacturers

W-
COSTARFLAT

Standard wash protocols modified to best position the manifold tubes
for dispensing and aspirating to Corning Costar flat-bottomed and
round-bottomed wells.

W-COSTAR_
ROUND

W-NUNC_384 Standard wash protocols modified to best position the manifold tubes
for dispensing and aspirating to Nunc® flat-bottomed wells, round-
bottomed wells, and 384-well plates.W-NUNC_FLAT

W-NUNC_
ROUND

RAD Technology Peri-pump Cassettes

P_RAD-96 100 µL/well Peri-pump dispense using a single-tube RAD cassette to
partially fill a 96-well plate, hit-picking wells to spell "RAD." Begins with
two 20 µL/tube pre-dispenses.

P_RAD-384 50 µL/well Peri-pump dispense using a single-tube RAD cassette to
partially fill a 384-well plate, hit-picking wells in a pattern that
represents the BioTek logo. Begins with two 10 µL/tube pre-dispenses.

P_RAD 8Tube-
24

1120 µL/well Peri-pump dispense using the 8-to-1 RAD cassette to
partially fill a 24-well plate, dispensing to each corner well and 4 wells in
the center. Tip Tracking is enabled with an initial Z-axis of 5.08 mm. The
chute is positioned to direct the fluid stream to the well walls with an X-
axis offset of 2.97 mm.

Note: duplicate protocols defined for the Secondary Peri-pump have a P2 prefix.
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Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the
MultiFlo FX, here is some important information about running it:

Touch Screen Control:

l The Quick Wash and Quick Dispense options do not function with the BioStack, i.e. the
BioStack will not deliver a plate. You must create a protocol to process plates using the
BioStack. Touch screen protocols must contain a BioStack loop.

l You can use the Quick Wash and Quick Dispense Prime options. This is recommended
especially prior to processing plates, to remove air from the tubing.

l To process plates with lids (a BioStack4 feature), you must have a Lid Definition file
that precisely matches your plate and lid type, and you must enable this option when
defining the protocol (not at runtime).

LHC Control:

l LHC users: connect both the BioStack and the MultiFlo FX to the computer and control
them with the LHC.

l Design protocols that integrate BioStack controls with MultiFlo FX steps. LHC protocols
must contain a BioStack loop.

l In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down menu,
select Controlling the Bio-Stack with LHC. It only takes a couple minutes to
complete this interactive demo. It is a great way to learn about the special BioStack
features offered with the LHC.

Install and Align the BioStack:

1. Set up the BioStack according to instructions in your BioStack Operator’s
Manual to interact with the MultiFlo FX. Connect the BioStack to the:

o Host computer (PC) when using the LHC to control the MultiFlo FX.

o MultiFlo FX when using the touch screen for instrument control.

2. Align the BioStack’s gripper with the MultiFlo FX’s plate carrier:

LHC: Touch screen:

1. Select Tools> BioStack
Utilities.

2. Use the Alignment Utility.

Click the Help button for
detailed instructions.

1. At the Home screen, select
Instrument>Next>BioStack.

2. Fill the BioStack installed checkbox.

3. Press BioStack Alignment to launch
this utility.
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3. Set the BioStack operating mode:

LHC: Touch screen:

When controlling the BioStack with the instrument
and not processing plates with lids, you can choose
to run the whole stack or a specific number of
plates at runtime: use the BioStack controls on the
run screen.

Fill the BioStack checkbox in the
main view to enable the BioStack
action buttons and use them to design
a protocol that delivers and retrieves
plates.

Note: Both methods, LHC and touch screen, require a
BioStack-enabled protocol to run the stacker.

4. Verify the setup: perform a protocol with 1 or 2 plates. See How to define a
BioStack protocol below.

At the start of the day, power up the BioStack first, and then the MultiFlo FX.
BIOSTACK2WR: Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the physical dimensions of the MultiFlo FX are
available upon request. Contact BioTek customer service.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the MultiFlo FX to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Use the BioStack

How to define a BioStack protocol

nSelect Instrument>Next>BioStack and fill the installed checkbox to enable the
BioStack steps.

Like the Loop, the BioStack command is a step container. First, add the BioStack
step to the protocol and then put the action steps inside the BioStack start (deliver
plate) and end (return plate) steps. Here's an example:
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1. Highlight a step or
the <end of steps>
placeholder and press
Add and then
BioStack. This adds a
start step, BioStack
delivers and an end
step, BioStack returns
plate. The end step is
highlighted.

2. Press the desired
action button and
define the parameters
of the steps to be
performed on each
plate.

Make sure the steps to be performed on the plates are inside the 'BioStack
delivers' and 'BioStack returns' steps.

3. Optionally, highlight the <end of steps> placeholder, press Add and add a
Restack step to move the plates back to the input stack. A Restack step must
be outside the BioStack step container.

4. When all the protocol steps are defined, click Validate to make sure the
protocol is correctly designed.

5. Save the protocol.

6. At runtime, except when using plates with lids, you can define the Number of
plates to process in the Run Info section of the run screen: enter a specific
number or select the "Entire input stack" for processing.

How to run plates with lids

1. Select the Info button and fill the checkbox
to Use Lids.

2. Select a file in the Lid Type field that most
closely matches your plate type. (Touch
screen: press the field to select a file.) (Select
View definition to see the file's details.)

Conversely, de-select Use Lids to process plates without them.

MultiFlo™ FX Multi-Mode Dispenser



Operating with the BioStack | 127

Typically, the BioStack will work perfectly using one of the Plate Lid Definition
files provided by BioTek. Review the list to find one that matches your lids. If,
however, you do not find a match or you experience problems when transferring
plates or lids, create your own files. Use calipers to precisely measure the
dimensions of the plates and lids to be processed. Refer to the BioStack Operator's
Manual when creating your own files.

Re-stack plates in the BioStack

After the plates in the input stack have been processed, they are moved to the
output stack. The Restack step moves them back into the input stack in their
original order.

Important: The Restack step must be outside the "BioStack" step container and it must
follow a container. Only plates previously processed in a BioStack loop can be re-stacked.

Nth Plate to perform special process

nThe Nth Plate feature is only available when using the BioStack (and plates
without lids). And, the Nth Plate step must be put inside a BioStack step
container.

nTo precisely time the events in a BioStack run, also consider the Delay option:
Timer Activated Delay on page 118.

About the Nth Plate

Read About the Nth Plate step, if you haven't already done so. See Also: Advanced
Plate Sequencing with the BioStack for more details and to see examples.

How to define the Nth Plate Steps

Remember to consider the placement of the Nth Plate block in relation to non-
special steps. When you want a special function to occur after a certain number of
plates have been processed, put the Nth Plate block after that step in the BioStack
block. Otherwise, determine the optimal sequencing of the Nth Plate and regular
steps.

The MultiFlo FX will perform the regular BioStack steps on all plates until the
specified Nth plate is reached, then, the it will perform the Nth Plate steps. When
you want to perform a special function on the Nth Plate or before the Nth Plate has
been processed, put the Nth Plate block before the regular step.
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1. Highlight the "BioStack" end step or the step that the Nth Plate block will
precede and select the Nth Plate button. This adds start and end steps, with the
end step highlighted.

2. Define the start plate and how often to repeat the special procedure.

3. Use the checkboxes to:

l Run only the Nth Plate steps: fill the checkbox to perform only the steps in the Nth
Plate block (step container) at the designated plate. Leave the checkbox blank to
perform all the protocol steps on the Nth plate, i.e. both the Nth Plate steps and the
protocol steps that follow the Nth Plate block and precede the next Nth Plate block or
BioStack end tag.

l Remove plate before running steps: to perform the Nth Plate steps without a plate.
Alternatively, de-select the checkbox to perform the steps on the designated plates.

4. Click an action button and define the parameters for the "Nth Plate" steps to be
performed. Make sure the steps are within the Nth Plate start and end tags.

5. Click Validate to make sure the protocol syntax is correct.

Add a Delay step to the protocol/Nth Plate steps to allow time during processing to put a
special plate, like a priming plate, on the instrument or to do another manual task.

About the Nth Plate Step

nThe Nth Plate feature is only available when using the BioStack (and plates without
lids). And, the Nth Plate step must be put inside a BioStack step container.

When using the BioStack, the Nth Plate feature lets you perform a special function,
like dispensing blanks, after a certain number of plates have been processed or to
specify special processing for certain plates in the stack. The MultiFlo FX identifies
the special plate or plates (that we call Nth plate) by counting the number of plates
that have been processed before it.

You can limit the action, when the Nth Plate is reached, to perform only the "Nth
Plate steps." In this case, the Nth Plate steps can be performed with or without an
actual plate. Another option is to perform all the steps in the protocol, both regular
and Nth Plate steps, when the Nth Plate is reached.
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The Nth Plate step is a step container, similar to the Loop and BioStack step
containers. First, you add the Nth Plate step to the protocol and then put the action
steps inside its start and end tags. We call this grouping an Nth Plate block.

For the designated plates, you choose between performing only the Nth Plate steps
or performing both the Nth Plate steps and the protocol steps that follow the Nth
Plate block (and precede the next Nth Plate block). This means you must consider
the placement of the Nth Plate block in relation to the regular protocol steps when
designing a complex protocol. For simple actions, like performing a maintenance
step after a certain number of plates have been processed, make the Nth Plate
Block the last step in the BioStack step container. All the plates will be processed
the same way and then the instrument will perform the maintenance action.

For more complex processing, remember that the steps are performed in ordered
sequence beginning with the first step in the BioStack block. When the first step is
an Nth Plate block, the MultiFlo FX can evaluate it to determine which plates will
be handled in a special way. Any steps that precede an Nth Plate block will be
performed on all plates, including the Nth designated plates.

Multiple Nth Plate blocks can be defined in a protocol to sequentially perform a
series of varying actions on a specified grouping of plates.

Advanced Plate Sequencing with the BioStack

Read About the Nth Plate Step on the previous page, if you haven't already done so.

nTo precisely time the events in a BioStack run, also consider the Delay option:
Timer Activated Delay on page 118.

Numerous scenarios can be served using these special features, here are a few
examples:
l Use an Nth Plate step to flush the tubing or perform a maintenance task after a certain
number of plates have been processed.

l Use a series of Nth Plate or BioStack steps to test the number of wash cycles required for
optimal assay performance.

l Use a series of Nth Plate or multiple BioStack steps to perform a serial dilution on
recurrent groups of plates: dispense 200 µL to the first plate, 150 µL to the second, and
100 µL to the third.

The BioStack step block creates groups of like-processed plates. The Nth Plate lets
you create a mixed group of plates that have been processed with different
parameters. For example, using three Nth Plate steps you can process a stack of
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plates to stagger the dilutions, as shown in the table below. Similarly, three
BioStack step blocks can result in a stack of plates sorted into dilution groups.

Using a series of Nth Plate or BioStack step blocks we can dispense 100 µL to
plates in the first pass, 200 µL to plates in the second pass, 300 µL in the third pass.
Choose the method that matches your preference for sorting the plates in the stack:

Group Plate Nth
Plate

Use
BioStack

A 1 100 µL 100 µL

2 200 µL 100 µL

3 300 µL 100 µL

B 4 100 µL 200 µL

5 200 µL 200 µL

6 300 µL 200 µL

C 7 100 µL 300 µL

8 200 µL 300 µL

9 300 µL 300 µL

Use an Nth Plate step to perform maintenance

Certain fluids, like BSA, can clog the liquid handler's dispense tubes, so flushing
the tubes after dispensing to a certain number of plates is recommended for
optimal performance. When using the BioStack you can use the Nth Plate step to
add a maintenance routine to the protocol.

Here's an example of using the Nth
Plate step to perform an AutoClean
loop after every 15 plates have been
washed. The Nth step is defined this
way:

Run only Nth Plate steps is
checked.

Remove plate before running steps is checked.
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AutoClean will occur after 15 plates are washed, after 30 plates are washed, and so
on.

Use a series of BioStack steps

When using the BioStack you can treat plates in a non-uniform manner by defining
a series BioStack step blocks. You can, for example, determine the optimal number
of wash cycles required for an assay.

Don't forget to define the "Number of plates
to process" for all the BioStack loops in the
protocol. Enter the number of plates at
runtime or when defining the protocol.

In this example we create groups of like-
processed plates. The stack will contain in
this sequence:5 plates with 5 cycles, 5 plates
with 4 cycles, 5 plates with 3 cycles, and 5

plates with 2 cycles. The plates in the
BioStack's output stack will be sorted this
way:

Plates # Wash
Cycles

1 5

2 5

3 5

4 5

5 5

6 4

7 4

8 4

9 4

10 4

11 3

12 3

13 3

BioTek Instruments, Inc.



132 | Chapter 3: Operation

14 3

15 3

16 2

17 2

18 2

19 2

20 2

21 1

22 1

23 1

24 1

25 1

Alternatively, Use Nth Plate steps to create mixed groups of plates, where each
group contains a plate with 5 wash cycles, a plate with 4 wash cycles, a plate with 3
wash cycles, and so on.

Serial Dilutions Examples

Nth Plate: To generate mixed groups of dilutions in the stack of plates, as depicted
in the table below, three Nth Plate steps are used. The entire stack can be processed
this way.

1st Nth Plate: Every 3rd plate starting with 1
2nd Nth Plate: Every 3rd plate starting with 2
3rd Nth Plate: Every 3rd plate starting with 3

Plate Volume

1 100 µL
2 200 µL
3 300 µL
4 100 µL
5 200 µL
6 300 µL
7 100 µL
8 200 µL
9 300 µL
10 100 µL
11 200 µL
12 300 µL
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BioStack steps: To generate three distinct dilution groups in the stack of plates, as
depicted in the table below, three "BioStack" steps/step containers are used.

Volume Plate

100 µL 1

100 µL 2

100 µL 3

200 µL 4

200 µL 5

200 µL 6

300 µL 7

300 µL 8

300 µL 9

Plate Types and Processing Patterns

Depending on the type of hardware installed on the instrument, e.g. manifold type,
the MultiFlo FX can process several plate types. The default parameters for wash
and dispense steps represent the optimal positioning of the hardware for the plate
type. And, the aspirate and dispense heights and horizontal positions can be
adjusted when necessary for special situations and to optimize assay performance.
l Review the Plate Types Table on page 9 for a listing of supported plates and their
geometries;

l See Dispense Processing Patterns on page 138

l Review these instrument settings that may improve your work flow:

o Plate Carrier Setting

o Plate Clearance Setting

o Dispense Pattern
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Handling Special Plates and Mini-tubes

Note: Also see the Plate Types Table on page 9.

l Peri-pump Special Plate Handling below

l Mini-Tube Racks on page 137

1536F - 1536-well Flanged Plates

Important: Crashes can occur! Remove unused manifolds when dispensing to 153F
plates.

To prevent an unused Peri-pump cassette or Syringe manifold from colliding with
the plate flange during dispensing:

l use both Syringe manifolds simultaneously, and,

l unload the Peri-pump cassette when it is not being
used;

l alternatively, remove the Syringe manifolds while
using the Peri-pump;

l limit protocols to one dispenser only, either the
Syringe or Peri-pump, i.e. run multiple protocols on a
plate when the assay requires using more than one
device.

To achieve the best dispense performance when processing 1536-well flanged
plates, the MultiFlo FX's default protocol settings specify a low dispense height to
position the dispense tubes as close as possible to the wells. When the dispense
arm holds multiple dispense manifolds, the manifolds not addressing the wells can
collide with the plate flanges during a dispense.

Peri-pump Special Plate Handling

Note: Applies to non-RAD cassettes only, i.e. standard 8-channel cassettes.

The Peri-pump supports several plate types, but vessels with fewer than 8 rows
require special handling. Some adjustment of or consideration of how the 8-channel
dispense head will address the plate is needed.
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The Peri-pump’s dispense volume is per tube or channel, not per well. This is the
most important fact to consider when using these special plates. The volume
defined in a Quick Dispense or protocol is the amount each tube will dispense to
the well.

When you use multiple tubes to address a well, specify the desired volume with
this multiple in mind. For example, two tubes can address each well in a 24-well
plate, so the "defined" volume must be half the desired volume. As always, be sure
to also consider the Peri-pump’s optimal performance settings when designing the
dispense protocol, i.e. full aliquots are more accurate than fractions of an aliquot.

Another tool to consider using with special plates is the X- or Y-axis Dispense
Position setting. You may be able to use it to aim the dispense tubes to a certain
region of the well.

6-, 12-, 24-, and 48-Well Plates

When addressing these plates with the Peri-pump, BioTek recommends
experimenting with different dispense-tube-to-well configurations. For some plates,
multiple tubes can dispense to a single well. Conversely, dispense tubes can (and
sometimes, must) be removed from the supply vessel or from the cassette to
prevent them from missing the wells.

Testing at BioTek found the following capabilities:

Plate Type Columns/Rows Tubes per Well Tubes removed

6 Well 3 x 2 3 or 4 (4 and 5) or 0
12 Well 4 x 3 2 3 and 6
24 Well 6 x 4 2 0
48 Well 8 x 6 1 3 and 6

l 6-well plates with 2 rows: three or four tubes can fit in the wells. Remove tubes 4 and
5 to use just three tubes per well. Fewer tubes may be preferred to preserve cells in
certain assays.

l 12-well plates with 3 rows: two tubes can fit in the wells, so 6 tubes will be used.
Remove tubes 3 and 6.

l 24-well plates with 4 rows and large enough wells to support two tubes are the easiest
of these special plates. All 8 tubes can be used, 2 per well, for standard microplates.
Exception: the special 24-vial rack, PN 7212058, requires removing the even numbered
tubes from the cassette or fluid supply.

l 48-well plates with 6 rows: requires two tubes, 3 and 6, to be removed.

nRemember, when defining a run: dispense volume is per tube, not per
well. Divide the desired volume by the number of tubes in a well.

BioTek Instruments, Inc.



136 | Chapter 3: Operation

If you regularly use 6- or 48-well plates, which require dispense tubes to be removed
from the fluid supply before dispensing, you should consider dedicating certain cassettes
for the purpose. Removing the unused tubes from the cassette, rather than from the fluid
supply, will preserve them for future use and make the cassette easier to handle. Review
the instructions to Replace Peri-pump Dispense Cassette Tubing on page 210.

Special Plate Carrier for Mini-tubes

An optional accessory for the MultiFlo FX,
a special plate carrier is needed to support
certain special vessels, like a box of mini-
tubes. (PN 7212042)

96 Mini Tubes is the Plate Type name we
give to Corning® 96 Well Cluster Tubes
(PN: 4410, 4411).

Special 24-Vial Rack

To dispense to the mini-tubes the special plate carrier must be installed to
accommodate the extra height. You can also use the carrier for other oversized
vessels that may not otherwise be addressed by the dispensers by increasing the
Plate Clearance setting. The maximum height supported with the combination of
special carrier and Plate Clearance is about 49-50 mm.

To install the special carrier:

1. Remove the standard carrier:
loosen the thumbscrew on the
left side of the carrier to
release the little support arm
and lift the carrier up and off
the transport rails.

2. Orient the special carrier so
the small cavity for the
support arm is on the left,
align the hollows under the
carrier with the transport
rails, and install the carrier.

3. Change the Plate Carrier setting to match the currently installed plate carrier:
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o Change the Plate Carrier Setting (Touch screen) on page 169

o Change the Plate Carrier Setting (LHC)

Mini-Tube Racks

The MultiFlo FX supports a special mini-tubes rack, which is available from BioTek
as an accessory item:
l 96 Mini-Tubes, in standard 12 column x 8 row format

Before dispensing to the mini-tubes, install the Special Plate Carrier for Mini-tubes on
the previous page provided for this vessel. You can use the Peri-pump and 8- and
16-tube Syringe dispensers to fill the mini-tubes.

nNote: Position adjustments in the Y-axis are prohibited with the special plate
carrier for mini-tubes.

Dispensing to Mini-Tubes

Unlike most dispensing with the MultiFlo FX, the fluid stream does not hit the
center of the well or tube when dispensing to the mini-tubes using the special plate
carrier. This image illustrates where the fluid stream is positioned depending on
the type of dispenser used:

Two tubes address each mini-tube when using the 16-tube Syringe manifold. For
the 8-channel devices, one channel per mini-tube is engaged.

nNote: Position adjustments in the Y-axis are prohibited with the special plate
carrier for mini-tubes.
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Dispense Processing Patterns

When dispensing to high-density plates, 384- and 1536-well, 8-channel dispensers,
like the (non-RAD) Peri-pump cassettes and certain Syringe dispensers, employ a
dispensing pattern that permits filling only a portion of the plate, skipping some
sections.

n8-channel dispensers include the Peri-pump, 96/384-well Wash manifold, and
the 8-tube Syringe dispenser manifold.

Columns

To skip an entire column toggle the radio button off. With this feature you can
dispense to odd columns in one dispense step, change fluids or use another
dispenser and dispense to even columns in another dispense step.

Rows

8-channel dispensers offer another way to control the dispense pattern to high-
density plates. See 8-Channel Dispense Patterns.

32-Tube Syringe Dispenser Manifolds

One 32-tube dispense manifold addresses one column at a time. When both 32-tube
manifolds are used simultaneously, they align with every 5th column, in a pattern
like this: 

Columns
1 5 9 13

2 6 10 14
3 7

4 8 and so on...
Syringe A Syringe B

Columns 1 and 5 are dispensed to first, then columns 2 and 6, 3 and 7, and so on.
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8-Channel Dispenser Dispense Pattern

When addressing high density plates, 384- and 1536-well, the 8-channel
cassette/syringe dispenser moves in the pattern described here to fill the plate.
With Advanced Dispense Options, you can skip certain rows and columns.

The MultiFlo FX let's you specify which columns to skip during a dispense step.

384-Well Plate

Rows: You can skip one of the two "rows" sections:

When an 8-channel dispenser addresses a 384-well plate, it first dispenses to odd
numbered rows, and then dispenses to even numbered rows. With this feature you
can dispense to odd rows in one dispense step, change fluids or use another
dispenser and dispense to even rows in another dispense step.

In addition, you can combine a selection of columns with one of the two row
sections (odd or even) to define a complex distribution pattern.

1536-Well Plate

Rows: You can skip up to three "rows" sections:
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When an 8-channel dispenser addresses a 1536-well plate, it first dispenses to rows
1, 5, 9, 13, 17, 21, and 25. The next section of rows dispensed to includes 2, 6, 10, 14,
18, 22, 26, and 30. And so on, creating 4 sections of rows.

Dispense Pattern with Both Syringes

When "Both" Syringe dispensers are selected to fill a plate, the manifolds move in
this pattern:
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Washer Operation

About the MultiFlo FX Wash Step

Minimally, a wash step includes an aspirate step followed by a
dispense step. This is a wash cycle. The default definition of a
wash step includes 3 cycles, followed by a final aspiration to
evacuate the wells. It is important to prime the washer manifold
before running a wash. You may also want to include a Pre-
dispense or tip prime to correct for evaporation and other minor
fluid loss to normalize the tips.
Overfill washing, which has proven effective for ELISA assays, is
a popular feature: fluid is aspirated simultaneously to dispensing
to prevent spillage by positioning the aspirate tubes at the tops of
the wells.

About the hardware:

The wash manifolds are identified by the plate types they
support, e.g. 96/384-well manifolds aspirate and dispense
fluid to and from 96-well and 384-well plates. Likewise,
the other manifold options are dedicated to a plate type:
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6-well, 24-well, and so on. Manifold configurations vary
to accommodate the geography of the plate; at times
using multiple tubes in a well to accomplish the task.

Cell Wash

See how to Define a Cell Wash Protocol below. 

The MultiFlo FX supports cell-based assays that require the addition and removal
of buffer solution without disrupting the cells in the wells of the microplate. Cells
are often dislodged when fluid is dispensed at too high a pressure and lost during
subsequent aspiration of the fluid from the well unless counter measures are taken.

When the Flow Rate is set to 1 or 2, the MultiFlo FX dispenses fluid to the wells
slowly enough to avoid damaging the cells.

Additional Techniques

Delay Aspiration: Also critical to cell-based assays is delaying aspiration to allow
the slower dispense process to finish before beginning fluid removal from the well.
This option, offered as part of the dispense step, is called Delay Start of Vacuum.

Adjust the Aspirate Travel Rate and Aspirate Height: when defining the aspirate
step select one of the specially designed travel rates that minimize turbulence in
the wells. Increase the aspirate height to leave more residual fluid in the wells to
protect the cell layer. Also, consider using a secondary aspiration.

Adjust the Dispense Flow Rate, Height and Position: when defining the dispense
step be sure to select one of the special Flow Rates, 1 or 2 CW. Also reposition the
dispense tubes to aim the fluid at the side of the wells to further minimize
turbulence. See Cell Wash Strategies on the facing page.

Slow down the Plate Carrier: select Instrument>General and set the Plate Carrier
Speed to Slow.

Define a Cell Wash Protocol

Adjust the volumes recommended in this procedure to meet your specific needs.

1. Create a new protocol.

2. Add a Prime step, especially when the lines are empty or when
changing fluids.
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3. Add a Wash step and define it as you normally would, except
with these special parameters:

o Set the Aspiration Travel Rate to 6 CW and the Delay to 0.
o Set the Dispense Flow Rate to 1 or 2.

l Select the Dispense Advanced Options link and enable the Delay start of Vacuum
until sufficient fluid has been dispensed. For small dispense volumes, BioTek
recommends setting the delay volume to equal your dispense volume.

l Reposition the dispense tubes to aim fluid at the side of the wells to reduce turbulence
and change the aspirate height to increase the amount of residual fluid left in the well to
protect the cell layer. See Cell Wash Strategies below.

Be sure to check the parameters for Final Aspiration.

Cell Wash Strategies

To give you a starting point for optimizing your own assays, here are some
recommendations for improving your cell wash assays:

Repositioning the dispense and aspirate tubes helps minimize turbulence in the
wells, preserving more cells.

For loosely adherent cells, the best performance was seen by increasing the aspirate
height and using both a standard and secondary (or crosswise) aspiration. Moving the
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aspirate tubes from one side of the well to the other prevents a fluid stream from forming
and dislodging the cells. Increased residual in the well means increased cell retention.

Best practice:

l Use the Adjust Utility to determine the optimal X, Y, and Z axis adjustments needed to
best position the manifold above the wells during the wash routine.

l Test the protocol settings by running the protocol using only water and an empty plate
before actually running your assay to make sure the fluid stream hits the wells as
desired.

Delay Aspiration or Vacuum-On Volume Control

Touch Screen: Edit the Wash or Dispense Step>Advanced Options

During regular plate washing, aspiration and dispensing occurs simultaneously.
This allows "overflow" dispensing, because the fluid is aspirated before
overflowing the plate.

Use this control to begin aspiration only after the specified volume is dispensed.
For cell wash assays, specify at least 10 µL/well. For small dispense volumes or to
disable aspiration for the entire dispense duration, set the vacuum-on volume to
equal your dispense volume. Refer also to application notes on the BioTek web site
for more information (www.biotek.com).

Note: When the volume is set to 1120 µL/well or more, aspiration is disabled during the
dispense step.
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Biomagnetic Separation - Magnetic Bead Assays

The microplate carrier, when the magnet adapter is used, supports placement of a
magnet under the microplate. The magnet induces magnetic beads to settle at the
bottom of the wells to help retain them during a wash protocol’s aspirate cycle.

The MultiFlo FX supports standard microplates and these magnets available for
purchase from BioTek:

Plate Type Magnet PN

96-well 96 Flat Magnet 7103016

96 Ring Magnet 7102216

384-well 384 Flat Magnet 7103017

384 Ring Magnet 7102215

You can use a different magnet if it fits in the carrier and accommodates your
plates. Contact BioTek TAC or visit the Customer Resource Center at
www.biotek.com to obtain a drawing of the carrier with its dimensions.

Persons with pacemakers/implants should avoid direct contact. Keep all
magnetic media, watches, and sensitive electronic devices away from the magnets.
Credit cards, tapes, and disks can be erased in the presence of a magnetic field. Bodily
harm [pinching of hands and skin] can result if magnets are not handled correctly.
Maintain distance between two or more magnets.

Take advantage of the sample magnetic-bead protocols shipped onboard the MultiFlo
FX. Copy W-Luminex_Mag_Flat_96, for example, and modify the parameters to suit your
assay requirements.

Handling and Cleaning the Magnets

For best magnet strength and bead retention, the bottom of the microplate must be
as close to the magnet as possible. We recommend using flat-bottom plates with
minimal support “webbing” between the sides of the outer wells and the plate
skirts.

Handle the magnets with care. Avoid direct contact with the magnet material. Keep
loose ferrous material away and do not attempt to disassemble.
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The magnet should be stored in a cool, dry environment and should be cleaned
with a damp cloth and mild detergent when exposed to harsh solvents. Do not
autoclave.

To install the magnet in the proper orientation:
l Flat magnet: place in the plate carrier adapter so the text on the side of the magnet is
readable;

l Ring magnet: place in the plate carrier adapter with the small round magnets visible,
facing upwards.

Realign the BioStack with the Magnet Installed

Using the magnet increases the effective height of the carrier surface (generally by
at least 7 mm). This shift in the plate position requires a comparable adjustment to
the BioStack’s gripper movement. Realign the BioStack before using it with the
magnetic bead assays.

Refer to the BioStack Operator’s Manual for detailed instructions of the alignment
procedure. To help get you started:

1. Place the magnet in the carrier and a microplate on top of it.

2. Launch the BioStack Alignment Utility:

LHC Touch screen

Tools> BioStack Utilities> Alignment Utility Instrument>Next> BioStack

3. HOME the BioStack and Begin Realignment.

4. Lower the claw until a 0.050” (1.3 mm) gap between the bottom of the plate and
the top of the gripper fingers is achieved and save the gripper position.

5. Put the microplate in the input stack and Verify the alignment.

Remember to realign the BioStack for non-bead assays, when applicable.

Perform Magnetic Bead Assays

For the best results when performing biomagnetic separation assays:
l Realign the BioStack with the Magnet Installed

l Change the Magnet Height Offset on page 150

l Optimize Magnetic Bead Protocols on the facing page
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Optimize Magnetic Bead Protocols

Here are some suggestions to consider for optimizing your magnetic bead assays:
l Plate Type: Flat-bottom plates are recommended for magnetic bead assays because
more of their well surface sits closer to the magnet, resulting in increased magnet
strength, than with other plate formats. If you must use round-bottom plates, increase
the between-cycle soak time to improve bead separation during processing.

l Magnet Adapter Height Offset: Deploy this offset to increase the Z-axis or height
setting in all processing options to accommodate the increased height of the magnet.
See Determine Magnet Height Offset. Use of this feature may eliminate the need to
"Adjust the Aspirate height" described below.

l Shake/Soak Step: Begin the protocol with a delay to let the magnetic beads settle.
Also, specify a mid-cycle soak to let the beads settle after fluid is dispensed to the plate,
e.g. include a 60 second soak before and between cycles.

l 6CW Aspirate Travel Rate: select 6CW for the aspirate travel rate. The CW travel
rates are designed to minimize disruption to cell layers on the bottom of the well. The
same principle applies to magnetic bead assays.

l Adjust the Aspirate height: increase the aspirate height setting (Z-axis) which will
increase the residual fluid in the wells but also preserve the beads. Good results were
obtained when keeping the aspirate height around 15.0 mm above the plate carrier for
all but a last Final Aspirate (disabled between cycles).

l Adjust the Aspirate position: When using Flat Magnets below, position the aspirate
tubes near the sides of the wells (X-axis), if possible, to improve bead retention.

l As always, before running assays, we recommend testing new protocols using deionized
or distilled water and a little Tween® 20 with the desired microplate and a magnet
installed.

Flat Magnets

Use this information about the flat magnets to fine-tune wash protocol settings:

96F Magnet 7103016

384F Magnet 7103017

The 96- and 384-well magnets are structured differently. Their force fields traverse
the magnet in opposite directions. Magnetic beads in the wells will be drawn to the
center. For the best bead retention, reposition the aspirate tubes in the proper axis:
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96-well Flat Magnet PN 7103016

The magnetic force (approx. 6800 Gauss)
is distributed in a horizontal pattern,
row-wise, across the plate. Magnetic
beads are pulled to the center, across the
well in flat-bottom plates and to the
button in round-bottom plates. Increasing
the aspirate height to increase the
amount of residual in the well may
improve performance.
Aspirate Settings:

Adjust the Y Position to align the
aspirate tubes near the well walls, if
available. Increase the Aspirate Height (Z
axis), leaving more residual volume in
the wells.

384-well Flat Magnet PN 7103017

The magnetic force (approx. 4300 Gauss)
is distributed in a vertical pattern,
column-wise, across the plate.

Adjust the X Position to align the
aspirate tubes away from the center of
the well, near the well walls.

Ring Magnets

Use this information about the VP magnets to fine-tune wash protocol settings:

96 Ring Magnet 7102216

384 Ring Magnet 7102215
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96 Ring Magnet
PN: 7102216

This magnetic bead separator uses
329 of VP’s 52 MGO magnets (7094
Gauss). The magnets are arranged
around each well, pulling the
magnetic beads to the bottoms and
edges of the wells. Aspirate from
the center of the well (the default
position), when using this magnet.

384 Ring Magnet
PN: 7102215

This magnetic bead separator uses
425 of VP’s 52 MGO magnets (6994
Gauss). The magnets are aligned
with the intersections of the wells,
pulling the magnetic beads to the
bottoms and edges of the wells.
Every well is circled by 4 magnets.

Aspirate from the center of the well
(the default position), when using this
magnet.

How to determine the Magnet Adapter Height Offset

Use calipers for the best results or another measuring device.

1. Put a magnet in the adapter, and the
type of plate you will be using in
place on top of it.

2. Measure the distance from the
bottom of the adapter to the top of
the plate in millimeters (mm).

3. Remove the plate, and measure it
alone.

4. Subtract the stand-alone plate
measurement from the measurement
value of the combined elements.
This is the value to use.

Examples

In our testing we found these offset values to be effective:
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Plate Type With PN Offset Value
(mm)

96 Corning Magnet Adapter 7180011 (kit) 8.73

Dexter 96 Magnet 7103016 10.20

VP 96 Ring Magnet 7102216 10.48

VP 96 Magnet 7102217 10.18

384 Corning Magnet Adapter 7180011 (kit) 8.73

Dexter 384 Magnet 7103017 11.20

VP 384 Ring Magnet 7102215 11.50

Magnet Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Dispense and Quick Wash
(without adjustments) when the magnet is used. It applies the specified height
value as an offset to all relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the
MultiFlo FX, i.e. the vessel's geometry permits the manifold tips to successfully address its
wells, this setting can be used to simplify protocol development.

For the best results, measure the height of the plate you are using with the magnet.
BioTek has determined that Nunc flat bottom plates are about 3 mm taller than a similar
Corning plate, for example.

The "In use" checkbox/option lets you specify and
retain a height setting. Set the value once and then use the control to switch it on
and off: fill the checkbox when using a magnet, empty the checkbox to disable the
offset.
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LHC Touch screen

1. Tools> Instrument Utilities> General

2. Fill the In use checkbox and set the
Magnet Adapter height to the correct
offset.

3. Click the Send link.

1. Instrument >General
2. Fill the Magnet in use checkbox

and enter the Height offset value.

Remove the checkmark to turn off
the offset.

Special Procedure for Magnetic Bead Assays

Before using the Syringe Dispenser or Strip Washer to dispense magnetic beads,
you must remove the magnets that normally hold the dispense manifolds on the
instrument. Two thumbscrews are shipped with the manifolds to replace the
magnets.

1. Use the 1/16th hex wrench (PN 48713) to
loosen the set screw on top of the
manifold.

2. Take advantage of the magnet’s attraction
to the hex wrench to remove it from the
manifold.

3. Locate the thumbscrews shipped with the
instrument’s accessories. After sliding both
manifolds onto the dispense arm, put the
screws into the post to hold the manifolds
in place.
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Peri-pump Peristaltic Dispenser

nSome models do not include a Peri-pump dispenser.

Quick Dispense-Prime-Purge

In addition to controlling the Peri-pump with defined protocol steps, the MultiFlo
FX offers a Quick menu to Dispense, Prime and Purge fluid. (0.5 µL dispensing is
not available and RAD 8-to-1 bulk dispensing is not recommended when using the
Quick menu; you must create a protocol for these features.)

Dispense Cassettes

nImportant: It is imperative that the cassette type setting onboard the
instrument match the installed cassette!

l Install the Dispense Cassette on page 56

l Change the cassette type setting on page 76

l Dispense Cassette Diagram on page 54

l Release the tension on the dispense cassette on page 154
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Peri-pump: How it works

The Peri-pump component dispenses fluid using a peristaltic pump. It works by
expelling a portion of fluid trapped between advancing rollers. The tubing is
pinched by the rollers to form a full aliquot or slug.

Peri-pump drum

The volume of fluid in a single slug depends on the tubing size and linear distance
between rollers. As the rollers spin, the fluid advances and is expelled at the tip in
finite aliquots or slugs. The volume of each slug is the amount of fluid squeezed
between two adjacent rollers.

The stepper motor turns the pump a determined number of steps. The pump drum
can be advanced in smaller increments than the distance between rollers to expel a
fraction of the full aliquot. However, the volume of the fractions is variable,
depending as it does on many factors (exact rotor position, tubing tension, tip
geometry, etc.). The variation between volumes of fractional aliquots is significantly
higher than between dispenses done with full aliquots. Thus, the best possible
performance and reproducibility from dispense to dispense is done in full
aliquot increments. That is, specifying a 1 µL dispense volume when using the 1
µL cassette, 5 µL dispense volume when using the 5 µL cassette, and 10 µL
dispense volume when using the 10 µL cassette. The exception is for instruments
that support 0.5 µL dispensing. These late-model instruments apply an offset to the
stepper motor to ensure precise and repeatable dispenses using a 1 µL cassette to
dispense 0.5 µL aliquots, which is the only half increment permitted. Only a 0.5 µL
dispense volume can be requested, not 1.5 or 2.5 µL, for example.

The tubing cassettes are calibrated by stretching the tubing to the size required to
accurately dispense the expected volume per aliquot. BioTek calibrates cassettes to
meet the specifications before shipping them. Over time the tubing’s properties
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will alter slightly, but the cassettes can be recalibrated to restore expected
performance, in most cases.
l See Performance Specifications on page 21.

l See Recalibrate the Peri-pump Dispense Cassette on page 211.

Release the tension on the dispense cassette

Important information about dispense cassettes!

When not in use, BioTek recommends releasing the tension on the cassette. This
practice extends its life, preserving the tubing’s integrity.

To release the tension:

1. Open the Pump Cover.

2. Pull out the Cassette Rest.

3. Release the spring-loaded latch that holds in place the Tube Tensioner
attached to the pump’s stainless steel plate. It will rest against the cassette
rest.
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Peri-pump Dispense Step

Add a Peri-pump dispense step to the protocol:

LHC Touch screen

Click P-Dispense and define the parameters Select Add>P-Dispense and
define the parameters

If applicable, select which Peri-pump to use, Primary or Secondary.

If applicable, enable the RAD technology dispenser.
Define the Dispense Step

Dispense Volume: Enter the per well volume in microliters, up to 30,000/well. The
recommended values for each cassette type are:

o 1 µL cassette = 1 - 50 µL or 0.5 µL

o 5 µL cassette = 5 - 2500 µL

o 10 µL cassette = 10 - 3000 µL

Note: When using the RAD 8-to-1 bulk-dispensing cassette lower the dispense height to
ensure fluid hits the wells, i.e. select Advance Options and change the Z-axis.

Select the Flow Rate

Cassette Type 1 μL 5 μL 10 μL

(μL/sec/tube)

Low 50 120 140

Medium 60 140 160

High 64 160 180

RAD technology: Single-channel cassette flow rates match the standard cassettes and the
8-to-1 cassette matches the 10 µL flow rates.
When dispensing 0.5 µL with the 1 µL cassette the average flow rate values are:

1 μL Cassette 0.5 μL Dispense

(μL/sec/tube)

Low 52

Medium 54

High 56
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Cassette Type Requirement

LHC/Touch screen

Optionally, Require (a) specific cassette type to run this protocol.
l Fill the checkbox to ensure users install the correct cassette type when running this
protocol.

l Leave the checkbox empty to allow any cassette type to be used.

l For RAD technology cassettes choose both tubing and cassette type.

Note: Half-microliter (0.5 µL) dispensing requires a 1 µL cassette. The Cassette
Requirement Mode behavior is implemented whenever a 0.5 µL volume is requested.
Make sure a 1 µL cassette is installed and the Cassette Type setting matches it.
Only a 0.5 µL dispense volume can be requested, not 1.5 or 2.5 µL, for example. Perform
two dispense steps, one for the half microliter and another at a full increment to achieve
these volumes.

Pre-Dispense

When enabled, the Peri-pump primes into the priming trough immediately
before dispensing to the plate. Pre-dispense is recommended for most
applications. It normalizes the tips, to correct for evaporation, for example, to
ensure precise fluid distribution.

See Protocol Parameters Tables on page 103 for details about the remaining
parameters.

RAD Tip Tracking

When using the 8-to-1 bulk-dispensing cassette, you can further minimize the
chance of disturbing cells in the bottom of a well using "tip tracking." When
enabled, the chute or tip gradually rises as fluid is dispensed into the well.

Dispensing begins at the specified dispense height (Z-axis) and
moves up to a maximum height that is equal to the Plate Clearance
height.
Prerequisites:
l Tip Tracking must be enabled in Instrument Settings

l You must define a dispense protocol, i.e. do not use Quick
Dispense.

l The protocol's initial dispense height or Z-axis position must be
lower than the default height.

Shortcut: Make a copy of the sample protocol: P2 RAD
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8TUBE-24, and modify it for your assay. As always, experiment
with parameters to determine the optimal settings.

How to use Tip Tracking:

1. Set the Cassette Type to 5 µL: 8 tubes RAD and enable Tip Tracking.

2. Define a protocol using:

l the external Peri-pump

l a 6-, 12-, or 24-well plate

l a Z-axis height 2-4 mm above the cells/well contents

l an X-axis value that positions the tip chute as close as possible to the well
wall

nUse the Align utility to determine the X- and Z-axis.

3. Install the bulk-dispensing cassette, and the plate and you're ready to run.

Important: Remove the priming trough inserts when using the 8-to-1 RAD cassette.
The chute will collide with both the RAD priming cup and the Syringe dispenser insert if they
are left in the priming trough.

RAD Well Map

RAD technology's single-channel dispenser is ideal for partially filling a plate. It
lets you pick the individual wells to dispense to (hit-picking). Green wells are
dispensed to, white wells are skipped.

Quick Dispense Protocol Dispense Step

PressWell Map Create/Edit the Protocol>P-Dispense, enable RAD and select
Advanced options, thenWell Map

l Select a well to toggle its state: fill or skip.

l Select a column or row header to fill or skip the whole row or column.

l In the top corner of the map, use the All options to change the fill or skip state of the
wells.

The multiple-well selection options use the state of the first well in the row, column, or
plate (A1) to determine whether to fill or skip the remaining wells.
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Require a Specific Peri-pump Cassette

When defining a Peri-pump step you can require a specific cassette type. Choose
the desired behavior when the required cassette is not installed at runtime:

l Prompt the user to confirm: provides the best protection against an unintentional
mismatch. If the cassette type itself has been physically changed to match the protocol,
but the instrument's setting has not been updated, this option changes the MultiFlo FX's
setting upon confirmation. However, if the cassette has not been changed to match the
protocol, users are given a chance to cancel the run, fix the error, and rerun the
protocol.

l Return an Error code: gives robotics programmers the ability to design and run
unattended processing routines without fear of a message screen interrupting the
operation.

l Automatically Set the cassette type: this option changes the MultiFlo FX's setting
without a confirmation. This option is for advanced users only.

nNo action is taken when the cassette type setting matches the protocol's
required cassette type.

nRAD technology cassettes add a layer of complexity to this feature. Error code
6029 is displayed when a mismatch of required or installed cassette types
occurs. Be as precise as possible when using this feature for best results.

Note: The Cassette Requirement Mode is automatically enforced when a 0.5 µL
dispense is requested. In this case, make sure a 1 µL cassette is installed.

LHC Touch screen

1. Select Tools>Instrument Utilities>Peri-
pump Dispenser.

2. Select the desired Cassette Requirement
Mode behavior:

o PROMPT

o ERROR

o SET

1. From the home screen,
select Instrument>Peri-
pump.

2. Select the Cassette
Requirement Modeoption:

o PROMPT

o ERROR

o SET
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Peri-pump Advanced Settings

Settings for 0.5 µL Dispense

Do not alter these settings without explicit instructions from BioTek.

Peri-pump offsets are required to ensure precise and repeatable dispense
performance when dispensing 0.5 µL. The default values were determined after
thorough testing and should not be changed. This control is provided in
anticipation of potential future changes to the 1 µL cassette tubing. In that case,
explicit instructions to alter the offsets will be provided.

Contact BioTek TAC for assistance if you have questions about dispense performance
at 0.5 µL.

8-to-1 Tube RAD Cassette

Chute height represents the distance between the bottom of the 8 tube tips to the
bottom of the chute tip. The default value reflects the chute provided with the
bulk-dispensing cassette. Only change this value if you remove or replace the
chute.

Set the Chute Height this way:
l If you remove the chute and run the cassette without one,
enter 0.

l If you replace the chute, measure from the bottom of the 8
tube tips to the bottom of the replacement chute, and
enter that value in millimeters (mm).

Contact BioTek TAC for assistance.
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Dual Syringe Dispenser

nSome models do not include a Syringe dispenser.

Quick Dispense

In addition to controlling the Syringe dispenser with defined protocol steps, the
MultiFlo FX offers a Quick menu to Prime the tubing and Dispense fluid.

How it works

The Syringe dispenser uses two positive-displacement syringe-type pumps and
distinct fluid paths to accurately deliver buffer, reagents, and other fluids.

See Syringe Dispenser- Autoclavable vs. Non-autoclavable on page 167 to learn
the difference between these two options.

Prime the Tubing
l How to Prime the Syringe dispenser below

l Recommended prime volumes for the Syringe dispensers on page 101

l See also: Syringe Dispenser and Strip Washer Maintenance on page 201

How to Prime the Syringe dispenser

Priming the tubing to remove all air bubbles is critical for accurate dispensing.
There are several ways to make sure the tubing is primed:
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Quick Prime

1. Select QUICK at the home screen.

2. Press Device to select Syringe -A or -B or -BOTH.

3. Press PRIME as many times as necessary. 5000 µL is dispensed each time.

Add a Prime step to the Protocol

See Syringe Prime Step below

Similarly, always include a Pre-dispense (or tip prime) in a Dispense/Wash
step.

Keep the tubing wet during idle time

Turn on AutoPrime for the Syringe Dispenser on page 182.

Syringe Prime Step

Select S-Prime and define the parameters to prime the Syringe pump.

Adequate priming is essential for achieving expected performance. It is a good
practice to perform this step immediately before a dispense step in the protocol.

The predefined maintenance protocols for the syringe dispensers, e.g. S-DAY_
RINSE, fully prime the system, pumping 40 mL through the tubing and pump.

The approximate dead volume for each Syringe dispenser system is 12 mL. Generally,
three times the dead volume completely primes the system. When using precious fluids,
e.g., expensive reagents, you can change the prime parameters: reduce the volume or
number of cycles specified in the predefined protocols or create your own protocols. Use
the priming trough inserts to capture expensive reagents when priming.

Define a Prime Step:

1. Select the Syringe to dispense with:
o A or B dispenser.

1. Enter the total Volume in microliters to flush through the tubing.

2. Define the Flow Rate: The rate at which the fluid is dispensed. Options range
from 1-5, 1 is the slowest, 5 is the fastest. Lower rates are recommended for
viscous fluids.

3. Enter the Number of prime cycles.
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To improve performance and possibly preserve reagent, increase the number of cycles
and reduce the volume of each cycle. Several small primes often do a better job pushing air
from the manifold than one or two large primes.

4. You can Submerge the dispense tubes in the fluid after the prime, if desired.
This requires filling the priming trough inserts, one for each syringe. Each
reservoir holds approximately 6.5 mL.

After the dispense tubes have been primed, the manifold moves down
into the priming trough inserts. When both Syringes are enabled, the
soak duration begins after both dispensers are primed.

nImportant: When using the submerge option, specify a volume that fills
the priming trough inserts with sufficient fluid to cover the tubes, e.g.
6000 µL. And, be sure to use the priming trough inserts when the option
is enabled. Learn more about soaking the dispense tubes...

Set the Submerge Duration and fill the Submerge checkbox to enable this
option.

nRemove the Peri-pump cassette or its priming trough insert when
soaking the Syringe dispenser or washer manifolds.

5. Optionally, adjust the Pump Delay when dispensing highly viscous fluids, if
necessary to improve performance.
When dispensing highly viscous fluids, the tubing's check valves perform more slowly.
Delaying the syringe pump sufficiently to allow the specified amount of fluid to pass
through the check valves before being pumped into the syringe has been shown to
improve dispense accuracy.
Begin by setting the delay to 500 msec. Experiment with different settings to determine
the optimal value for your fluid.
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Syringe Dispense Step

Add a Syringe pump dispense step to the protocol:

LHC/Touch Screen

Click S-Dispense and define the parameters

Define the Dispense Step

1. Select the Syringe to dispense with:
o A or B or Both dispensers.
o Note: "Both" is not an option when low-density-plate-type manifolds are installed.

nBoth: When both Syringe dispensers are used, they simultaneously dispense
the specified volume/well in a pattern that varies depending on the plate type.
Remember to create two prime steps, one for each dispenser, to precede the
dispense step. See Dispense Pattern with Both Syringes on page 140.

n1536-well Flange Plates: Use "Both" Syringe dispensers when processing
1536F plates.

2. Enter the Volume to dispense per well. The valid values are 5-30,000 µL
depending on the plate type.

3. Define the Flow Rate: The rate at which the fluid is dispensed. Options range
from 1-5, 1 is the slowest, 5 is the fastest. The valid rate is volume dependent.
Lower rates are recommended for viscous fluids.

Rates are volume and plate-type dependent:

For example, rate 1 must be used when dispensing between 10-19 µL to a 96-well
plate. When dispensing 20-49 µL to a 96-well plate, you can use rates 1 or 2. And,
when dispensing 50-59 µL to a 96-well plate, you can use rates 1, 2, or 3. And so
on, as shown in these tables.

96-well plate 16-Tube 8-Tube

Volume
(µL)

Rate µL/sec/well

10-19 1 450 140
20-49 1-2 600 209
50-59 1-3 750 279
60-79 1-4 900 350
80-3000 1-5 1000 420
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384-well plate

Volume
(µL)

Rate µL/sec/well

5 -9 1 225
10-24 1-2 300
25-29 1-3 375
30-39 1-4 450
40-1500 1-5 500

nNote: For 16-channel syringes the µL/sec/well rate accounts for 2 tubes/well
when addressing 96-well plates and one tube/well for 384-well plates.

1536-well plate

Volume (µL) 3-3000
The 32-tube manifold flow rates do
not have minimum volumes.
The µL/sec/well for each type of
manifold, Small Bore (SB) and Large
Bore (LB), is shown:

Rate SB LB

1 56 125
2 58 150
3 60 162
4 62 174
5 64 187

The default rate is 3.

Low-density-plate manifolds

Like the standard manifolds described above, for these plate-type-specific
manifolds the flow rate is defined as µL/sec/well and the minimum volumes are
cumulative, i.e. any rate can be used to dispense Rate 5's minimum.

Manifold Flow/Minimum
Volume Rate 1 Rate 2 Rate 3 Rate 4 Rate 5

6-Well Flow 560 836 1116 1400 1680

Min Vol 40 80 200 240 320

12-Well Flow 420 627 837 1050 1260

Min Vol 30 60 140 160 220

24-Well Flow 280 418 558 700 840

Min Vol 20 40 100 120 160

48-Well Flow 279 372 560 600 800

Min Vol 40 80 200 240 320
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Enable Pre-dispense to normalize the tips before dispensing. Enter the volume and
number of cycles.

Select the Columns to dispense to (aka the Plate Map):

Each button represents a column.

Use the buttons and Set and Clear links: The buttons, which represent each
column, toggle on and off when selected. Toggle them on to dispense to the
column or off to skip the column.
l Each button represents a column.

l The number of active column buttons reflects the specified Plate Type, which should
match the plate you are dispensing to.

l Learn about Processing Patterns for 384- and 1536-well plates.

Pump Delay

When dispensing highly viscous fluids, the tubing's check valves perform more slowly.
Delaying the syringe pump sufficiently to allow the specified amount of fluid to pass through
the check valves before being pumped into the syringe has been shown to improve dispense
accuracy.
Begin by setting the delay to 500 msec. Experiment with different settings to determine the
optimal value for your fluid.

Change the Syringe Dispenser Manifold

Changing the Syringe manifold requires two steps:
l Physically changing the Syringe dispenser manifold: See Install the Syringe
Dispenser Component on page 62.

l Updating the instrument's manifold setting; as described below.

After physically changing the manifold, perform these steps to tell the instrument
which manifold is installed.

1. LHC: Select Tools> Instrument Utilities> Syringe Dispenser
Touch screen: Select Instrument> Syringe> Manifold
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2. Choose the option that represents the installed manifold. Look at the top of the
manifold to identify its type, which is engraved on the top:

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel.

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB).

8-tube 6-well plates only; 4 tubes per well.

9-tube 12-well plates only; 3 tubes per well.

8-tube 24-well plates only; 2 tubes per well.

12-tube 48-well plates only; 2 tubes per well.

3. LHC: Click Send to send this setting to the instrument.

Syringe Dispenser Settings

Syringe Dispenser Assembly

After installing the Syringe dispenser unit, update the instrument's settings. The
MultiFlo FX automatically detects which type of pump is installed. Select the
manifold installed.
l Non-Autoclavable: the black plastic casing of the non-autoclavable syringes are easy
to distinguish from the glass and stainless steel autoclavable syringes.

l Autoclavable: glass and stainless steel autoclavable syringes.

8-tube Dual 8-tube manifolds in a single block.

16-tube 16-channel.

32-tube 1536-well plates only;
Model: Large Bore (LB) or Small Bore (SB).

8-tube 6-well plates only; 4 tubes per well.
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9-tube 12-well plates only; 3 tubes per well.

8-tube 24-well plates only; 2 tubes per well.

12-tube 48-well plates only; 2 tubes per well.

Look at the top of the manifold to identify its type, which is engraved on the top.

Calibration Data

Calibration data is critical to achieving expected performance and it is unique to
each individual syringe unit. BioTek prints the values on the bottom of the unit, so
you have a permanent record of the values.

When installing the Syringe dispenser, enter the values printed on the unit.

Syringe Dispenser- Autoclavable vs. Non-autoclavable

Two types of Syringe dispensers are available, autoclavable and non-autoclavable.
It is easy to distinguish them:
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Autoclavable Non-autoclavable

Stainless steel and glass pump heads Black plastic pump heads

Glass supply bottles Plastic supply bottles

Amber, transparent check valves White, opaque check valves

Changing the Instrument's Settings

About the Onboard Settings

The instrument's onboard settings dictate its behavior. Certain settings, like Plate
Clearance, can improve performance. Other settings are critical to its performance.
For example, the manifold setting must match the installed manifold type.

LHC users: do not confuse the LHC's Target Instrument Settings assigned to each
protocol with the onboard settings! Review the Help topic: LHC Protocols Explained to learn
the distinctions.

To change the onboard settings:

LHC Touch screen

1. Select Tools>Instrument
Utilities

2. Choose the applicable tab and
modify settings as desired.

3. Click Send after changing a
setting to update the
instrument.

1. Press
Instrument>Options
for washer settings.

2. Explore the other
tabs for more
settings.

nWhen using the LHC to change instrument settings, you may need to reboot the
MultiFlo FX before controlling it with the touch screen.

Dispense Pattern

Touch screen: Select Instrument>General

Select the fill pattern: by column or row for processing 384- and 1536-well plates.

For high-density plates, the 8-tip manifold must address the plate multiple times to
fill it. Column-wise dispensing fills each column before moving to the next. Row-
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wise dispensing fills the first 8 rows, then reverses direction to fill the next 8 rows,
and so on. Once it is defined, your pattern preference will apply to all runs, Quick
Dispenses and protocols.

Choose row for faster throughput or column for more precision.

The dispense pattern applies to RAD technology cassettes, as well, but neither
option offers an advantage.

Change the Plate Carrier Setting (Touch screen)

The instrument's onboard settings must match the installed hardware.

When you physically change the plate carrier to perform special assays, you must
also change the instrument carrier setting to direct the devices to higher or lower
positions to accurately address the wells:

1. Select Instrument>General.

2. Press the Plate Carrier selection drop-down list to select the currently installed
carrier:

o STD - Standard carrier

o MTUBE - Mini-tube carrier.

Change the Plate Clearance Setting (Touch screen)

The Plate Clearance setting adds the specified value to the travel height for the
selected plate type, i.e. it adds this number to the "Plate Height" value cited in the
Plate Types Table. The manifold rises to this height to move from one column to
the next and whenever repositioning is needed. This setting does not affect
dispense and aspirate heights.

Use this setting to accommodate plates that are slightly taller than standard plates
to make sure the manifolds rise high enough above the plate to prevent crashes
when the plate carrier moves.

Note: Enabling the Magnet Adapter Height affects the travel height, as well as
dispense and aspirate heights. The Magnet Adapter Height increases the respective
values of all height parameters. Generally, it is best to keep the default setting for
Plate Clearance when using the Magnet Adapter Height setting.

To change the setting:
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1. Press Instrument>General.

2. Touch the number field to enter an offset value in millimeters (mm).

Plate Carrier Speed

For sensitive cell-based assays, especially when using low-density plates with large
wells, this setting may improve performance by preventing fluid from sloshing
around, potentially disturbing the cell mono-layer or spilling fluid during
processing. Setting the speed to Slowwill apply during both Quick routines and
when running protocols.

Upload-Download Protocols (LHC Only)

The LHC lets you transfer protocols from your computer to your instrument and
back again.

1. Select Tools>Transfer Protocols.

2. Make sure the desired protocols are displayed: check the Protocol Folder path
for This computer. Refresh the list of protocols onboard the Instrument by
clicking the Settings link.

3. Highlight one or more protocols in a display box. (Hold the Ctrl or Shift key to
simultaneously select multiple files.)

4. Optionally, at the top left corner of the screen, choose to Disable Editing of
transferred protocols to lock the protocols from editing or deleting when they
are onboard the instrument.

5. Click the applicable Upload or Download button.

The LHC will confirm the transfer or prompt you for more information. When the
transfer is complete, you can manipulate the files as you normally would in their
new location.

Transfer Protocols (Touch Screen Only)

You can install protocols on the MultiFlo FX from a USB flash drive and,
conversely, upload protocols from the MultiFlo FX to a USB stick. This is useful for
sharing protocols with colleagues and obtaining protocols created or modified with
BioTek's LHC software.
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Prerequisite:

Important: A folder named "Protocols" must be present on the USB flash
drive to transfer protocols. Likewise, a folder named "Lid Definitions" is required
to transfer these files. Put the protocols you want to download to the instrument in
a Protocols folder. Conversely, you can create an empty folder named "Protocols"
on the USB stick to upload protocols from the instrument to the USB stick. Do the
same to manage Lid Definition files.

To transfer protocols:

1. Insert the memory stick into the USB port on top of the washer.

2. Choose the File Source: Internal to copy protocols to the flash drive, or USB to
copy protocols from it to the MultiFlo FX.

3. Optionally, apply the Lock files option to prevent users from changing the
protocols.

4. Select files individually by highlighting them (touch) or transfer all protocols
simultaneously.

Protocols transferred to the MultiFlo FX can be run from the Home screen and, if
not locked, modified from the Protocol Definition screen.

Locked files: you can "unlock" a protocol by replacing it using the Protocol Transfer
control. Upload the protocol to a USB stick, make sure "Lock files" is disabled and re-
transfer the protocol. It will overwrite the existing file.

Transfer Plate Lid Definitions

For use with BioStack4 plate de-lidder feature: You can install lid definition files
on the MultiFlo FX from a USB flash drive and, conversely, upload them to a USB
flash drive. This is useful for sharing files with colleagues and obtaining files from
BioTek.

Prerequisite:

Important: A folder named "Lid Definitions" must be present on the USB
flash drive. Put the files you want to download to the instrument in this folder.
Conversely, you can create an empty folder named "Lid Definitions" on the USB
stick to upload protocols from the instrument to the USB stick.
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To transfer Lid Definition files:

1. Insert the memory stick into the USB port on top of the washer.

2. Choose the File Source: Internal to copy files to the flash drive, or USB to copy
files from it to the MultiFlo FX.

3. Optionally, apply the Lock files option to prevent users from changing the
protocols.

4. Select files individually by highlighting them (touch) or transfer all files
simultaneously.

Files transferred to the MultiFlo FX can be attached to a protocol and, if not locked,
modified from the Plate Lid Definition screen.
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Maintenance

Properly maintaining the MultiFlo FX is the key to reliable
performance.
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Storing the Instrument 210
Replace Components 210
Calibrate the Backlash for Syringe Dispenser 212

Overview

A Preventive Maintenance (PM) regimen for the MultiFlo FX includes rinsing and
soaking the fluid path and cleaning and/or autoclaving the various components.
The level of maintenance required to keep the instrument performing as expected
is dependent on several factors, including the type of fluid dispensed, the
frequency of use, and the work habits employed.

The Recommended Maintenance Schedule on page 176 summarizes BioTek’s
recommended maintenance tasks, and indicates approximately how often each task
should be performed. Daily and periodic routines and minimal guidelines for
frequency are listed. Beyond that, it is difficult for BioTek to recommend a fixed
frequency for each task to be performed. The frequency of conducting these tasks
must be based on the risk and performance factors of your assays.

Develop a maintenance schedule for your MultiFlo FX based on the characteristics
of the fluids used and the activity level. Here are some guidelines for each
component:

Washer
o If the washer will be idle for several hours or days at a time, soak the tubes to
keep them in a ”wetted” state. Enable AutoPrime if the washer is idle for more
than 3 hours.

o Wash solutions affect the rinse frequency. If the solution does not contain
surfactant, consider rinsing (or running AutoPrime) at least once an hour.

Peri-pump
o Purge the fluid at the end of a dispense run and flush the tubing with water (or
buffered saline and then water). This is a good practice whenever the dispenser
will be idle for more than an hour, and at the end of the day.

o When using the 1 µL cassette, filter fluids to 50 microns to reduce the chance of
the tips clogging.

o When dispensing fluids that can crystallize or harden after use, increase the
frequency of maintenance activities.  Autoclave the cassette as needed.
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o Keep track of the number of plates processed with a cassette to determine when
the cassette has reached its expected lifetime and is due for replacement or
recalibration.

Syringe Dispenser
o Perform the daily maintenance routines. Flush the dispenser with an appropriate
reagent at the beginning of the day (e.g., deionized water in the morning) and at
the end of a run.

o When dispensing fluids that can crystallize or harden after use, increase the
frequency of maintenance activities. This is especially important for the 32-tube
small bore (SB) dispensers.

o Autoclave the Syringe heads and pistons, when applicable, and the 16-tube
manifolds as needed. See Clean the Dispense/Aspirate Tubes on page 202.

Recommended Maintenance Schedule

The schedule recommends preventive maintenance tasks, the frequency with which
each task should be performed, and the predefined onboard Maintenance program
that should be run (if applicable). See Recommended Maintenance Schedule on
the next page.

n It is important to note that the risk and performance factors associated with
your assays may require that some or all of the procedures be performed
more frequently than suggested in this schedule.

nWater: Daily maintenance is the key to keeping the liquid handler performing
to specifications. In the maintenance procedures provided in this manual, the
requirement to use distilled (dH2O) or deionized (DI) water can be met by
numerous water purification methods, including MilliQ™. A minimum water
purity of 2mOhm is expected.
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Recommended Maintenance Schedule

Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Washer

Run W-DAY_RINSE ü ü

Run AutoPrime ü

Run W-OVERNIGHT_LOOP ü

Run W-RINSE_AND_SOAK ü

Peri-pump

Flush dispense cassette ü ü

Record number of plates
processed with cassette

ü

Syringe Dispenser

Run S-DAY_RIN SE_A&B ü ü

Run AutoPrime ü

Components

Remove protein residuals and
fungi growth, (if necessary)

ü ü ü

Check/empty waste bottles ü ü

Clean bottles ü ü

Clean plate carrier system ü ü

Clean washer manifold ü ü

Clean aspirate and dispense tubes ü ü

Clean exterior surfaces ü

Clean Syringe dispenser manifold ü ü

Clean Syringe dispenser tubes ü ü
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Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Autoclave Syringe pumps ü

Decontaminate

Decontaminate external surfaces ü ü

Run W-DECONTAMINATE ü ü

Run S-DECONTAMINATE ü ü

Prepare for Storage or Shipment

Run W-LONG_SHUTDOWN ü

Run S-LONG_SHUTDOWN ü

Replace/Repair Components

Recalibrate Peri-pump cassette As Needed

Replace Peri-pump dispense
tips/chute

As Needed

Replace Peri-pump cassette tubing As Needed

Replace Syringe dispenser check
valves

As Needed
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Daily Maintenance

Daily maintenance involves flushing the washer and dispensers with an
appropriate reagent or deionized water throughout the day.  Routine rinsing helps
to prevent the aspirate and dispense tubes from clogging between runs. Flushing
the devices with deionized water is recommended at the end of the day for most
applications.

The recommended rinsing frequency depends on the solutions currently in use: 

l When a solution containing surfactant is used throughout the day, perform
the rinsing procedure when the device is idle for more than 3 hours.

l When the solution does not contain surfactant, consider rinsing at least once
an hour.

nThe type of hardware also affects rinsing frequency. The 32-tube dispense
manifolds require more diligence to keep them clog-free.

Run these protocols and enable AutoPrime to satisfy the daily maintenance
requirements:

l W-DAY_RINSE

l S-DAY_RINSE_A&B

l P-#UL_CASS_RINSE (# represents the cassette type)(P2 protocols are for the
secondary Peri-pump)

Make sure the supply bottles contain sufficient rinse solution and that the waste
bottles are empty before running the protocols.  

Also see the additional maintenance procedures required when dispensing protein
solutions: Removing Protein Residuals and Fungi Growth on page 187.

AutoPrime

AutoPrime automatically conditions the dispense tubes, priming them with the
specified volume, after a user-specified amount of idle time. See AutoPrime on the
facing page.

l Press the STOP button to interrupt the AutoPrime routine when it is
underway.

l Any interaction with the instrument via the touch screen or the LHC resets
the interval clock.
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Overnight/Multi-Day Maintenance

Overnight/multi-day maintenance involves flushing all solutions out of the
instrument, and then periodically rinsing and soaking the tubes to keep them
moist. Here are three recommendations for accomplishing the task. Employ the
method that best suits your work flow:

Overnight Loop

To keep the wash manifolds in a wetted condition, you can run these predefined
protocols to soak the tubes for several hours at a time:

l W-OVERNIGHT_LOOP: requires the washer to remain turned on.

l W-RINSE_AND_SOAK: alternatively, run this protocol and turn off the
instrument after the soak begins. The tubes will soak in the priming trough
until the instrument is turned on again.

AutoPrime

Recommended for optimum performance, AutoPrime keeps the tubing wet in
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime automatically primes the tubing whenever the instrument is idle for a
specified time. Keeping the tubes wet prevents clogging and mitigates fluid
evaporation at the tips. AutoPrime's submerge feature lets you soak the tubes for
extended periods, which is an effective maintenance option.

The downtime interval is defined for all components, but each device supports
distinct priming parameters. Devices are primed consecutively, beginning with the
syringe dispensers, not concurrently.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to
"Submerge."

"Submerge" is not offered for the Peri-pump because it is not a good practice for
the dispense cassettes. However, because the cassette Tip Holder resides on the
same dispense arm as the Syringe dispenser manifold, it will be moved into the
submerge position when the Syringe tips are submerged. Either remove the cassette
altogether when soaking the Syringe tips, or remove the prime trough inserts for
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the Peri-pump to prevent cross contamination of fluids or unintended wicking of
fluid into the cassette.

nKeep in mind that any interaction with the MultiFlo FX will reset the interval
clock. And, AutoPrime only runs when the main menu, quick menu, or run
completion message is displayed.

nWhen AutoPrime is running you can press STOP on the keypad to stop it. It
will run again the next time the downtime interval occurs.

Specify the Interval and AutoPrime Parameters

AutoPrime runs at the Home screen when the instrument has been idle for a
specified interval. One interval setting is defined for all devices.

To set the AutoPrime Interval:

LHC: Touch screen:

1. Select Tools>Instrument
Utilities> AutoPrime tab.

2. Specify the idle-time
interval that will trigger
an AutoPrime; up to 24
hours.

3. Enable and define the
parameters for each
device. Remember to set a
Submerge Duration to
employ this option.

4. Click Send to transfer the
settings to the instrument.

1. Select Instrument at the Home
screen and select AutoPrime.

2. Specify the idle-time interval
that will trigger an AutoPrime;
up to 24 hours in minutes.

3. Set the Submerge Duration, if
desired. You will select the
device to submerge in a
subsequent step.

4. At the AutoPrime Device Menu,
select the device you want to
enable.

5. For each device, define the
AutoPrime parameters: rate,
volume.

Turn on AutoPrime for the Peri-pump Dispenser

LHC Touch screen

1. Select Tools>Instrument
Utilities>AutoPrime;

1. Select Instrument
>AutoPrime;
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LHC Touch screen

2. Set the AutoPrime Interval: enter the
downtime interval that will trigger an
AutoPrime.

3. Fill the Enabled checkbox for the
dispenser.

4. Set the Volume and Rate. The default
settings are 50 µL/tube at the High flow
rate.

5. Click Send. Wait for a confirmation
message.

2. Set the AutoPrime Interval:
enter the downtime interval
that will trigger an
AutoPrime (for all devices).

3. Fill the checkbox for the
dispenser and, then, press its
link.

4. Set the Volume and Rate.
The default settings are 400
µL at rate 3.

Details about Peri-pump AutoPrime

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to
"Submerge."

"Submerge" is not offered for the Peri-pump because it is not a good practice for
the dispense cassettes. However, because the cassette Tip Holder resides on the
same dispense arm as the Syringe dispenser manifold, it will be moved into the
submerge position when the Syringe tips are submerged. Either remove the cassette
altogether when soaking the Syringe tips, or remove the prime trough inserts for
the Peri-pump to prevent cross contamination of fluids or unintended wicking of
fluid into the cassette.

nKeep in mind that any interaction with the MultiFlo FX will reset the interval
clock. And, AutoPrime only runs when the main menu, quick menu, or run
completion message is displayed.

nWhen AutoPrime is running you can press STOP on the keypad to stop it. It
will run again the next time the downtime interval occurs.

When the Peri-pump AutoPrime is Stopped

Because purging and priming the tubing is the best way to remove air bubbles and
prepare the tubing for accurate dispensing, this routine is executed whenever
AutoPrime for the Peri-pump is stopped:

1. Purge: fluid is purged from the tubing, i.e. returned to the supply vessel. The
volume depends on the cassette type (µL/tube).

2. Prime: the tubing is primed with the optimal volume of fluid (µL/tube):
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Cassette Type Purge Volume Prime Volume

10 µL 250 500

5 µL 150 300

1 µL 50 100

Note: these volumes are per tube, except for the RAD cassettes, multiply times 8
for total volume. You may want to disable AutoPrime when trying to preserve
expensive reagents.

Turn on AutoPrime for the Syringe Dispenser

LHC Touch screen

1. Select Tools>Instrument
Utilities>AutoPrime;

2. Set the AutoPrime Interval: enter the
downtime interval that will trigger an
AutoPrime.

3. Fill the Enabled checkbox for the
dispenser.

4. Set the Volume and Rate. The default
settings are 400 µL at rate 3.

5. Click Send. Wait for a confirmation
message.

1. Select Instrument
>AutoPrime;

2. Set the AutoPrime Interval:
enter the downtime interval
that will trigger an
AutoPrime (for all devices).

3. Fill the checkbox for the
dispenser and, then, press its
link.

4. Set the Volume and Rate.
The default settings are 400
µL at rate 3.

Note: The Volume dispensed is actually double the input value. The Syringe dispenser
always performs two prime cycles during AutoPrime, doubling the volume. For example,
when 400 µL is entered, the dispenser actually primes the tubing with 800 µL.

You can Submerge the dispense tubes in the fluid after the prime, if desired. This
requires filling the priming trough inserts, one for each syringe. Each reservoir
holds approximately 6.5 mL.

After the dispense tubes have been primed, the manifold moves down into the
priming trough inserts. When both Syringes are enabled, the soak duration
begins after both dispensers are primed.
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nImportant: When using the submerge option, specify a volume that fills the
priming trough inserts with sufficient fluid to cover the tubes, e.g. 6000 µL.
And, be sure to use the priming trough inserts when the option is enabled.
Learn more about soaking the dispense tubes...

Set the Submerge Duration and fill the Submerge checkbox to enable this option.

nRemove the Peri-pump cassette or its priming trough insert when soaking the
Syringe dispenser or washer manifolds.

Turn on AutoPrime for the Washer

l Learn about AutoPrime, if you haven't already done so.

1. Select Tools>Instrument Utilities>AutoPrime in the LHC or
Instrument>AutoPrime onboard.

2. Set the AutoPrime Interval: enter the downtime interval that will trigger an
AutoPrime.

3. Fill the checkbox for the washer and press its link.

4. Set the Volume and Rate. The default values are 400 µL at rate 3. x2 - Two
dispense cycles are performed.

5. You can Submerge the manifold tubes in the fluid after the prime, if desired.
Set Duration in Hours and Minutes.

After the dispense tubes have been primed, the manifold moves down into the
priming trough that is filled with the dispensed solution. The tubes are
allowed to soak. After the specified duration, the trough is aspirated.

It takes approximately 6.5 mL of fluid to fill the priming trough insert. Be sure
to specify a volume of fluid, we recommend 3500 µL, that will cover the tubes.

nNote: the washer aspirates fluid during the prime step, but it does not fully
evacuate the priming trough insert.

Keep in mind:

l AutoPrime can be stopped when it is underway: press STOP.

l Any interaction with the instrument via the touch screen or the LHC resets
the interval clock.

l AutoPrime only runs when the Home screen is displayed.
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Submerge and Shutdown

An overnight/multi-day maintenance option for soaking the tips and turning off
the instrument for overnight and weekend maintenance.

You can soak the MultiFlo FX dispense manifolds by filling the priming troughs
and turning off the instrument after the soak begins. The tubes will soak in the
priming troughs until the instrument is turned on again.

1. First, run S-DAY_RINSE_A&B but do not empty the priming trough inserts.

2. Turn off the instrument, and lower the manifolds into the priming trough.

3. Run W-RINSE_AND_SOAK.

4. When the wash manifold is submerged, turn off the instrument.

If the syringe dispenser manifolds do not lower themselves into their troughs,
gently push down on the dispense arm to submerge the manifold tips in the
priming fluid.

nRemove either the cassette or the Peri-pump priming trough from the
instrument before performing this procedure.

5. Run a System Self-Test on page 218 to empty the washer's priming trough when
restarting the instrument.

nNote: the washer aspirates fluid during the prime step, but it does not fully
evacuate the priming trough insert.

32-tube Syringe Dispenser

When using the 32-tube dispense manifold, especially the small bore (SB) model,
BioTek recommends using the following AutoPrime parameters to keep the
manifold clog-free:

Volume: 1000 µL

Flow rate: 3

Submerge duration: 3 hours (requires priming trough inserts)

Overnight/Multi-day practice: After modifying the AutoPrime parameters to
submerge the tubes for several hours:

1. Put the priming-trough-inserts into the priming trough.

2. Use Quick Dispense to fill both inserts (prime cups): QUICK>PRIME (for both
Syringe A and B). Run the Prime two or three times to fill the cups.

3. When the priming troughs are filled, press Main Menu.
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Soak the manifold tubes in cleaning fluid

Keeping the dispense and aspirate tubes in a wetted condition is required to keep
them clog free. Soak the tubing in deionized or distilled water or a cleaning fluid
whenever the device is not being used to ensure trouble-free performance.

Prime Step

1. Fill a supply bottle with a cleaning agent.

2. Click W-Prime or S-Prime and define parameters to fully prime the tubing, for
example:

Washer Syringe Dispenser

Volume = 5000 µL Volume = 8000 µL

Flow Rate = 5 Flow Rate = 5

Submerge tips in fluid after prime: enable option and set Duration, up to 24
hours.

nFor the manifolds: Use the priming trough inserts to submerge the tips.

nNote: the aspirate manifold does not completely evacuate the priming trough
insert.

nOvernight Maintenance: You can turn off the instrument after the tips are
submerged to leave them soaking in the priming trough for an extended
duration.

3. Click Run. Save the program with a memorable name for future use.

AutoPrime

Enable AutoPrime to ensure the tubing is soaked during downtime intervals.

It is especially important when using the 32-tube SB dispense manifolds to keep
the tubes wet to prevent clogs. One option is to modify the AutoPrime parameters
used for idle periods during a regular work day to soak the tubing for longer
periods overnight and on the weekends.

nBe sure to use the priming trough inserts when the submerge feature is
enabled. And, remove either the Peri-pump cassette or its priming trough
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insert.

Define the AutoPrime values to fill the priming-trough-inserts, e.g. 6000 µL, and
then submerge the tubes for several hours. When AutoPrime is enabled for both
dispense manifolds, the soak duration begins after both manifolds are primed, i.e.
both priming-trough-inserts have been filled.

More about soaking the dispense tubes...

You can soak the Syringe dispenser's two manifolds, A and B, simultaneously or
separately depending on how you define the prime routine. Two priming trough
inserts are supplied, one for each manifold. The troughs can be used to preserve
precious fluids and to soak the manifold tubes.

nNote: the washer aspirates fluid during the prime step, but it does not fully
evacuate the priming trough insert.

nBe sure to use the prime trough
inserts to submerge the tips in
fluid.

Create a Prime protocol

As an alternative to AutoPrime, BioTek recommends creating a protocol with two
prime steps to soak the Syringe dispenser's tubes:
l Do not enable the submerge feature for Syringe A. Specify a volume that fills the prime
trough insert, e.g. 6000 µL.
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l Create a second prime step for Syringe B, with the same volume, and the submerge
duration defined. Both Syringe A and Syringe B dispense tubes will be submerged in their
respective prime trough inserts.

Important: Remove the Peri-pump cassette when the Syringe dispenser is set to
"Submerge."

"Submerge" is not offered for the Peri-pump because it is not a good practice for
the dispense cassettes. However, because the cassette Tip Holder resides on the
same dispense arm as the Syringe dispenser manifold, it will be moved into the
submerge position when the Syringe tips are submerged. Either remove the cassette
altogether when soaking the Syringe tips, or remove the prime trough inserts for
the Peri-pump to prevent cross contamination of fluids or unintended wicking of
fluid into the cassette.

nKeep in mind that any interaction with the MultiFlo FX will reset the interval
clock. And, AutoPrime only runs when the main menu, quick menu, or run
completion message is displayed.

nWhen AutoPrime is running you can press STOP on the keypad to stop it. It
will run again the next time the downtime interval occurs.

Removing Protein Residuals and Fungi Growth

Important! Solutions containing proteins, such as bovine serum albumin (BSA),
will compromise the MultiFlo FX’s performance over time unless a strict maintenance
regime is adhered to. Do not use isopropyl alcohol or DI water to flush out BSA or
similar fluids.

When using protein solutions or similar fluids, BioTek recommends performing the
following additional Maintenance procedures to thoroughly flush out protein
particles and other contaminants from the fluid path.

Also note, some components can be autoclaved to sterilize them.

Daily Practice with buffer and deionized water:

If the MultiFlo FX will be idle between plates for longer than 45 minutes, flush the
proteins using buffer. Use buffer for the AutoPrime, as well, for immediate reuse of
the instrument. Otherwise, if the tubes will be allowed to dry, flush the system
with DI water to remove the buffer:
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1. Fill a supply bottle with buffer solution. Connect the bottle to the washer or
dispenser.

2. Run the applicable DAY_RINSE protocol.

3. Enable AutoPrime for 60-minute intervals.

nFlush the buffer from the system using DI water when the device will be idle
for an extended period, i.e. repeat steps 1 and 2 using water.

At the end of the day:

1. Fill a supply bottle with buffer. Connect the bottle to the washer or dispenser.

2. Run the applicable DAY_RINSE protocol three times.

3. Fill a supply bottle with deionized water. And repeat steps 1 and 2.

4. Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCl to remove proteins:

1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by
neutralization with an equivalent normality (0.1-0.5 N) of HCl (hydrochloride).

2. Rinse well with deionized water to remove the HCl.

3. Run the applicable DAY_RINSE protocol three times with deionized water if
you plan to use the device immediately.

n* N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of
solute per liter of solution. The gram equivalent weight is equal to the
molecular weight expressed as grams divided by the ‘valency’ of the solute.

Alternatively use an Enzyme-Active Detergent:

1. Mix an enzyme-active detergent according to the manufacturer’s directions to
fill a four-liter supply bottle. Connect the bottle to the washer’s Buffer valve A
or one of the Syringes. Connect a bottle of deionized or distilled water to
Buffer valve B to rinse the tubing.

2. Run the W-DECONTAMINATE or S-DECONTAMINATE protocol, as appropriate.

3. Respond to the Delay message, “Connect a bottle of water…”, leave the
detergent bottle connected and when ready, press Continue.

4. For the Syringes: connect a bottle with deionized or distilled water to the
pump and REPEAT the protocol.

5. When the protocol is completed, connect a bottle containing four liters of
deionized water and run W-DAY_RINSE or S-DAY_RINSE three times to flush
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the system.

6. Repeat the procedure for the other Syringe dispenser.

Periodic Maintenance

Periodic maintenance involves cleaning the components on a regular basis to keep
the instrument running efficiently and in compliance with performance
specifications.  The recommended frequency for cleaning components is at least
monthly. The risk and performance factors associated with your assays may require
that some or all of the procedures be performed more frequently.

Warning! Internal Voltage. Turn off and unplug the instrument for all cleaning
operations.

nImportant: Do not apply lubricants to manifold O-rings, channel-end seals,
bottle cover seals, any tubing connection, or any surface that is a part of the
fluid path. The use of any lubricant on the fluid handling components will
interfere with aspirate and dispense performance, and may cause irreparable
damage to these components.

nWater: Daily maintenance is the key to keeping the liquid handler performing
to specifications. In the maintenance procedures provided in this manual, the
requirement to use distilled (dH2O) or deionized (DI) water can be met by
numerous water purification methods, including MilliQ™. A minimum water
purity of 2mOhm is expected.

Important!

l Do not immerse the instrument, spray it with liquid, or use a ”wet” cloth on it.

l Do not allow the cleaning solution to run into the interior of the instrument. (If this
happens, contact the BioTek TAC.)

l Do not expose any part of the instrument to the recommended diluted sodium
hypochlorite solution (bleach) for more than 20 minutes. Prolonged contact may damage
the instrument surfaces.

l Be certain to rinse and thoroughly wipe all surfaces.

l Do not soak the keypad. Instead, moisten a clean cloth with deionized or distilled water
and wipe the keypad. Dry it immediately with a clean, dry cloth.

Perform these preventive maintenance tasks regularly:

l Clean the Bottles on the next page

l Clean the Plate Carrier on page 191
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l Peri-pump Dispenser Maintenance on page 192

l Syringe Dispenser and Strip Washer Maintenance on page 201

Autoclavable Components

Autoclaving is an efficient method of sterilizing instrument components. For
qualified items, it is a good alternative to some of the decontamination procedures.

Do autoclave: Do NOT autoclave:

Peri-pump cassettes Washer manifolds

16-Tube and Low-density-plate-type-
specific Syringe dispenser manifolds

Plate carrier

Priming trough inserts 32-Tube Syringe dispenser manifolds

Autoclavable Syringe pump head
(glass/stainless steel)

8-Tube Syringe dispenser manifolds (gray
block holds two manifolds, 16 tubes total)

Syringe module tubing with transparent
amber check valves and glass bottles

Non-autoclavable syringe pumps (black plastic)

Non-autoclavable syringe accessories: white
check valves and plastic bottles

l Autoclaving the cassette typically increases the tubes' capacity. Expect the cassette to
dispense more fluid than expected immediately after sterilizing or disinfecting the
tubing. (When the cassette is completely dry, dispense volumes return to normal.)

l Autoclaving the dispense cassette does not diminish its expected life.

Clean the Bottles

l Clean and rinse the supply bottles with deionized water before the first use, before each
refill, and, periodically, as necessary, to prevent bacteria growth.

l Empty the waste bottle often (at least daily), and firmly seat the waste bottle stopper.

l Rinse the covers every time the wash or rinse bottles are filled.

l Accumulated algae, fungi, or mold may require decontamination.

nTo ensure that fluid does not back up into the vacuum pump during operation,
always operate the instrument with the waste sensor cable installed and the
waste detection sensor enabled (the sensor is enabled by default).

If fluid collects in the overflow bottle, thoroughly rinse the level-switch
assembly and bottle.
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l Check the hex nuts securing the quick-disconnects to the bottle cap to ensure they are
not loose or corroded.

Clean the Plate Carrier

If liquid has overflowed onto the plate carrier, transport rail, or platformglide
strips, some buildup may occur and prevent the microplate from seating correctly
on the carrier. This can interfere with plate transport. Weekly cleaning is
recommended.

1. Turn the instrument off.

2. Lift the carrier up and off the transport rail. Loosen the thumbscrew on the left
side of the carrier to release the little bracket that holds the carrier in place and
remove the carrier.

3. Clean the carrier, rails, and glide stripssurface, using mild detergent and hot
water, 70% isopropyl alcohol, or ethanol. Clean the priming trough, too.

4. If detergent was used, wipe the components with a cloth moistened with water.
Use a clean, dry cloth to dry the components.

5. Reinstall the carrier:
l Place it on the transport rail so the slot on its base fits into the Y-axis Carrier Arm.
l Clip the bottom bracket onto the transport rail, align the little bracket on the left rail
to hold the carrier in place and tighten the thumbscrew.

l If necessary, release the spring-loaded microplate clamp in the back left corner of the
carrier to level the carrier on the base.

Clean the exterior surfaces

1. Turn off the instrument and disconnect the power cable.

2. Moisten a lint-free disposable towel with water, or with water and mild
detergent. Do not soak the cloth.

3. If detergent was used, wipe all surfaces with a cloth moistened with water.

4. Use a clean, dry cloth to dry all wet surfaces.
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Peri-pump Dispenser Maintenance

The level of the maintenance required to keep the dispenser/washer performing as
expected is highly dependent on several factors, including the type of fluid
dispensed, the frequency of dispensing, and the work habits employed. For
example, when dispensing fluids that can crystallize or harden after use,
maintenance activities are required more frequently.

When using the 1 µL cassette filter fluids to 50 microns to reduce the chance of tips
clogging. 

Daily maintenance includes purging the fluid at the end of a dispense run and
flushing the tubing with water (or buffered saline and then water). This is a good
practice whenever the dispenser will be idle for more than an hour, as well as at
the end of the day.

Another important daily requirement is keeping track of the number of plates
processed with a cassette. This is necessary to determine when the cassette has
reached its expected lifetime and is due for replacement or recalibration.
Replacement Tubing Kits, a refurbishment service, and new cassettes are available
from BioTek Instruments.

Monthly maintenance requires overall cleaning of the dispenser and its accessories,
and verifying performance to determine if the cassette needs recalibration.
Autoclaving or decontaminating the cassette is also recommended.

Peri-pump Maintenance Tasks:

l Flush the Dispense Cassette below

l Unclog the Dispense Tips on page 194

l Record the Number of Plates Processed on page 199

l RAD 8-to-1 Cassette - Replace Chute on page 200

l Recalibrate the Peri-pump Dispense Cassette on page 211

l Replace Peri-pump Dispense Cassette Tubing on page 210

Flush the Dispense Cassette

Prime the tubing with an appropriate reagent at the beginning of the day, and,
flush the tubing to effectively remove all contaminants at the end of the day.
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The type of rinse fluid to use is determined by the type of fluid you are
dispensing. Some dispense fluids require the use of enzyme-active detergent,
buffered saline, ethanol or isopropyl alcohol, rather than deionized water alone.

Tools and Supplies

l Deionized or distilled water

l Buffered saline solution or enzyme-active detergent for protein or cell based
assays

At the start of the day:

Prime the tubing to prepare for a dispense run.

1. Reload the cassette and fill the supply vessel:

l When dispensing solutions not effected by water, simply prime with the
dispense fluid.

l When dispensing protein solutions, first prime the tubing with a buffered
saline solution to remove any traces of water in the tubing, then, prime with
the dispense fluid.

2. Prime the tubing until fluid flows into the priming trough and all visible air
bubbles have been removed.

At the end of the day:

Purge the tubing to reclaim the dispense fluid, then Prime the tubing to flush it
clean.

1. Purge the cassette until the tubing appears empty.

2. Replace the supply vessel with the appropriate rinse fluid:

l When dispensing water soluble solutions use deionized or distilled water.

l When dispensing protein solutions, first prime the tubing with a buffered
saline solution to remove protein particles, then, prime with deionized or
distilled water.

3. Prime the tubing for the specified duration:
l 1 µL cassette = 5 seconds
l 5 µL cassette = 7 seconds
l 10 µL cassette = 10 seconds.
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Unclog the Dispense Tips

The small diameter of the dispense tips makes them susceptible to clogging. You
may be able to visually identify a clogged tip, or inaccurate dispense performance
may signal a problem. Good work habits can prevent clogging or reduce its
occurrence:

l When using 1 µL cassettes, filter fluids to 50 microns before dispensing.

l Thoroughly flush the tubing after/in-between usage, especially when using
liquids that crystallize or harden.

In case the need arises, BioTek ships a 10 cc plastic syringe with special tubing and
fitting for use unclogging tips. Installation instructions recommend storing it in the
pouch on the back of the instrument. The remedy involves removing the dispense
tip and flushing it with water. Depending on the type of clog, soaking the tip
holder in hot water with mild detergent is recommended.

This task may be easier if you use the cassette’s shipping container to hold the
unaffected cassette parts, keeping them out of your way.

Required Materials
l 10 cc syringe with tubing and fitting attachment shipped with dispenser

l Screwdriver shipped with dispenser

l A sufficient quantity of deionized (DI) water in a beaker
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Procedure

1. Fill the 10 cc syringe with water and set aside.

2. Remove the cassette from the dispenser.

3. Use the screwdriver to open the Tip Holder. Put the top of the holder aside.

4. Lift the affected dispense tube from the holder and pull its tip off the tube.

5. Slide the tip, tapered end first, into the tubing on the end of the syringe.

6. With the tip poised to expel the clog and the water into the beaker or a sink,
discharge the syringe.

7. Fill and discharge the syringe as many times as needed to flush the tip.

8. Reassemble the cassette:
l Push the straight end of the tip into the bottom of the tube (the tapered end of the
dispense tip is exposed).

l Reinsert the tube into the Tip Holder. Seat the flared edges of the tip into the molded
slots.

l Replace the Tip Holder cover with its two screws. The etched BioTek label identifies the
top of the cover (except for 1536 cassettes’ steel cover plate).

RAD™ Technology Cassettes

Gaining access to the tips is the only difference in the procedure above for
unclogging the single-tube and 8-to-1 bulk-dispensing cassettes. Here are some
guidelines for disassembling and reassembling the RAD cassettes:
l See RAD Single-tube Cassette - Unclog the Tip on the next page

l See RAD 8-to-1 Cassette - Unclog the Tips on page 197
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RAD Single-tube Cassette - Unclog the Tip

Disassemble the cassette to unclog the tip:

Single-tube RAD Cassette

1. Use the screwdriver provided with the MultiFlo
FX to disassemble the cassette's tip holder.
Remove the two screws on the single-tube
cassette's cover to release its bottom plate.

2. Upturn the cassette's tip holder, and remove the
tubing.

3. Pull off the tip and follow the instructions to
flush the tip using the 10 cc syringe.

4. When finished, reassemble the tip holder:

l Put the straight end of the tip into the bottom
of the tube leaving the tapered end exposed.

l 1 µL tubing: put the little block in the space
provided for it.

l All tubing: slide the flared top of the tip into
its molded slot. Only the end of the tip
protrudes from the holder.

l Replace the bottom plate: it only fits one way.

l Holding the pieces together, turn it over and
insert the two screws. Tighten each screw half
way, rotating between the two before
tightening them all the way.
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RAD 8-to-1 Cassette - Unclog the Tips

Note: Reassembling the 8-to-1 cassette is somewhat challenging. Before resorting to this
method of unclogging the tips, try multiple purge-prime rounds and/or autoclaving the
cassette. If that fails, proceed with this method.

Disassemble the cassette to unclog the tips:

1. Use the Philips screwdriver provided
with the MultiFlo FX to remove the
three screws on the 8-to-1 cassette's
cover plate.

2. Remove the plate and set it aside.

3. Remove the two screws that hold the
chute on the cassette.

4. Remove the chute and set it aside. This
frees the tips and tubing from the
cassette.

5. Pull the tubing off the tips and follow the instructions to use the 10 cc syringe
to unclog tips. See Unclog the Dispense Tips on page 194.

6. When finished, reassemble the cassette:

l Observe the numbers next to the tubing posts on the back side of the
molded tip head. Use the Center Holder to determine the proper order for
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restoring the tubing: for this procedure the tubes are numbered as shown
below, from left to right when facing the center holder.

molded tips with tube numbering

l Push the tubes back onto posts on the molded tip head taking care to place
the correctly numbered tube onto its numbered post. Try to make the tubes
flush with the tip head.

Use a little isopropyl alcohol on the tubing to help it slide onto the post.

Note: Components fit back together in only one way!

l Attach the tip head (with tubing) to
the cassette head by aligning the pins
on the tip head with their sockets on
the cassette.

l Reattach the chute, aligning it on the
same pins and securing it with its two
screws. Tighten each screw half way,
rotating between the two before
tightening them all the way.
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l Gather the tubes together, as neatly as
possible, and slide them into the groove in
the stainless steel cover plate.

l Seat the cover plate correctly on the
cassette and secure it in place with its three
screws. Tighten each screw half way,
rotating between the three before
tightening them all the way.

Record the Number of Plates Processed

To determine when a tubing cassette has reached the end of its expected lifetime,
make a habit of counting and recording the approximate number of plates and
volume dispensed per cassette.

Create a form similar to the example table below or estimate your usage of the
cassette and project a date for replacement or recalibration.

Cassette Expected Lifetime

Cassette Types Cassette Life Total Volume

1 µL 1000 384-well plates @ 5 µL/well 2,000 mL

5 µL 1000 96-well plates @ 50 µL/well 5,000 mL

10 µL 1000 96-well plates @ 100 µL/well 10,000 mL
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With strict adherence to best practices and maintenance recommendations, this is
the typical longevity of the dispense cassettes.

Example table for recording cassette usage:

You may want to create a form similar to this table to keep track of the volume
dispensed with each cassette:

Cassette serial #: 2178

Date # Plates Plate Type Volume/Well Total Daily Vol. Total Cassette Vol

10/10/08 26 384 5 µL 49920 µL 50 mL

10/11/08 33 96 10 µL 31680 µL 82 mL

RAD 8-to-1 Cassette - Replace Chute

As needed, you can replace the chute on the 8-tube RAD bulk-dispensing cassette.
A spare chute is included in the cassette package.

Use the Philips screwdriver shipped with the MultiFlo FX to remove the chute and
replace it with another:

To reattach the chute, align it on the pins on the tip head and secure it with its two
screws. Tighten each screw half way, rotating between the two before tightening them all
the way.
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Syringe Dispenser and Strip Washer Maintenance

The level of the maintenance required to keep the dispenser/washer performing as
expected is highly dependent on several factors, including the type of fluid
dispensed, the frequency of dispensing, and the work habits employed. For
example, when dispensing fluids that can crystallize or harden after use,
maintenance activities are required more frequently.

32-tube small bore (SB) dispense manifold: If the fluid
streaming from a dispense tube appears to be awry or skewed,
it is most likely caused by minute particles of debris on the end
of the tube. Brush away any particles from the end of the tube
using a piece of silicon tubing. Silicon will not flake off and leave
particles behind like other materials.

Clean the Bottles and Tubes 
l Clean the dispense and rinse bottles and supply tubes with deionized water before the
first use, before each refill, and if they have been idle for any length of time.

l Accumulated algae, fungi, or mold may require decontamination.

Syringe Dispenser Maintenance Tasks
l Autoclave the Syringe Head on page 204

l Clean the Dispense Tubes on the next page

l Clean the Syringe Dispenser Manifold below

l Clean or Replace the Check Valves on page 204

l Run AutoPrime to soak the dispense tubes

Clean the Manifolds

Regular rinsing helps to keep the manifold clean and the dispense tubing clear,
and will increase the life of the tubing. Follow the Decontamination procedure to
disinfect the manifold and tubing.

If you suspect a particular problem is related to the manifold (for example, clogged
tubes can result in uneven dispensing), you should perform a thorough cleaning of
the manifold.
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To clean the manifold:

1. Turn off and unplug the instrument.

2. Pull the manifold off of the dispense arm and disconnect the tubing from the
manifold.

3. Remove the plugs from the ends of the manifold. Using a lint-free disposable
towel, thoroughly clean the outside of the dispense tubes.

4. Run hot water through the inlet fitting. Check to see if water comes out of all of
the dispense tubes. If not, soak the manifold in hot soapy water and repeat.
Clean the Dispense Tubes below, if necessary.

Clean the Dispense/Aspirate Tubes

nDo NOT autoclave the dual 8-tube and 32-tube dispense manifolds!

n Do NOT autoclave the washer dispense or aspirate manifolds!

nNote: The autoclavable 16-tube and non-autoclavable 8-tube manifolds have
removable dispense tubes. We do not recommend routinely removing these
tubes. In the case of a particularly difficult problem with any one channel,
however, a tube may be removed and cleaned individually, or replaced.

Clean the Tubes

Unless there is a problem, the manifold tubes do not need special cleaning.
Periodic rinsing is usually sufficient to keep the tubes clean. However, if the
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regular maintenance is not completely successful, try the following:
l washer, 8- and 16-tube manifolds: clean the tubes with the stylus;

l 32-tube manifolds: flush the tubing with the 10 mL syringe.

1. Remove the plugs from the ends of the manifold.

2. Tip the manifold on end and flush hot water through this open channel.

3. Using the supplied tool, clean the insides of all of the tubes.
o washer, 8- and 16-tube manifold stylus: PN 2872304

o 32-tube manifold: 10 cc syringe and tubing

Let water flow through the open channel while you probe or flush each tube,
forcing any particles to be washed away.

4. Rinse the manifold with deionized or distilled water. Check to see if water
comes out of all of the dispense tubes (except when working with the 32-tube
SB manifold). Reinsert the plugs into the ends of the manifold.

5. Remount the manifold and replace the tubing.

6. Run a Prime protocol using 40 mL of deionized water.

7. Verify dispense performance visually, or Perform the Syringe Dispense Precision &
Accuracy Test on page 236.
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Clean or Replace the Check Valves

nThe check valves do not twist open.

If the check valves leak or become clogged, you can either clean or replace them.
Contact BioTek Customer Service to order replacement check valves.

To clean a check valve:

1. Pull the tubing off the check valve.

2. Insert the stylus into the feed end of the valve to hold it open (observe arrow on
valve indicating flow direction).

3. Flush with hot water.

4. Replace the valve and the tubing.

Replace Syringe Dispenser Check Valve on page 211, if necessary.

Autoclave the Syringe Head

Certain models of the Syringe dispenser are not autoclavable. Be sure your
dispenser is described as autoclavable before proceeding. See Syringe Dispenser-
Autoclavable vs. Non-autoclavable on page 167.

1. Use the supplied 3/32” (2.39 mm) hex wrench to remove the two mounting
screws that hold the syringe head in the unit.

2. Pull the syringe head straight back and off of the piston
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3. Use the hex wrench to loosen the setscrew on top of the sleeve that holds the
piston and then remove the piston.

Important! Autoclave the piston and syringe head separated from one another.
Keep the piston and syringe head unattached to each other when autoclaving. 

4. Autoclave at 134°C and 216 kPa for 3 minutes, or 121°C and 115 kPa for 30
minutes. The manifold, tubing, autoclavable check valves, and supply bottles
may also be sterilized in the autoclave.

nCheck valves (PN 68073) recommended for use with organic substances
cannot be autoclaved.

5. Replace the components by reversing the steps:

6. With the flat side of the shaft facing up, slide the syringe piston shaft into the
piston holder until it stops.

7. Use the 3/32” (2.39 mm) hex wrench to tighten the setscrew.

8. Push the syringe head over the piston until it is flush with the unit and use the
hex wrench to attach the two mounting screws. 

Decontamination

Any laboratory instrument that has been used for research or clinical analysis is
considered a biohazard and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into contact with the
instrument during shipping, handling, and servicing. Decontamination is required
by the U.S. Department of Transportation regulations. Persons performing the
decontamination process must be familiar with the basic setup and operation of the
instrument.
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The recommended frequency for decontamination is at least monthly, and before
shipment of the instrument to BioTek for calibration or repair.

nImportant! BioTek Instruments, Inc. recommends the use of the following
decontamination solutions and methods based on our knowledge of the
instrument and recommendations of the Centers for Disease Control and
Prevention (CDC). Neither BioTek nor the CDC assumes any liability for the
adequacy of these solutions and methods.  Each laboratory must ensure that
decontamination procedures are adequate for the biohazards they handle.

Warning! Internal Voltage. Turn off and unplug the instrument for all
decontamination operations.

nDo not immerse the instrument, spray it with liquid, or use a ”wet” cloth. Do
not allow the cleaning solution to run into the interior of the instrument. If this
happens, contact the BioTek TAC. Do not soak the keypad.

nWear prophylactic gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep gloved
hands away from eyes, mouth, nose, and ears.  Eating and drinking while
decontaminating instruments is not advised.

nMucous membranes are considered prime entry routes for infectious agents.
Wear eye protection and a surgical mask when there is a possibility of aerosol
contamination. Intact skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts may not always be
visible. Wear protective gloves when performing the decontamination
procedure.

Tools and Supplies

0.5% sodium hypochlorite (NaClO, or bleach)

70% isopropyl alcohol (as a bleach alternative)

Deionized or distilled water

Priming plate

Safety glasses

Surgical mask

Protective gloves
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Lab coat

Biohazard trash bags

Clean cotton cloths

Step-by-Step Decontamination Instructions:

l Decontaminate Exterior Surfaces below

l Decontaminate Tubing and Manifold on the next page

l Alternate Decontamination Procedure for Tubing and Manifold on page 1

Decontaminate Exterior Surfaces

Caution! Be sure to check the percentage NaClO of the bleach you are using; this
information is printed on the side of the bottle. Commercial bleach is typically 10%
NaClO; in this case, prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in
this case, prepare a 1:10 dilution.

The bleach solution is caustic; wear gloves and eye protection when handling. 

1. Turn off the instrument and disconnect the power cord. Empty the waste bottle.

2. Unload the Peri-pump cassette and the prime trough inserts, and remove the
Syringe dispenser manifold and tubing, if applicable.

3. Autoclave the cassette and other autoclavable components.

4. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).
As an alternative, 70% isopropyl alcohol (or 70% ethanol) may be used if the
effects of bleach are a concern.

nIsopropyl alcohol is not recommended for removing proteins (such
as bovine serum albumin).

5. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.
l Wipe the touch screen (do not soak). Wipe again with a clean cloth moistened with
deionized or distilled water. Dry immediately with a clean, dry cloth.

l Wipe the plate carrier, top surface of the instrument’s base, supply bottles and
tubing, and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with DI or distilled water.
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l Wipe the inside and outside surfaces of the Peri-pump cover panel.

l Wipe the plate carrier, top surface of the instrument’s base, supply bottles, tubing,
bottle covers and all exposed surfaces of the instrument that have been cleaned
with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

Decontaminate Tubing and Manifold

Predefined protocols to flush and soak the supply tubing and manifolds with
disinfectant, then flush the system with rinse fluid, are installed onboard the
instrument and on the host computer during installation of the LHC:

o W-DECONTAMINATE for the washer
o S-DECONTAMINATE for the Syringe dispenser (two protocols: for dispenser A
and dispenser B)

When storing or shipping the instrument, the LONG_SHUTDOWN procedure (page
208) primes and soaks the instrument, and ends by pushing air through the system.
The parameters can be edited for optimum cleaning. For example, consider using
ethanol instead of air to complete the decontamination process.

nTwo supply bottles are required for this procedure: one for disinfectant, and
one for rinse.

1. Empty the waste bottle, if necessary.

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).

3. Fill one supply bottle with at least 400 mL of bleach solution (disinfectant).

4. Fill another supply bottle with at least 800 mL of deionized water (rinse).

5. Reconnect the power cord and turn on the instrument.

6. Run the decontamination protocols.

Long Shutdown (Prepare for Storage or Shipment)

Before the MultiFlo FX is shipped or stored, the entire system should be rinsed and
soaked with disinfectant and then purged of all fluid. Perform these steps when
leaving the instrument unused for a long period of time.
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Predefined protocols are installed onboard the instrument and on the host
computer during installation of the LHC:

o W-LONG_SHUTDOWN— for the washer

o S-LONG_SHUTDOWN— for the Syringe dispenser

The LONG_SHUTDOWN protocols flushes and soaks the supply and manifold tubing
with disinfectant, then flushes with rinse, and finally purges the system of fluid. 

For the Syringe dispensers: copy this protocol and modify it to run on Syringe B.

nThree supply bottles are required for this procedure: one for disinfectant, one
for rinse, and one for air.

Caution! Be sure to check the percentage NaClO of the bleach you are using; this
information is printed on the side of the bottle. Commercial bleach is typically 10%
NaClO; in this case, prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in
this case, prepare a 1:10 dilution.

1. Turn the instrument off and disconnect the power cord.

2. Unload the Peri-pump cassette and the prime trough inserts, if applicable.
Clean and store them separately.

3. Empty the waste bottle.

4. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).

5. Fill one supply bottle with at least 400 mL of bleach solution (disinfectant).

6. Fill another supply bottle with at least 800 mL of deionized water (rinse).

7. Keep the third supply bottle empty (air).

8. Turn on the instrument and run W-LONG_SHUTDOWN.

nWhile this program is running, you will need to periodically check the display
panel and follow the instructions.

9. When the washer has been cleaned and purged, repeat the process to clean and
purge the Syringe dispensers, if applicable:
o Prepare the supply bottles with disinfectant, rinse and air;

o Run S-LONG_SHUTDOWN
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Storing the Instrument

After performing the Long Shutdown (Prep for Storage or Shipment) on page 208
protocols:
l Turn off the instrument and disconnect the power cord.

l Store it on a flat surface that is relatively free of vibration, in a dust-free and particle-
free environment.

l Protect the instrument from temperature extremes that can cause condensation within
the unit and from corrosive fumes and vapors.

l Store the instrument under the following environmental conditions:

Temperature: 20° to 50°C (-4° to 122°F)

Relative humidity: 10% to 85% (non-condensing)

n Important: Allow the instrument to reach room temperature before use after
storage.

Replace Components

Some components of the MultiFlo FX must be replaced periodically to maintain
specified performance levels.

Peri-pump Components

l Replace Peri-pump Dispense Cassette Tubing below

l Recalibrate the Peri-pump Dispense Cassette on the facing page

Syringe Dispenser and Strip Washer Components

l Clean or Replace the Check Valves on page 204

l Calibrate the Backlash for Syringe Dispenser on page 212

Replace Peri-pump Dispense Cassette Tubing

BioTek provides replacement tubing kits as an alternative to buying a new cassette.
Purchase the replacement tubing kits from BioTek and follow the instructions
shipped with the kit or on the MultiFlo FX Operator’s Manual CD/USB stick in the
"Cassette Calibration" folder, titled: 7171017_(current Rev)_Replacing the tubing_
8x14.PDF. For the best experience with these instructions print them on legal size
paper (8½” x 14”).
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Recalibrate the Peri-pump Dispense Cassette

Gravimetric Method                                    

The most precise method for calibrating a cassette is the gravimetric method. Find
the instructions and an Excel® spreadsheet on the MultiFlo FX Operator’s Manual
USB stick, titled: Gravimetric Calibration Instructions 7171024 (current Rev).pdf.

Calibration Jig

BioTek offers an accessory for recalibrating dispense cassettes. The Calibration Kit
(PN 7170017) includes an 8-pipette jig, instructions and an Excel spreadsheet that
may save time when calibrating a cassette.

Follow the instructions shipped with the kit or find them on the MultiFlo FX
Operator’s Manual USB stick, titled: Calibration Jig Instructions 7171009 (current
Rev).pdf.

Important: After calibrating the cassette, BioTek recommends performing the "Peri-
Pump Dispense Precision and Accuracy Tests" defined in the operator's manual and
IQOQPQ procedure to verify the cassette meets specifications.

Replace Syringe Dispenser Check Valve

You can order replacement check valves from BioTek Customer Care if your check
valves become clogged and cleaning them does not solve the problem:
l PN 68083 — Autoclavable valves for use with non-organic substances.

l PN 68073 — Check valves recommended for use with organic substances.

n If you observe a decline in performance after changing the check valves,
Calibrate the Backlash for Syringe Dispenser on the next page.
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Calibrate the Backlash for Syringe Dispenser

nPlate-Type-Specific Syringe Manifolds: this procedure requires an
experienced user and both standard 8- and 16-channel manifolds to determine
the backlash for these special manifolds. Contact BioTek TAC for assistance.

If you have replaced a check valve and subsequently noticed a decline in
performance, recalibrating the backlash is recommended to restore accuracy in
dispense volumes. 

Equipment Required

l Microplates: 384-well plates for testing the 16-tube dispensers (which can be
replaced with 96-well plates if more applicable for your lab); 1536-well plates
for testing the 32-tube dispensers; and 96-well plates for testing the 8-tube
dispensers.

l Precision balance with minimum capacity of 100 g and readability of 0.001 g
resolution

l Supply bottle with deionized water

Setup

While calibrating and testing, try to maintain a steady liquid level in the supply
bottle, keeping it half full. Start with more fluid to allow for priming. Connect the
supply bottle to the Syringe under test. Make sure the supply bottle is at the same
level as the dispenser.

Create a Dispense Protocol

Create a protocol that dispenses the correct volume for the manifold under test:
l 16-tube manifold: 20 µL per well to a 384-well plate at Flow Rate 2.

l 32-tube manifold: 6 µL per well to a 1536-well plate at Flow Rate 2.

l 8-tube manifold: 20 µL per well to a 96-well plate at Flow Rate 2.

Prime and Dispense

1. Run a Prime protocol, for example, S-DAY_RINSE or S-DAY_RINSE_A&B when
both Syringe pumps need calibration, to remove air bubbles from the tubing.

2. Place the plate on the balance, and tare the balance.

3. Place the plate onto the carrier and run the dispense protocol created above.
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4. Upon completion, carefully remove and reweigh the plate to determine the
Actual Weight.

5. The Expected Weight is:
o 16 tube = 7.680 grams

o 32 tube = 9.216 grams

o 8 tube = 1.920 grams

6. Calculate the volume (weight) error and the backlash adjustment that needs to
be made:

o 16 tube: (7.680 - Actual Weight ÷ 24 ÷ [.0033 or .0031*]) = backlash setting

o 32 tube: (9.216 - Actual Weight ÷ 48 ÷ [.0033 or .0031*]) = backlash setting

o 8 tube: (1.920 - Actual Weight ÷ 12 ÷ [.0033 or .0031*]) = backlash setting
* use .0033 for autoclavable units; use .0031 for non-autoclavable units.

l Subtract the Actual Weight from the Expected Weight and divide by
the number of columns dispensed to.

l Divide the result by 0.0033 and round to the nearest whole number.

Example: 7.680 - 7.550 = 0.130, 0.130/24 = 0.00542, 0.00542/0.0033 = 1.64
rounded to 2. The backlash setting needs to be adjusted by 2.

7. Adjust the backlash as necessary: select Tools>Instrument Utilities> Syringe
Dispenser and enter the number of steps in the applicable Backlash fields in
the Calibration Data group box.

8. Repeat steps 1 through 4 until the volume dispensed is within one backlash
unit of being exact: ± 0.119 mL.
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Qualification

This chapter provides instructions for periodically testing the
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Qualification Overview

Instrument verification for the MultiFlo FX involves three activities: qualification of
installation and setup, qualification of routine capability, and qualification of long-
term stability. These activities are called Installation Qualification (IQ), Operational
Qualification (OQ), and Performance Qualification (PQ), respectively. Verification
testing includes:
l The System Self Test verifies system components, such as the vacuum, manifold, and
carrier positioning. The Checksum Test verifies the basecode software against internal
checksum values to ensure that no corruption has occurred.

Washer

l Evacuation Efficiency: This test measures the residual volume per well after
aspiration. The lower the residuals per well, the better the evacuation efficiency of the
washer. 

l Dispense Precision: This test measures the variability of volumes dispensed from tube
to tube across the manifold. 

Washer Qualification Tests:
l Dispense Precision and Accuracy Test on page 253

l Evacuation Efficiency Test on page 254

Peri-pump and Syringe Dispensers

l Dispense Precision is a measure of the variability of volumes dispensed from tube to
tube across the manifold or tip holder. The optical density of the solution in a well is
proportional to the total volume of the solution in the well. When the % Coefficient of
Variation (%CV) is calculated, the result is a measure of the uniformity of the
distribution of dispensed volumes across the manifold. It is the ratio, expressed in
percent, of the standard deviation of the distribution of fluid volumes in the wells to the
mean value of volume per well. The uniformity of distribution across the manifold
improves as the %CV is lowered. 

l Dispense Accuracy is a measure of the average volume dispensed per well. It is
independent of precision. The volume per well may vary greatly over a plate, yet the
accuracy may be exact because it is an average of the volumes.

Peri-pump Qualification Tests:
l Performing the Peri-Pump Precision and Accuracy Tests on page 224
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Syringe Dispenser Qualification Tests:
l Perform the Syringe Dispense Precision & Accuracy Test on page 236

Qualification Schedule

The following schedule defines the factory-recommended intervals for verification
tests for an instrument used two to five days a week. The schedule assumes that
the MultiFlo FX is properly maintained as outlined in the Recommended Maintenance
Schedule on page 176.

nNote: An instrument qualification package (PN 1260521) is available for
purchase. The package contains thorough procedures for performing
Installation Qualification, Operational Qualification and Performance
Qualification (IQ-OQ-PQ) and preventative maintenance (PM). Extensive
Checklists and Logbooks are included for recording results. Contact your local
dealer for more information.

Tests
IQ OQ PQ

Initially Annually Monthly

Unpacking, Installation, and Setup ü

System Self Test and Checksum Test ü ü ü

Shake Test ü

Washer Evacuation Efficiency Test ü ü

Washer Dispense Precision & Accuracy Test ü ü

Peri-pump Dispense Precision and Accuracy
Test

ü ü

Syringe Dispense Precision and Accuracy Test ü ü

Run Assay ü

nImportant! The risk factors associated with your assays may require that the
Operational and Performance Qualification procedures be performed more or
less frequently than shown above.
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System Self-Test, Verify Information

Perform these steps to verify software information and run a system self-check:

Prerequisite: When controlling the instrument with the LHC, ensure that it is
attached to the host computer and turned on, and then launch the LHC software.

To run the System Self-Test:

LHC Touch screen

Select Tools>Instrument
Utilities>General Settings.
Under Instrument Functions,
click Perform Self-check.

1. Select Instrument at the Home screen.

2. On the Other screen, press Run Self-
Check.

Test Results:

l If the test fails, an error code displays. If this happens, find the error code in
the MultiFlo FX Operator’s Manual to determine its cause. If the problem is
something you can fix, turn off the instrument, fix the problem, and then turn
the instrument back on and re-run the test. If the problem is not something
you can fix, contact BioTek’s Technical Assistance Center.

Record Onboard Software

Record the software part number and version installed on the MultiFlo FX.

LHC Touch screen

1. Select Tools>Instrument
Utilities

2. Select the Software tab and from
the Basecode Software
Information section record the

l Software Version and part
number

1. Select Instrument at the Home
screen.

2. Record the Software part number
and version from the About screen.
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Liquid Testing the MultiFlo™ FX Multi-Mode Dispenser

Which Tests to Perform?

We recommend that you perform these routine tests before first use (after the
IQ) and then monthly:

Washer
l Dispense Precision and Accuracy Test. Precision tests measure the variability of
volumes dispensed from tube to tube across the manifold and Accuracy tests measure
the average volume dispensed per well.

l Evacuation Efficiency Test. Measures the residual volume per well after the
aspiration aspect of plate washing. The lower the residuals per well, the better the
evacuation efficiency of the washer.

Perform the tests applicable to the installed wash manifold type.

Peri-pump Dispenser
l Dispense Precision and Accuracy Test. For each Peri-pump installed perform two
tests, one at the volume that matches the cassette type and another that best represents
the cassette type and dispense volume most common to your applications.

l RAD Technology Cassettes: For the single-tube cassettes, perform the two tests as
recommended for the standard cassettes, except limit the dispense to only one row. For
the 8-to-1 bulk-dispensing cassette, perform the special test procedure.

Syringe Dispenser
l Dispense Precision and Accuracy Test. Perform two tests for each syringe using the
tests that best represent the plate type and dispense volume most common to your
applications.

Standard manifolds: Liquid Tests

8-tube manifolds (1 unit) Test 1 and
Test 2

16-tube manifolds Test 1 and
Test 2

32-tube manifolds Test 3

Low-Density-Plate-Type-Specific Manifolds:

6-, 12-, 24-, 48-well manifold Plate-type-
specific test
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Important Recommendations for All Liquid Tests

Test Solutions

l Using pure deionized water in place of the test solutions is not
recommended and will likely result in the failure to meet specifications.

l Prepare the solutions the day before you plan to run the tests. This will
allow any foam caused by the agitation of solutions containing Tween® 20 to
settle.

l BioTek determined the pass/fail specifications for the instrument tests using
the recommended test solutions. You may use your own buffer solution
instead, but if any tests fail using your own buffer, retry the tests using the
recommended solutions.

Plate Reading

l If you are using one of BioTek’s keypad-based readers, such as the ELx800 or
ELx808, ensure that the reader is not running in Rapid mode. To check the

setting, select UTIL à READ and cycle through the options until READ IN

RAPID MODE? appears. Set it to NO.

l The absorbance of blue dye solutions should be measured at 630/450 (or
405) nm. The BioTek blue dye solution part number is 7773001.

l The final absorbance for all dye solution concentrations should be in a range
between 0.700 and 1.600 OD.

Recording Test Results

l Use the Liquid Test Worksheets at the end of this section for recording data
reduction results. If your tests are failing, this information will be useful for
BioTek TAC to help diagnose any problems.
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Peri-pump Dispense Precision and Accuracy Tests

Dispense Precision and Accuracy Specifications

Cassette Precision Accuracy

1 µL 10%CV  @ 1 µL per well ± 10%@ 1 µL per well

5%CV  @ 2 µL per well* ± 5%@ 2 µL per well*

10%CV  @ 0.5 µL per well n/a

5 µL 5%CV  @ 5 µL per well ± 4%@ 5 µL per well

2.5%CV  @ 10 µL per well* ± 2%@ 10 µL per well*

10 µL 4%CV  @ 10 µL per well ± 4%@ 10 µL per well

2%CV  @ 20 µL per well* ± 2%@ 20 µL per well*

* These specifications are for these dispense volumes and higher.

Exception: the accuracy specs above apply to the RAD technology bulk-dispensing cassette, 8
tubes-to-1 (chute) with 5 µL tubing for volumes that are 8 times the full unit increments for
the cassette, e.g. valid at 40, 80, 160, ... 30,000 µL:

l ± 4% when volume is 40 µL/well

l ± 2% when volume is ≥80 µL/well.

nNote: For IQ/OQ/PQ purposes you can add 1.0% additional tolerance to the
Precision %CV to accommodate various test solutions, off-peak wavelengths,
reader errors, and pipette errors.

Peri-pump Precision and Accuracy Testing Methodology 

Tare an empty plate on a balance. Use the Peri-pump to dispense a quantity of
fluid with a known dye concentration to the wells. Weigh the plate to obtain the
weight of the fluid dispensed.  Pipette deionized water on top of the dye to bring
the wells up to a more optically measurable volume (if necessary). Read the wells
in a microplate reader and determine the percentage Coefficient of Variance (%CV)
among all wells, and gravimetrically determine the accuracy of the volume
dispensed in each well (% Accuracy Error).

BioTek recommends performing two tests, one at the volume that matches the
cassette type and another that best represents the cassette type and dispense
volume most common to your applications:
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Tests – Solutions
Cassette Types

1 µL 1 µL 1536 5 µL 10 µL

1 µL √ √

5 µL √

10 µL √ √

50 µL √

100 µL √

1536 √

8-to-1 √

l 1 µL Test: Confirms the performance of the 1 µL cassettes when dispensing a single
aliquot (1/4 turn of pump) into each well of the plate. It dispenses 1 µL into each well
using the 1 µL Solution, and requires an additional 150 µL of deionized or distilled
water to raise the fluid level for optimal reading.

nA single aliquot for a cassette type is the smallest volume unit recommended
for it. 1 µL for the 1 µL cassette, 5 µL for the 5 µL cassette, and 10 µL for the
10 µL cassette (except that later model instruments can dispense 0.5 µL/well
using a 1 µL cassette).

l 5 µL Test: Confirms the performance of the 5 µL cassettes when dispensing a single
aliquot (1/4 turn of pump) into each well of the plate. It dispenses 5 µL into each well
using the 5 µL Solution, and requires an additional 150 µL of deionized or distilled
water to raise the fluid level for optimal reading.

l 10 µL Test: Confirms the performance of the 1 µL cassettes when dispensing 10 aliquots
(2 1/2 turns of pump) and the 10 µL cassettes when dispensing a single aliquot (1/4 turn
of the pump) into each well of the plate. It dispenses 10 µL into each well using the 10
µL Solution, and requires an additional 100 µL of deionized or distilled water to raise
the fluid level for optimal reading.

l 50 µL Test: Confirms the performance of the 5 µL cassettes when dispensing 10 aliquots
(2 1/2 turns of pump) into each well of the plate. It dispenses 50 µL into each well using
the 50 µL solution, and requires an additional 100 µL of deionized or distilled water to
raise the fluid level for optimal reading.

l 100 µL Test: Confirms the performance of the 10 µL cassettes when dispensing 10
aliquots (2 1/2 turns of pump) into each well of the plate. It dispenses 100 µL into each
well using the solution called 100 µL solution, and requires an additional 50 µL of
deionized or distilled water to raise the fluid level for optimal reading.

l 1536 Test: Confirms the alignment of the tips; that the cassette is firing straight into
the wells. Dispenses 6 µL into columns 2, 4, 19-30, 45, 47 of a 1536-well plate using the
"1536 solution." Also requires performing the 1 µL Test described above.
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l 8-to-1 Test: Confirms the performance of the RAD technology 8- to-1 bulk-dispensing
cassette 40 µL/well into a 24-well plate (which is 8 times the full 5 µL tubing
increments). Use the 100 µL solution, and top off the wells with an additional 1080
µL/well of deionized or distilled water to raise the fluid level for optimal reading.

Peri-pump Dispenser Test Materials

l 96-well plates: Corning® Costar #3590 or equivalent

l 1536-well plates: Nunc #264710, if applicable

l 24-well plates: Corning® Costar #3524, for RAD 8-to-1 cassette

l Precision balance with readability of 0.0001 g resolution is preferable, 0.001 g resolution
is acceptable, and capacity of 100 g minimum

l Pipettes and graduated beakers

l Microplate absorbance reader capable of dual wavelength reading at 630 and
450 (or 405) nm

l BioTek blue dye solution, PN 7773001, or equivalent to create the Peri-pump Dispense
Precision and Accuracy Test Solutions below.

nSee Important Recommendations for All Liquid Tests on page 220.

Peri-pump Dispenser Precision and Accuracy Test Solutions

Unique concentrations of the test fluid are described here, each one corresponds to
a specific dispense volume. Prepare the solutions you will need to validate the
cassette types and dispense volumes used most commonly in your applications.

nThe 5 µL Solution is used to make the higher volume test solutions.

1 µL Solution

Using BioTek’s 10X concentrated blue dye solution (PN 7773001), mix 5 mL of
deionized or distilled water with 8 mL of the blue dye solution.

5 µL Solution

Using BioTek’s 10X concentrated blue dye solution (PN 7773001), mix 100 mL of
deionized or distilled water with 10 mL of the blue dye solution.

10 µL Solution

Mix 25 mL of DI or dH2O water with 20 mL of the 5 µL Solution (described above).
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50 µL Solution

Mix 45 mL of DI or dH2O water with 5 mL of the 5 µL Solution.

100 µL Solution

Mix 40 mL of DI or dH2O water with 2 mL of the 5 µL Solution. (Use this solution
to test the RAD 8-to-1 cassette.)

1536 Solution

Mix 5 mL of 70% isopropyl alcohol with 3 mL of the 5 µL Solution and 35 mL of DI
H2O.

Perform the Peri-Pump Precision and Accuracy Tests

Prerequisite:
l Gather the required materials.

l Prepare the test solutions.

l Make a copy of the applicable worksheets. Find them on the operator's manual USB stick
in the Qualification chapter PDF.

Procedure:

1. Install the cassette to be tested.

2. Turn on the MultiFlo FX and make sure the cassette type setting is correct.

3. Turn on the balance.

4. Fill a beaker or other vessel with the test solution.

5. Define a Protocol and save it for reuse. Set the parameters based on the desired
test volume:

nA predefined protocol for the 1536 Test is shipped with the instrument and
installed on your PC when you install the LHC: QC_P-1536_DISP_TEST (P2
protocols are designed for the Secondary Peri-pump).

l  Add a dispense step to the protocol: .

l Set the Dispense Volume to match the Test:

Test Volume

1 µL 1 µL
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Test Volume

5 µL 5 µL

10 µL 10 µL

50 µL 50 µL

100 µL 100 µL

1536 6 µL

8-to-1 1120 µL

l Set the Flow Rate to High for all protocols except the 1µL test; use the Medium
flow rate for this test.

l Optionally, choose to Require the specific cassette type under test.
l LHC/Touch screen users: select Advanced options: retain the default
Positioning settings.

l Define a Pre-dispense: set the volume to 10 µL and the Number of
Pre-dispenses (cycles) to 2.

l RAD single-tube cassettes: define the Well Map to dispense to one row only.
Then, perform the remaining steps in this procedure on that row only. Remember
to calculate the results based on 12 wells, rather than 96.

5. Place a clean/new microplate on the balance and tare the balance.

6. Put the Tube Organizer into the test fluid vessel and Prime the tubing until any
large air bubbles are removed.

7. Run the dispense protocol.

8. Place the plate on the balance and record the Total Dispense Weight in the
worksheet.

9. Using a calibrated hand pipette or the Peri-pump, add the specified amount of
deionized water to each well to raise the fluid level for optimal reading.

Test Volume

1 µL 150 µL

5 µL 150 µL

10 µL 100 µL

50 µL 100 µL

100 µL 50 µL

1536 0 µL

8-to-1 0 µL
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10. Read the plate in an absorbance reader using the dual-wavelength method: read
the plate at 630 nm and 450 nm.

11. Calculate the Delta OD: (630 nm - 450 nm), Mean Absorbance, Standard
Deviation, and the %CV for the wells under test. %CV = (Standard Deviation ÷
Mean) * 100.

12. Print the report, obtain required signatures, and store it according to regulatory
guidelines.

If one or more of your tests are failing, make sure the dispense tubes are not
clogged, (follow instructions to Unclog the Dispense Tips on page 194). If that doesn’t
work, recalibrate the cassette and repeat the test(s). If your tests continue to fail,
contact BioTek’s Technical Assistance Center (TAC).

Documenting Test Results

Dispense Precision & Accuracy Test Worksheets are provided below. We
recommend you make copies of the appropriate pages and use them to record your
calculations and test results.

Alternatively, you can purchase the instrument qualification package, which
contains additional tools for conducting test procedures and recording the results,
including logbooks and Excel® spreadsheets.

MultiFlo™ FX Multi-Mode Dispenser



Peri-pump Dispense Precision & Accuracy Test Worksheet
1 µL Test for 1 µL Cassette

1 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 11.0% c Pass    c Fail

1 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 10.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Number:

Tests Performed By:
Date:

Reviewed/Approved By:
Date:

MultiFlo FX Qualification Procedures
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10 µL Test for 1 µL Cassette

10 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 6.0% c Pass    c Fail

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 5.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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1536 Test

1536 Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 384)

% CV (SD ÷ Mean x 100) %

% CV must be < 6.0% c Pass    c Fail

1536 Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 5.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Peri-pump Dispense Precision & Accuracy Test Worksheet
5 µL Test

5 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 6.0% c Pass    c Fail

5 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 4.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Peri-pump Dispense Precision & Accuracy Test Worksheet
50 µL Test for 5 µL Cassette

50 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 3.50% c Pass    c Fail

50 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 2.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Peri-pump Dispense Precision & Accuracy Test Worksheet
10 µL Test for 10 µL Cassette

10 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 5.0% c Pass    c Fail

10 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 4.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved By:
Date:

MultiFlo FX Qualification Procedures
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Peri-pump Dispense Precision & Accuracy Test Worksheet
100 µL Test

100 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ # of wells)

% CV (SD ÷ Mean x 100) %

% CV must be < 3.0% c Pass    c Fail

100 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 2.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Peri-pump Dispense Precision & Accuracy Test Worksheet
8-to-1 RAD Cassette Test

100 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 24)

% CV (SD ÷ Mean x 100) %

% CV must be < 2.5% c Pass    c Fail

100 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100 %

% Accuracy Error must be < 4.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Cassette Serial Num-
ber:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Syringe Dispenser Liquid Tests

Dispense Precision and Accuracy Specifications

n Important: For IQ/OQ/PQ testing purposes 1.0% tolerance has been added
to some of the published specifications for Precision %CV to accommodate
variations in test solutions, off-peak wavelengths, reader errors, and pipette
errors. % Accuracy Error is calculated for the dispense volume specified in the
respective test procedure in adherence to the published specifications.

Test # Plate Type-Manifold Precision Accuracy

2 384-well plate < 3% CV @ 80 µL/well < 1.25%@ 80 µL/well

1 16-tube manifold < 6% CV @ 20 µL/well < 5%@ 20 µL/well

2 96-well plate < 3% CV @ 160 µL/well < 1.25%@ 160 µL/well

1 8- & 16-tube manifold < 6% CV @ 40 µL/well < 5%@ 40 µL/well

3 1536-well plate < 12% CV @ 6 µL/ well < 5%@ 6 µL/well

32-tube manifold

Low-Density-Plate-Specific Manifolds

Dispense Precision

Refer to the values below for dispense precision when measured in full plates with the
specified volume of deionized water with 0.1% Tween 20 and FD&C#1 blue dye solution
and read at 630 nm/405 nm.

Plate Type Performance Volume (µL/well)

6-Well ≤6.0% CV 5560

12-Well ≤4.0% CV 2240

24-Well ≤4.0% CV 1120

48-Well ≤4.0% CV 560

Dispense Accuracy is measured gravimetrically when dispensing any volume of room-
temperature deionized water using Flow Rate 2. For all plate-specific manifolds, dispense
accuracy shall be 2 µL or 1%, whichever is greater.
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Syringe Dispenser Test Materials

l Microplates: 384-well plates for testing the 16-tube dispensers (which can be replaced
with 96-well plates if more applicable for your lab); 1536-well plates for testing the 32-
tube dispensers; and 96-well plates for testing the 8-tube dispensers. For the low-
density-plate-type specific manifolds, the applicable plate type is required.

l Precision balance with readability of 0.0001 g resolution is preferable, 0.001 g resolution
is acceptable, and capacity of 100 g minimum

l Pipettes and graduated beakers

l Microplate absorbance reader capable of dual wavelength reading at 630 and 405 (or
450) nm

l The test solutions: Syringe Dispenser Test Solutions below.

nSee also Important Recommendations for All Liquid Tests on page
220.

Syringe Dispenser Test Solutions

20 µL Solution

o Mix 10 mL of BioTek’s blue dye solution with 100 mL of deionized or distilled water
to create a dilution of the concentrate. Mix 160 mL of deionized or distilled water
with 20 mL of the diluted concentrate.

80 µL Solution

o Mix 120 mL of deionized or distilled water with 40 mL of the 20 µL Solution.

1536 Solution

o Mix 21 mL of 70% Isopropyl Alcohol with 13 mL of the 20 µL Solution and 150 mL
of DI H2O.

Perform the Syringe Dispense Precision & Accuracy Test

Prerequisites:
l Gather the required materials: Syringe Dispenser Materials above.

l Prepare the test solutions: Syringe Dispenser Test Solutions above.

l Make a copy of the applicable worksheets.

BioTek Instruments, Inc.
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Test Protocols

Two predefined QC protocols are provided for qualifying the 32-tube dispensers.
Skip the protocol development steps in the procedure when testing these
dispensers:

Onboard Name Description

SA-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe A
manifold.

SB-1536_DISP_TEST Dispense precision test protocol for 32-tube Syringe B
manifold.

These predefined protocols dispense 6µL/well into 512 wells of a 1536-well
plate (columns 2, 4, 19-30, 45, 47). For speed, efficiency and to reduce the
amount of alcohol needed, the test is designed for visual inspection of the two
columns at each end of the plate, while the block of columns at the center of the
plate is used for evaluating dispense precision.

Procedure: 

Standard Syringe Manifolds: Perform two tests for each syringe using the
applicable plate type and dye solutions. Plate-Type-Specific Manifolds: Perform
one test for each syringe using the applicable plate type and the 80 µL solution.

Standard Syringe Manifolds Low-Density-Plate-Type-Specific
Manifolds

384-well for the 16-tube manifolds (unless
only 96-well plates are used in your lab),
1536-well for the 32-tube manifolds, and 96-
well for the dual 8-tube manifold.

6-, 12-, 24-, or 48-well plates supported by
the manifold.

1. Prepare the syringe dispenser to be tested:

Standard Syringe Manifolds Plate-Type-Specific Manifolds

l Test 1: Use the 20 µL solution

l Test 2: Use the 80 µL solution

l Test 3: Use the 1536 solution

l Plate-Type Test: Use the 80 µL solution

2. Prime the Syringe using your preferred method: run S-DAY_RINSE_A (or B) or
use the Quick Dispense menu to remove any air bubbles from the system.

3. Create and save protocols for the tests, two for each Syringe, A and B, as
follows, except only one test per manifold is required for plate-type-specific
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manifolds:

Skip these protocol development steps for the 32-tube dispensers. And,
because you will save the protocols, you only need to create them one
time for the other manifolds.

1. Define a Dispense step for each test for each manifold, A and B:

Standard Syringe Manifolds

Manifold
Type

Plate
Type

Volume
(µL/wel
l)

Flow
rate Pre-dispense (2 cyc)

Test 1: 16-Tube 384 20 2 20

8-Tube 96 40 2 40

Test 2: 16-Tube 384 80 2 80

8-Tube 96 160 2 160

Plate-Type Specific Manifolds

Parameters 6-Well 12-Well 24-Well 48-Well

Volume (µL/well) 5560 2240 1120 560

Flow Rate 5 5 5 5

Z-axis/Dispense Height 465 460 452 460

Pre-dispense (2 cycles) 320 220 160 320

2. Save the protocol.

4. Place a clean, empty microplate on the balance and tare the balance.

5. Place the microplate on the carrier and run the protocol (created in step 3 or
predefined).

6. Place the plate on the balance and record the Total Dispense Weight. This value
will be used to calculate the % Accuracy Error.

7. For Test 1 Only: Use a calibrated hand pipette or the Peri-pump to dispense
deionized water on top of the dye solution in the wells.

l 384-well: Pipette 60 µL/well (resulting in 80 µL/well)

l 96-well: Pipette 120 µL/well (resulting in 160 µL/well)

BioTek Instruments, Inc.
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8. Shake the plate using the MultiFlo FX, an orbital shaker or in a microplate
reader for 15 seconds, or lightly tap the side of the plate with your finger to
agitate the contents of the wells.

9. Read the plate in an absorbance reader using the dual-wavelength method, to
reduce the influence of scratches and foreign particles that could be in the well. 
See the recommended wavelengths. Print or export the results. 

10. Calculate and report the Mean absorbance, Standard Deviation, and the %CV for
the wells under test. %CV = (Standard Deviation ÷ Mean) * 100.

11. The % Accuracy Error calculation is: (Actual Weight - Expected Weight) ÷
Expected Weight x 100

Subtract the expected dispense weight (see below) from the Actual (Total)
Dispense Weight (from step 5), and divide the result by the expected weight.
Multiply the result by 100.

The Expected Dispense Weight is the volume dispensed per well in mL
multiplied by the number of wells dispensed. For example, if 40 μL is
dispensed to 96 wells, the expected weight is 0.040 x 96 = 3.84 grams. We
have calculated some expected dispense weights for you:

Test # of wells Volume
μL/well Expected Weight

Test 1: 384 wells 20 7.68 grams

96 wells 40 3.84 grams

Test 2: 384 wells 80 30.72 grams

96 wells 160 15.36 grams

Test 3: 512 wells (of a 1536-well plate) 6 3.012 grams

Plate-Type Specific Tests

6 Well 5560 33.36 grams

12 Well 2240 26.88 grams

24 Well 1120 26.88 grams

48 Well 560 26.88 grams
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12. Analyze your test results. The following is the Pass criteria for each test:

Test %CV % Accuracy Error

Test 1 < 6.0% ± 5.0%

Test 2 < 3.0% ± 1.25%

Test 3 < 12.0% ± 5.0%

6 Well < 6.0% ± 1.0%

All other plate-type tests < 4.0% ± 1.0%

If one or more of your tests are failing, clean the dispense tubes with the stylus, re-
prime the manifold, and repeat the test(s). If your tests continue to fail, contact
BioTek’s Technical Assistance Center.

Documenting Test Results 

Dispense Precision & Accuracy Test Worksheets are provided on the MultiFlo FX
Operator's Manual USB flash drive in the Qualification chapter PDF. We
recommend you make copies of the appropriate pages and use them to record your
calculations and test results.

Each worksheet records calculations and pass/fail test results for an individual test.

BioTek Instruments, Inc.



Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 96-Well Microplate/40 µL Dispense 

40 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 96)

% CV (SD ÷ Mean x 100) %

% CV must be < 6.0% c Pass    c Fail

40 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be < 5.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Serial Number:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
© BioTek® Instruments, Inc.



Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 96-Well Microplate/160 µL Dispense

160 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 96)

% CV (SD ÷ Mean x 100) %

% CV must be < 3.0% c Pass    c Fail

160 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be < 1.25% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Serial Number:

Tests Performed By:
Date:

Reviewed/Approved By:
Date:

MultiFlo FX Qualification Procedures
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 1 / 384-Well Microplate / 20 µL Dispense

20 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 384)

% CV (SD ÷ Mean x 100) %

%CVmust be < 6.0% c Pass    c Fail

20 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight)÷ Expected Weight x 100

%

% Accuracy Error must be < 5.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Serial Number:

Tests Performed By:
Date:

Reviewed/Approved
By:
Date:

MultiFlo FX Qualification Procedures
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 2 / 384-Well Microplate / 80 µL Dispense

80 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 384)

% CV (SD ÷ Mean x 100) %

% CV must be < 3.0% c Pass    c Fail

80 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be < 1.25% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Serial Number:

Tests Performed By:
Date:

Reviewed/Approved By:
Date:

MultiFlo FX Qualification Procedures
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Syringe Dispenser Precision & Accuracy Test Worksheet

Test 3 / 1536-Well Microplate / 6 µL Dispense

6 µL Dispense Precision Test

Standard Deviation (SD):

Mean Absorbance (sum of all wells ÷ 384)

% CV (SD ÷ Mean x 100) %

% CV must be < 12.0% c Pass    c Fail

6 µL Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be < 5.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Serial Number:

Tests Performed By:
Date:

Reviewed/Approved By:
Date:

MultiFlo FX Qualification Procedures
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Dispense Precision and Accuracy Test Worksheet

6-Well-Plate Syringe Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 6 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 6.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±1.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:
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Dispense Precision and Accuracy Test Worksheet

12-Well-Plate Syringe Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 12 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±1.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Dispense Precision and Accuracy Test Worksheet

24-Well-Plate Syringe Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 24 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±1.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Dispense Precision and Accuracy Test Worksheet

48-Well-Plate Syringe Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 48 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±1.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Washer Qualification Liquid Tests

Dispense Precision and Accuracy Test

Dispense precision is a measure of the variability of volumes dispensed from tube
to tube across the manifold. The optical density of the solution in a well is
proportional to the total volume of the solution in the well. If the % Coefficient of
Variation (%CV) is calculated, the result is a measure of the uniformity of the
distribution of dispensed volumes across the manifold. It is the ratio, expressed in
percent, of the standard deviation of the distribution of fluid volumes in the wells
to the mean value of volume per well. The uniformity of distribution across the
manifold improves as the %CV is lowered.

Dispense accuracy is a measure of the average volume dispensed per well. It is
independent of precision. The volume per well may vary greatly over a plate, yet
the accuracy may be exact because it is an average of the volumes.

n Important: For IQ/OQ/PQ testing purposes 1.0% tolerance has been added
to some of the published specifications for Precision %CV to accommodate
variations in test solutions, off-peak wavelengths, reader errors, and pipette
errors. % Accuracy Error is calculated for the dispense volume specified in the
respective test procedure in adherence to the published specifications.

Evacuation Efficiency Test

The Evacuation Efficiency test measures the residual volume (mean residual
weight) per well after aspiration is performed. The lower the residual per well, the
better the evacuation efficiency of the washer. A known solution is dispensed into
all wells of a previously weighed microplate. Aspiration is performed and the plate
is re-weighed. The total residual fluid is calculated based on the weight difference,
and this value is divided by number of wells in the plate, to obtain the mean
residual weight.

In addition, a diagnostic tool is provided for use, if necessary, to identify problem
wells: a known dye concentration is dispensed to and evacuated from the wells,
and the plate is weighed. Buffer is then dispensed to all wells to bring the volume
of fluid to a more optically measurable volume. The optical density (OD) of each
well is measured and the background is subtracted to account for scratches on the
plate or particulates in a well. Each well’s residual volume is calculated using its
OD and a calibration factor derived from the mean residual weight and the mean
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OD of all wells on the plate. It is assumed that 1 mg = 1 µL of fluid for this
calculation.

Washer Qualification Test Materials

l One new microplate per test to be performed:

Microplate Type

Flat-bottom 96-well plates, Corning® Costar #3590 or equivalent

Flat-bottom 384-well plates, Corning Costar #3574 or equivalent

Flat-bottom 48-well plates, Corning Costar #3548 or equivalent

Flat-bottom 24-well plates, Corning Costar #3524 or equivalent

Flat-bottom 12-well plates, Corning Costar #3513 or equivalent

Flat-bottom 6-well plates, Corning Costar #3516 or equivalent

l Precision balance with minimum capacity of 100 g and readability of 0.001 g
resolution

l Pipettes and graduated beakers

l Microplate absorbance reader capable of dual wavelength reading at 630/450
nm

l Liquid Test Worksheets at the end of this chapter for recordingdata and
results

l Deionized or distilled water
l Test solutions described below

nThese volumes are sufficient for performing the dispense tests and standard
and diagnostic Evacuation Efficiency tests with enough fluid remaining to re-
run a test, if necessary.

Test Solutions

Solution #1:  Buffer Solution

Pipette 1 mL Tween 20 into 1 liter (1000
mL) of deionized or distilled water and
mix well.

or Pipette 10 mL of BioTek Wetting Agent* into
1 liter of deionized or distilled water and
mix well.
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* BioTek Solution #1 100X Concentrate Wetting Agent 125 mL (PN 7773002)
contains 10% Tween 20 in deionized water and 0.01% Sodium Azide as a
preservative.

SOLUTION #2:  Residual Test Solution

Mix 100 mL of Solution #1 with 0.050
grams of FD&C #1 blue dye.

or Mix 90 mL ofSolution #1with 10 mL
of BioTek Blue Test Dye*.

* BioTek Solution #2 10X Concentrate Blue Test Dye 125 mL (PN 7773001)
contains 5 grams per liter FD&C Blue #1, 0.1% Tween 20 in deionized water and
0.01% Sodium Azide as a preservative.

SOLUTION #3:  Dispense Precision and Accuracy Solution

Mix 1180 mL of deionized or distilled water with 20 mL of Solution #2.

Create Washer Qualification Protocols

1. Select Maintenance at the Home screen, and then Define.

2. Press Create.

3. Press the Name field and assign a unique name, e.g. 6-Well
Dispense Test.

4. Plate Type: select the appropriate plate type for the test and
press OK.

5. Add steps with the recommended parameters (shown below):

l Add a W-Dispense step for the Dispense Precision and
Accuracy test and W-Aspirate step for the Evacuation
Efficiency test.

l Press Advanced Options to define the Z-axis, Pre-Dispense,
and other parameters.

6. Press Save to save the protocol for future use.

Dispense Precision and Accuracy Protocols

Parameters 6-Well 12-Well 24-Well 48-Well 384-well

Volume (µL/well) 5560 2240 1120 560 80
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Parameters 6-Well 12-Well 24-Well 48-Well 384-well

Flow Rate 5 5 5 5 5

Z-axis/Dispense
Height

465 460 452 460 333

Pre-dispense For all manifold types enable and set its Volume to 300 µL and
Number of cycles to 2.

Retain default values for all other parameters.

Evacuation Efficiency Protocols

Parameters 6-Well 12-Well 24-Well 48-Well

Travel Rate 0 1 1 1

Z-axis 45 51 51 42

X-axis 350 222 150 96

Retain default values for all other parameters.

Dispense Precision and Accuracy Test

nFind a list of the supplies you will need at Materials on page 251.

nSave the plate!When this test is complete, use the filled plate to perform the
Evacuation Efficiency Test.

nPrerequisite for plate types other than 96-Well: Create the protocols
needed to test your manifold. See Create Washer Qualification Protocols
on the previous page. One time only! (Predefined protocols are provided
with the instrument qualification package (PN 1260521).

1. Fill a supply bottle with 2 liters of deionized or distilled water and run the W-
DAY_RINSE protocol once or twice to flush the fluid lines and manifold.

2. Fill a supply bottle with 1200 mL of Solution #3.

3. Run W-DAY_RINSE again to prime the washer with the solution.

4. Place a new microplate on the balance and zero the balance.

5. Place the plate on the carrier and run the QC_96_DISP_TEST or the protocol
you created for your manifold.  The protocol dispenses solution to each well of
the plate.  It does not evacuate the solution.
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6. When the protocol is completed, carefully remove the plate. Place the plate on
the balance and record the Total Dispense Weight.

7. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

8. Use the Dispense Precision Test Worksheet to perform data reduction:

Tip: If you have a spreadsheet software program, enter/export all 96 values into a
spreadsheet and apply your program’s Standard Deviation function (e.g., Microsoft®
Excel’s STDEV).

a. Calculate the Standard Deviation.

b. Calculate the sum of the OD values for all wells, then divide by number of
wells, e.g. 96, to determine the Mean OD for the plate.

c. Calculate the %CV: (Standard Deviation / Mean OD) * 100.

The %CV should be <= 4.0,
except for 6-well plates the %CV should be <= 6.0.

If the %CV is greater than 3.0, one or more dispense tubes may need to be cleaned.
Remove the manifold and use the stylus to clean the dispense tube(s) giving lower-
than-average absorbance readings. When finished, re-prime the washer and retry
the test.

9. When finished, prime with deionized water to flush out the dye solution.

Evacuation Efficiency Test

nSave the plate!When this test is complete, use the plate to perform the
Shake Test for the OQ, if applicable.

nPrerequisite for plate types other than 96-Well: Create the protocols
needed to test your manifold. See Create Washer Qualification Protocols
on page 252. One time only! (Predefined protocols are provided with the
instrument qualification package (PN 1260521).

n If you tared the balance at the start of the Dispense Precision and
Accuracy Test, use the plate from that test here; skip steps 1-3.

1. Fill a supply bottle with 2 liters of deionized or distilled water. Run the
Maintenance program W-DAY_RINSE two or three times to prime the tubing
and manifold.
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2. Place a new 96-well microplate on the balance and zero the balance.

3. Pipette or dispense specified volume of Solution #1 into each well of the
microplate:

Plate
Type

Volume
(µL/well)

96 Well 300

6 Well 5560

12 Well 2240

24 Well 1120

48 Well 560

4. Place the plate on the carrier and run the W-96_EVAC_TEST protocol or the
protocol you created for your manifold.  This protocol evacuates the wells,
leaving a small amount of residual fluid.

5. When the program is completed, remove the plate and weigh it immediately
because evaporation will affect the results. This is the Total Residual Weight in
grams.

6. Visually inspect the plate and note if any wells appear to have considerably
more liquid than others.

7. Use the Evacuation Efficiency Test Worksheet to perform data reduction:
o Divide the Total Residual Weight by number of wells to find the Mean
Residual Weight.

o The Mean Residual Weight should be <=.

Plate Type Expected Mean
Residual Weight

96 Well 0.002 g

6 Well 0.6 g

12 Well 0.15 g

24 Well 0.05 g

48 Well 0.025 g

If the Mean Residual Weight is greater than expected, or if one or more wells
appear to have much more liquid than the others, the washer failed the test.
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Troubleshoot as follows:

If the test fails once: 
o If the problem appears to be related to particular wells, clean those aspiration
tubes: remove the manifold and thoroughly clean the tubes with the stylus (See
Clean the Dispense/Aspirate Tubes on page 202). When finished, retry the
test.

o Failure of this test is commonly caused by improper aspiration tube placement
within the wells, usually because a microplate other than the recommended
Corning Costar® was used. If you must use a plate other than a Corning Costar,
modify the Aspirate Height, i.e., Z position, or horizontal X or Y position
parameters in a copy of the protocol to correct this error.  After making this
change, retry the test using a new microplate.

If the test fails a second time: For 96-well plates, perform the Evacuation Diagnostic
Test. All other plate types, closely examine the residual volume in each well to
identify which aspirate tube(s) are clogged.

Evacuation Diagnostic Test

nConduct this test if the standard Evacuation Efficiency Test fails twice when
using a 96-well plate. This test will confirm which aspirate tube(s) may be
clogged, or if the plate’s alignment or position is the problem. For a ll other
plate types, a close examination of the residual volume in each well will
identify which aspirate tube(s) are clogged.

1. If you have not already done so, repeat steps 2 through 7 of the standard
Evacuation Efficiency test, using Solution #2 for the dispense fluid. Be sure to
recalculate the Mean Residual Weight.

2. Pipette Solution #1 into each well, on top of the residual solution: up to 300
µL/well in a 96-well plate or 100 µL/well in a 384-well plate.

3. Shake the plate to achieve uniform distribution of the remaining dye in each
well.

4. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

5. Use the Evacuation Efficiency Test Worksheet to perform data reduction:

l Calculate the sum of the OD values for all wells, then divide by the number
of wells to determine the Mean OD for the plate.

l Divide the Mean OD by the Mean Residual Weight (from step 1), to find the
Residual Factor.
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l For each well, divide its OD value by the Residual Factor to find its Residual
Weight.

Each well’s Residual Weight should be <= 0.002 g.

If one or more wells have a Residual Weight greater than 0.002 g, review the data to
determine which well, or wells, is causing the problem.

o If the problem appears to be related to particular wells, clean the associated
aspiration tubes: remove the manifold and thoroughly clean the tubes with the
stylus, and repeat the test.

o If the problem appears to be related to a particular region, edge, or corner of the
plate, review the alignment and flatness of the plate on the carrier. 

o For additional suggestions, See Troubleshooting on page 272.
o If the test continues to fail, contact BioTek Instruments.
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MultiFlo™ FX Multi-Mode Dispenser



Dispense Precision and Accuracy Test Worksheet

96/384-Well Manifold

96-Well Microplate

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ number of wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 3.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
© BioTek® Instruments, Inc.



Evacuation Efficiency Test Worksheet

96/384-Well Manifold
96-Well Plate

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 96): g

Mean Residual Weight <= 0.002 g? q Pass    q Fail

Evacuation Diagnostics Test (check here q if not performed)

Mean OD for the plate (Sum of all wells ÷ 96):

Residual Factor (Mean OD ÷ Mean Residual Weight):

Calculate the Residual Weight for each well: well OD ÷ Residual Factor

Every Residual Weight per well <= 0.002 g? q Yes  q No

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Dispense Precision and Accuracy Test Worksheet

96/384-Well Manifold
384-Well Plate

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ number of wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(mL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:
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Dispense Precision and Accuracy Test Worksheet

6-Well Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 6 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 6.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:
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© BioTek® Instruments, Inc.



Evacuation Efficiency Test Worksheet

6-Well Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 6): g

Mean Residual Weight <= 0.6 g? q Pass    q Fail

Date:

Test Performed By:
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Dispense Precision and Accuracy Test Worksheet

12-Well Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 12 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Evacuation Efficiency Test Worksheet

12-Well Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 12): g

Mean Residual Weight <= 0.15 g? q Pass    q Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Dispense Precision and Accuracy Test Worksheet

24-Well Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 24 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:
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Evacuation Efficiency Test Worksheet

24-Well Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 24): g

Mean Residual Weight <= 0.05 g? q Pass    q Fail

Date:

Test Performed By:
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Dispense Precision and Accuracy Test Worksheet

48-Well Manifold

Serial Number:

Dispense Precision Test

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ 48 wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Dispense Accuracy Test

Total Dispense (Actual) Weight: grams

Expected Weight:
(µL/well x number of wells dispensed)

grams

% Accuracy Error:
(Actual Weight – Expected Weight) ÷  Expected Weight x 100

%

% Accuracy Error must be ≤ ±3.0% c Pass    c Fail

Visual verification that no well varies
considerably from the others

c Pass    c Fail

Date:

Test Performed By:
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Evacuation Efficiency Test Worksheet

48-Well Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 48): g

Mean Residual Weight <= 0.025 g? q Pass    q Fail

Date:

Test Performed By:

MultiFlo FX Qualification Procedures
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Chapter 6

Troubleshooting

This chapter provides guidelines for error recovery and
troubleshooting performance problems.
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Troubleshooting

Error recovery:

First Response: Run a System Test (restart the instrument) to give the instrument
an opportunity to restore its initial settings and communication capability.

LHC Users: Reboot your Computer and Instrument: When you cannot run a
system test, e.g. LHC is not responding, or when running a system test doesn't
resolve the issue, turn off your computer and MultiFlo FX, check all the cabling, i.e.
make sure your serial or USB cable is in good condition and is properly connected
to the PC and instrument, and then, power them on. This should refresh the devices
and reset communication parameters.

Error Codes

To find a specific error code:
l Software Error Codes on page 294 (6000-6200) - protocol errors

l System Error Codes on page 284 (0000-A500) - hardware errors

Most error conditions generate an error message that is displayed on the computer
screen or keypad.

The most common error for new MultiFlo FX users is easily fixed:

306 Peri-pump Pump Cover is open. Close the pump cover and re-run protocol.

To run the Peri-pump, its pump cover must be closed, protecting both the pump
and the operator.

401 Carrier Y motor failed positional verify

If the plate carrier is not installed correctly, this instrument error will be displayed.
Make sure the back right corner of the carrier is correctly seated in the little black
knob attached to the transport rail. A slit on the bottom of the carrier allows it to fit
into place.

BioStack Errors: To recover from a BioStack error, remove the plate from the
BioStack's tray, if applicable, and Home the stacker using the alignment utility:
select Instrument>BioStack from the Home screen. Press BioStack Alignment and
then Home.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You
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can use USB to connect the MultiFlo FX to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Syringe Dispenser Troubleshooting

l Dispense Manifold Movement below

l Fluid Delivery on the next page

l Fluid Leakage on page 276

l Syringe Movement on page 277

l Microplate Carrier Movement on page 276

Startup

Problem Possible Cause What To Do

Syringe or
manifold
position
error.

Syringe or manifold is
being obstructed.

Remove obstruction.

Motor, sensor, or
electrical problem.

Turn instrument off, wait at least 15 seconds, turn
it back on and run a Quick Dispense routine, e.g.
Prime. If the problem persists, contact BioTek
TAC.

Syringe piston not seated
all the way to the bottom
before fastening set
screw.

Reinstall the syringe head.

Dispense Manifold Movement

Problem Possible Cause What To Do

Manifold position
error.

Manifold movement is
blocked.

Increase the Plate Clearance height setting.
Allow at least 1 mm clearance above plate.

Check for/remove any obstructions.

Contact BioTek TAC.
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Fluid Delivery

Problem Possible Cause What To Do

Unable to dispense
fluid.

Inlet tube not connected
at manifold or at bottle.

Check all tubing.

Supply tube inside the
supply bottle is kinked or
disconnected.

Straighten or connect supply tube.
Optimize Performance on page 98

Clogged dispense tubes on
the manifold.

Remove and clean the manifold.

Inlet tube is not connected
to the bottom port of the
syringe.

Connect the inlet tube to the lower
port of the syringe pump.

Outlet tube is not
connected to the top port
of the syringe.

Connect the outlet tube to the top
port of the syringe pump.

Check valve flow direction
is incorrect.

Compare the flow direction of the
check valves, See Syringe
Dispenser Check Valves on page
70.

Check valves are stuck
closed.

Clean or Replace the Check Valves
on page 204

No fluid. Fill bottles with appropriate fluid.

System not primed. Run S-DAY_RINSE once or twice for
one or both syringes.

Highly viscous fluid. Apply a Pump Delay to improve
performance when dispensing highly
viscous fluid, i.e. edit the dispense
or prime step to set a 500 msec.
delay.

Faulty syringe pump. Contact BioTek TAC.

Set screw not tightened
on the syringe pump
piston.

Reinstall the syringe head.

Plate overfills
(floods).

Dispense height too high. Change the Dispense Z-axis position
(height).

MultiFlo™ FX Multi-Mode Dispenser



Troubleshooting | 275

Problem Possible Cause What To Do

Volume too large for the
vessel.

Define a smaller volume.

Dispense rate too fast for
volume selected.

Define a slower dispense rate or
lower volume.

Uneven dispensing of
fluid;
wells not filled.

Clogged dispense tubes on
the dispenser manifold.

Clean the Syringe Dispenser
Manifold on page 201

Manifold or tubing not
adequately primed (air in
fluid lines).

Run a Prime using 20 mL. Follow
with a Dispense: 20 µL per well for
24 strips.

Dispense flow rate too
low.

Define a higher flow rate.

Setscrew not tightened on
the syringe pump piston.

Reinstall the syringe head as
described in Autoclave the Syringe
Head on page 204

32-tube dispense
manifolds are not
dispensing accurately.

Calibrate the Backlash for Syringe
Dispenser on page 212

Highly viscous fluid. Apply a Pump Delay to improve
performance when dispensing highly
viscous fluid, i.e. edit the dispense
or prime step to set a 500 msec.
delay.

Dripping dispense
tubes.

Dispense tubing routed
incorrectly.

The supply bottle tube must connect
to the Syringe’s bottom port.

Fluid jet is off-center
or skewed from 32-
tube SB manifold.

Minute particles of debris
on the end of the tubes.

Brush away any particles from the
end of the tube using a piece of
silicon tubing. Silicon will not flake
off and leave particles behind like
other materials.
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Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from manifold. Defective seals. Maintaining the Syringe Dispenser

Check valves are
leaking.

Clean or Replace the Check
Valves on page 204

Fittings to manifold are
leaking.

Reconnect/reseat the fittings.

Fluid leaking from underneath
the unit.

Defective syringe cup. Contact BioTek TAC.

Leaking syringe seal.

Defective syringe
piston.

Fluid leaking from external
tubing connector.

Worn tubing. Replace tubing.

Defective connector. Contact BioTek TAC.

Microplate Carrier Movement

Problem Possible Cause What To Do

Dispense
tubes not
entering well
correctly.

Microplate not
properly seated or
strips not level.

Reseat microplate carrier, or the plate or strips in
holder.

Make sure the carrier is clean.

Horizontal dispense
position does not align
the tubes in the wells.

Change the X-axis (horizontal) Position in the
protocol.

Dispense tube(s) bent. Push the supplied stylus into the tube and then
gently attempt to straighten the tube using your
fingers. If it remains bent, contact BioTek TAC.

Manifold tilted. Check tubing for twists.

Carrier
position error.

Carrier movement is
blocked.

Check for/remove any obstruction.

Dirty carrier or carrier
rail.

Clean carrier and/or carrier rail.
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Syringe Movement

Problem Possible Cause What To Do

Syringe
position
error.

Syringe movement is blocked. Ensure the 26-pin high-density cable shipped
with the Syringe is connected to the MultiFlo
FX’s rear panel.

Contact BioTek TAC.

Syringe piston not seated all the
way to the bottom before
fastening set screw.

Reinstall the syringe piston and syringe
head.

Peri-pump Troubleshooting

Problem What To Do

Fluid stream
missing wells

Check Tip Holder, make sure it is properly seated in the dispense
arm.
Select the correct Plate Type.

Fluid splashing out
of the wells

Select the correct Plate Type.
Reduce the Flow Rate.
Lower the Dispense Height.

Uneven dispensing Make sure all cassette components are properly seated in their
respective positions. 
Tips are clogged. (See Unclog the Dispense Tips on page 194.)
Recalibrate the Peri-pump Dispense Cassette on page 211.
Replace Peri-pump Dispense Cassette Tubing on page 210.

Dispenser skipping
columns

Check/define the plate map, i.e. See also Advanced Dispense
Options for Peri-pump.

Tips clogging Filter the dispense fluid to 50 microns before dispensing.
Replace the tubing.

Viscous fluids
sticking to tips

Vary the Flow Rate: experiment with different flow rates to
determine which setting best forces fluid to break from the tip.

Cannot
communicate with
computer

Check the cabling.
Select the correct COM Port.
Turn on dispenser; display Main Menu.

Foaming in the Reduce the dispense step’s Flow Rate.
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Problem What To Do

wells

Dispenser crashing
into plate

Increase the Dispense Height/Z-axis for the Syringe dispenser or
Peri-pump.
Increase the Plate Clearance Height.

Washer Troubleshooting

Review these suggestions to correct problems your washer is having:
l Fluid Aspiration below

l Fluid Delivery on page 280

l Fluid Leakage on page 282

Microplate Carrier Movement

Problem Possible Cause What To Do

Aspiration tubes
not entering
wells correctly.

Microplate not
properly seated or
strips not level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the
problem is unresolved, the carrier may have to be
realigned. Contact BioTek TAC.

Aspirate tubes
position is too wide
for a movement.

Change the horizontal, X- or Y-axis aspirate
position in the protocol.

Aspirate tubes
bent.

Contact BioTek TAC.

Cell layer
disruption

Fluid sloshing in
wells disturbs cells

Slow down the plate carrier speed: set the Plate
Carrier Speed in the Instrument utilities to "Slow."

Fluid Aspiration

Problem Possible Cause What To Do

Poor or uneven
aspiration.

Insufficient or no
vacuum.

Firmly seat the waste bottle cover.  Ensure tubing
is connected properly.

Check all external tubing and in-line filter for
kinks or clogs. If you are using an in-line vacuum
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Problem Possible Cause What To Do

filter, it may need to be replaced.

With the vacuum pump on, remove the muffler, if
installed, from the back of the module. Put your
finger over the port; if there is no vacuum,
contact BioTek TAC.

Clogged aspiration
tubes on the washer
manifold.

Clean the Washer Manifolds

Make sure the microplate carrier is level.

Aspirate height
adjustment too high
or too low.

Change the aspiration height (Z-axis position) in
the protocol. Similarly, make sure the Magnet
Adapter Height offset is disabled or not too high.

Vacuum pump
failure.

Contact BioTek TAC.

Uneven
aspiration of
water buffer.
Some wells left
full.

No surfactant in the
buffer, such as
Tween® 20.

Add surfactant to the buffer. If this is not
possible, continue below.

Protocol settings not
optimized.

Optimize protocols to improve evacuation on
page 101

Aspiration tubes not
properly positioned
horizontally in wells.

If none of the tubes are bent, try adjusting the
horizontal aspirate position (X-/Y-axis) in the
protocol.

Microplate not level
in carrier, or strips
not level in holder.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder.
If the problem is unresolved, the carrier may
have to be realigned. Contact BioTek TAC.

Too much
residual left in
wells after
aspiration.

Clogged vacuum
filter.

If you are using an in-line vacuum filter (PN
48146), the filter may need to be cleaned or
replaced.

Waste bottle cover
not properly sealed
or fittings not
properly connected.

Firmly seat the waste bottle stopper.  Make sure
tubing is connected properly.

Manifold out of
alignment or not
moving freely.

Check for obstructions. If none are found, contact
BioTek TAC.

Protocol requires Optimize protocols to improve evacuation on
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Problem Possible Cause What To Do

optimization. page 101.

Aspirate tubes are
bent.

Gently attempt to straighten the tubes using your
fingers. Contact BioTek TAC if the tubes remain
bent.

Fluid Delivery

Problem Possible Cause What To Do

Unable to
dispense
fluid.

Inlet tube not connected. Make sure all tubing is connected properly.
Check all external tubing for kinks or clogs.

Clogged valve Run Quick Prime several times, to try to
unclog valve.

Clogged dispense tubes on
the washer manifold.

Clean the Washer Manifolds

Check-valve flow direction
is incorrect.

Make sure the flow-direction arrows on the check
valves match the actual flow direction.

Check-valves are stuck
closed.

Clean or replace the check-valves. See Clean
or Replace the Check Valves on page 204.

No wash or rinse fluid. Fill bottles with appropriate fluid. Ensure bottles
are clean and do not contain particles or organic
material.

Unable to
dispense
fluid.

System not primed. Large
air pockets in tubing.

Run W-DAY_RINSE multiple times.

Insufficient suction,
clogged tubing, or faulty
valve.

Perform Washer Maintenance; If the problem
persists, contact BioTek TAC.

Plate
overfills
(floods).

Dispense height too high.
The aspirate tubes are too
far above the wells to
prevent overflow.

Lower the dispense height (Z-axis position) in the
protocol.

Dispense flow rate too
low.

Define a higher dispense Flow Rate in the
protocol.

Aspiration tubes hit Manifold may not be properly seated or mounted.
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Problem Possible Cause What To Do

bottom of trough during
Prime or Maintenance.

Contact BioTek TAC.

In-line vacuum filter
plugged.

Replace or remove the in-line vacuum filter.

Loose covers on waste
bottle.

Firmly tighten waste bottle cover.

Dispense rate too fast for
volume selected.

Specify slower dispense Flow Rate or lower
volume.

Faulty vacuum pump. Contact BioTek TAC.

Insufficient or no vacuum. Firmly seat the waste bottle cover.
Check all external tubing for kinks or clogs.
When the program begins, you should be able to
hear the vacuum pump turn on. If it is not turning
on, contact BioTek TAC.
If the vacuum pump turns on, remove the
vacuum tubing from the back of the instrument
and put your finger over the port. If there is no
vacuum, contact BioTek TAC.

Uneven
dispensing
of fluid;
wells not
filled.

Clogged dispense tubes on
the washer manifold.

Clean the Washer Manifolds

Manifold or tubing not
adequately primed.

Run W-DAY_RINSE once or twice.

Dispense flow rate too
low.

Define a higher dispense Flow Rate.

Microplate aspiration
height adjustment too high
or too low.

Change the aspirate height (Z-axis position) in
the protocol.

Dripping
dispense
tubes

Dispense tubing routed
incorrectly.

Connect the fluid supply bottle tube to the bottom
port of the syringe pump. Contact BioTek TAC if
the problem persists.
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Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from
manifold.

Defective seals.

Aspiration tubes
only: vacuum too
low.

Check waste connector tubes; make sure
they are properly connected.
If you are using an in-line vacuum filter,
check the filter for clogging, and replace if
necessary.
Check seal of waste bottle cover.
Check for air leaks in the waste tubing and
bottle.
Use a slower Aspiration Travel Rate.
Enable Continuous Vacuum: During
Protocol (Instrument>Washer)

Uneven (not level)
surface.

Make sure the washer sits on a perfectly
level surface.

Fluid leaking from
underneath the washer
module.

Defective tubing
connector or inlet
tubing.

Contact BioTek TAC.

Leaking valve or
syringe seal.

Contact BioTek TAC.

Fluid leaking from
external tubing
connector.

Defective
connector.

Replace connector.

Worn tubing. Replace tubing or cut back tubing one inch
(to remove worn section).
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A listing of potential error codes and possible solutions for
resolving them.
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System Error Codes

Most of these error conditions require technical expertise to correct. Error code 306
and few other exceptions to this rule are listed with remedies in the
Troubleshooting section. A few other errors may be caused by an obvious
obstruction to a device's movement or insufficient fluid in a supply vessel. Fix
these kinds of errors and restart your instrument to give it an opportunity to clear
the error code.

Contact BioTek Technical Assistance Center (TAC) for assistance.

Code Message What to do

100 Task was aborted Restart instrument if this message is
unexpected.

210, 220 Carrier X motor didn’t find
home opto sensor transition
Carrier X motor didn’t find
autocal jig opto sensor
transition

Clean the plate carrier, rails, and glide
strips, using mild detergent and hot water,
70% isopropyl alcohol or ethanol. Restart
the instrument. If the error occurs again,
contact BioTek TAC.

211, 221 Carrier Y motor didn’t find home
opto sensor transition
Carrier Y motor didn’t find
autocal jig opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

212, 222 Dispense head motor didn’t find
home opto sensor transition;
Dispense head motor didn’t find
autocal jig opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

213 Secondary Peri-pump motor
didn’t find home opto sensor
transition,

Run self test. If error reoccurs, contact
BioTek TAC.

214 Syringe A motor didn’t find
home opto sensor transition

Run self test. If error reoccurs, contact
BioTek TAC.

215 Syringe B motor didn’t find
home opto sensor transition

Run self test. If error reoccurs, contact
BioTek TAC.

216 Peri-pump motor didn’t find
home opto sensor transition

Run self test. If error reoccurs, contact
BioTek TAC.
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Code Message What to do

217 Strip washer syringe motor
didn’t find home opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

218, 228 Aspiration head motor didn’t
find home opto sensor
transitionAspiration head motor
didn’t find autocal jig opto
sensor transition

Run self test. If error reoccurs, contact
BioTek TAC.

219, 229 RAD Y-axis motor didn’t find
home opto sensor transitionRAD
Y-axis motor didn’t find autocal
jig opto sensor transition

Run self test. If error reoccurs, contact
BioTek TAC.

220 Carrier X motor didn’t find
autocal jig optical sensor
transition.

Service Only.
Contact BioTek TAC.

221 Carrier Y motor didn’t find
autocal jig optical sensor
transition.

Service Only.
Contact BioTek TAC.

300 Carrier X motor interlock safety
switch open

Service Only.
Contact BioTek TAC.

301 Carrier Y motor interlock safety
switch open

Service Only.
Contact BioTek TAC.

302 Dispense head motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

303 Secondary Peri-pump motor
interlock safety switch open

Service Only.
Contact BioTek TAC.

304 Syringe A motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

305 Syringe B motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

306 Peri-pump Pump Cover is open Close the pump cover door and rerun the
protocol.

307 Strip washer motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

308 Aspirate head motor interlock
safety switch open

Service Only.
Contact BioTek TAC.
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Code Message What to do

309 RAD Y-axis motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

400 Carrier X motor failed positional
verify

Run self test. If error reoccurs, contact
BioTek TAC.

401 Carrier Y motor failed positional
verify

Run self test. If error reoccurs, contact
BioTek TAC.

402 Dispense head motor failed
positional verify

Run self test. If error reoccurs, contact
BioTek TAC.

403 Secondary Peri-pump motor
failed positional verify

Service Only.
Contact BioTek TAC.

404 Syringe A motor failed
positional verify

Service Only.
Contact BioTek TAC.

405 Syringe B motor failed
positional verify

Service Only.
Contact BioTek TAC.

406 Peri-pump motor failed
positional verify

Service Only.
Contact BioTek TAC.

407 Strip washer syringe motor
failed positional verify

Service Only.
Contact BioTek TAC.

408 Aspirate head motor failed
positional verify

Service Only.
Contact BioTek TAC.

409 RAD Y-axis motor failed
positional verify

Service Only.
Contact BioTek TAC.

600-609 Specified motor currently in use Service Only.
Contact BioTek TAC.

700 -
70F

Invalid motor number specified Service Only.
Contact BioTek TAC.

900 Calibration failed. The
measured or calculated autocal
value is out of tolerance

Service Only.
Contact BioTek TAC.

A00 Invalid plate type selected The currently selected plate type is not
supported with the currently installed or
requested hardware. If this is not the case,
contact BioTek TAC.
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Code Message What to do

C01 Configuration or autocal data
missing

Service Only.
Contact BioTek TAC.

C02 Checksum mismatch -calculated
checksum didn’t match saved
checksum

Service Only.
Contact BioTek TAC.

C03 Configuration parameter out of
range

Service Only.
Contact BioTek TAC.

1001 Bootcode powerup checksum
test failed

Contact BioTek TAC.

1002 Unknown error in bootcode Contact BioTek TAC.

1003 Bootcode page program error Contact BioTek TAC.

1004 Bootcode block size error (not
256)

Contact BioTek TAC.

1005 Invalid processor signature (not
1280,1281,2560,2561)

Contact BioTek TAC.

1006 Bootcode memory exceeded Contact BioTek TAC.

1007 Invalid slave port Contact BioTek TAC.

1008 Invalid response from slave Contact BioTek TAC.

1009 Invalid processor detected Contact BioTek TAC.

1010 Checksum error downloading
basecode

Contact BioTek TAC.

1250 Internal RAM test error on the
UI processor

Contact BioTek TAC.

1251 Internal RAM test error on the
MC processor

Contact BioTek TAC.

1260 Stack test error on the UI Contact BioTek TAC.

1261 Stack test error on the MC Contact BioTek TAC.

1300 Invalid syringe selection Contact BioTek TAC.
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Code Message What to do

1301 Syringe module not connected Make sure the Syringe module is correctly
connected using the new BioTek-provided
serial cable.1302 Syringe initialization error

1303 Syringe sensor not cleared
error

1304 Invalid syringe dispense volume See error 1308 below.

1305 Invalid syringe operation Contact BioTek TAC.

1306 FMEA error on syringe A Contact BioTek TAC.

1307 FMEA error on syringe B Contact BioTek TAC.

1308 Invalid Syringe pre-dispense
volume

Protocol may have been written for a
different type of dispense manifold. Make
sure the Instrument Settings represent the
installed hardware. Modify the protocol to
match.

1309 Invalid Syringe prime volume

1310 Invalid Syringe manifold

1350 Peri-pump (PP) invalid dispense
volume

Contact BioTek TAC.

1351 PP invalid cassette type Change the cassette type to match the
protocol requirement and rerun the protocol.

1352 PP invalid pre-dispense volume Contact BioTek TAC.

1353 Multiple required cassettes Make sure every Peri-pump step in the
protocol calls for the same cassette type. A
conflict was found.

1354 PP pump cover (safety door)
open

Close the pump cover door and rerun the
protocol.

1355 PP not installed If you are trying to run a Secondary Peri-
pump, check the cabling in the back of the
instrument. Otherwise Contact BioTek TAC.

1356 PP Invalid dispense position Contact BioTek TAC.

1357 PP two dispensers are expected Contact BioTek TAC.

1358 PP Half UL not supported 0.5 µL Peri-pump dispensing is not
supported on this instrument.
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Code Message What to do

1359 RAD Technology is not
supported

RAD single-tube and 8-to-1 cassettes are not
supported on this instrument. If the
hardware is properly installed and all cables
are currently plugged in, contact BioTek
TAC.

1401 The waste bottles should be
emptied before continuing

Empty the waste bottles and rerun the
protocol.

1404 Plate type restricted This instrument model or the requested
device does not support the selected plate
type. Edit the protocol to change the plate
type.

1405 Z-axis out of range The requested travel/dispense height cannot
be reached. The conflict may be caused by a
combination of variables, plate type, Plate
Clear or other height settings. Review the
protocol parameters and instrument settings
to identify a correction.

1407 Invalid step type The protocol may have been created for a
different instrument, it is not compatible
with this instrument.

1408 Invalid plate geometry Contact BioTek TAC.

1409 Invalid plate carrier type Contact BioTek TAC.

1412 Tip clearance error Contact BioTek TAC.

1413 AutoPrime in progress Contact BioTek TAC.

1414 AutoPrime aborted Contact BioTek TAC.

1415 AutoPrime value out of range Contact BioTek TAC.

1430 Strip washer syringe pump
FMEA

Contact BioTek TAC.

1431 Strip washer aspirate manifold
not installed

Contact BioTek TAC. Instrument basecode is
not correctly configured.

1432 Strip washer module not
connected

Plug in the strip washer: connect the washer
module to the MultiFlo FX using the supplied
serial cable.

1433 Bad step pointer used to
calculate Z-axis positioning

Contact BioTek TAC.
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Code Message What to do

1440 RAD module not connected. Check the cables that connect the external
Peri-pump and the RAD module to the back
of the instrument. Make sure they are
correctly plugged in.

1441 RAD 8-to-1 bulk-dispensing
cassette Chute Height invalid.

Change the Peri-pump advanced instrument
setting for Chute Height.

1503 Dispense volume error Contact BioTek TAC.

1506 The requested carrier Y-axis
position is out of range

Contact BioTek TAC.

1508 Pre-dispense volume error The specified Pre-dispense volume is invalid
for this plate type. Edit the protocol.

1512 Invalid plate type The specified plate type is not supported
with the current hardware.

1513 Plate type - manifold conflict Change the Plate Type to one supported by
the manifold. Or, check the Instrument
Settings and make sure they match the
physical hardware: Get settings from
instrument.

1600-
160C

The onboard storage space
allocated for this function has
been used up

Use the LHC ”Manage Memory” control to
reallocate space.

160D Not a valid step Contact BioTek TAC.

2400 Parameter limit exceeded Contact BioTek TAC.

4000 Program locked so operation
denied

Contact BioTek TAC.

4010 Program cannot be erased so
delete denied

Contact BioTek TAC.

4020 Bad checksum when reading
program from EEPROM

Contact BioTek TAC.

4030 Program not found Contact BioTek TAC.

4040 Can’t save program because no
space available

Contact BioTek TAC.

4050 Program run canceled by user Restart instrument if this message is
unexpected.
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Code Message What to do

8100 Communications NAK Contact BioTek TAC.

In this 8100 series of communications error codes, the third number, e.g.
81n1, n identifies the source: 0 between PC and instrument; 1 between UI and
MC; and 2 between BioStack and instrument. For example, 8101 is timeout
error in communication between the instrument and the PC, and 8111 is a
timeout error in communication between the internal controllers, UI and MC.

8101
8111

Timeout while waiting for serial
message data

Contact BioTek TAC.

8102 Instrument busy and unable to
process message

Contact BioTek TAC.

8103 Receive buffer overflow error Contact BioTek TAC.

8104 Checksum error Contact BioTek TAC.

8105 Invalid structure type in
byMsgStructure header field

Contact BioTek TAC.

8106 Invalid destination in
byMsgDestination header field

Contact BioTek TAC.

8107 Request object received not
supported by instrument

Contact BioTek TAC.

8108 Message Body size exceeds
max limit

Contact BioTek TAC.

8109 Max number of requests
currently running and cannot
run the latest request

Contact BioTek TAC.

810A No request running when
response request issued

Contact BioTek TAC.

810C Response for outstanding
request not ready yet

Contact BioTek TAC.

810D To communicate with the LHC,
the instrument must be at its
main menu

The LHC can only talk to the instrument
when its main menu is displayed. When the
instrument is busy, for example when
AutoPrime is running, press the Stop button
on the keypad, if desired, to end the current
process and return to the main menu.

810E One or more request
parameters are not valid

Contact BioTek TAC.
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Code Message What to do

810F The command was received
while the software was not
ready to accept that command

Contact BioTek TAC.

A00 Invalid plate type requested Service Only.
Contact BioTek TAC.

A100 -
A10F

Software device not available Service Only.
Contact BioTek TAC.

A200 Version strings for multiple
microprocessors do not match

Service Only.
Contact BioTek TAC.

A301 +5v logic power supply level
error

Service Only.
Contact BioTek TAC.

A302 +24v system/motor power
supply level error

Service Only.
Contact BioTek TAC.

A303 +42v Peri-pump motor power
supply level error

Service Only.
Contact BioTek TAC.

A305 +42v Secondary Peri-pump
motor power supply level error

Service Only.
Contact BioTek TAC.

A400 Malloc failed Service Only.
Contact BioTek TAC.

A500 Multiple tasks attempted to use
display simultaneously

Service Only.
Contact BioTek TAC. 

A600 Serial EEPROM access error Service Only.
Contact BioTek TAC.

A700 Motor truncation error: X axis.
Carrier X-axis motor steps are
being truncated based on the
profile

Service Only.
Contact BioTek TAC.

A701 Motor truncation error: Y axis.
Carrier Y-axis motor steps are
being truncated based on the
profile

Service Only.
Contact BioTek TAC.

A702 Motor truncation error:
Dispense head motor steps are
being truncated based on the
profile

Service Only.
Contact BioTek TAC.
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Code Message What to do

A703 Motor truncation error: external
/secondary Peri-pump motor
steps are being truncated

Service Only.
Contact BioTek TAC.

A704 Motor truncation error: Syringe
A motor steps are being
truncated

Service Only.
Contact BioTek TAC.

A705 Motor truncation error: Syringe
B motor steps are being
truncated

Service Only.
Contact BioTek TAC.

A706 Motor truncation error:
internal/primary Peri-pump
motor steps are being truncated

Service Only.
Contact BioTek TAC.

A707 Motor truncation error: strip
washer syringe motor steps are
being truncated

Service Only.
Contact BioTek TAC.

A708 Motor truncation error: strip
washer aspirate head motor
steps are being truncated

Service Only.
Contact BioTek TAC.

AA30 -
AA38

Motor profile errors Service Only.
Contact BioTek TAC.

AD00 Stack overflow error Service Only.
Contact BioTek TAC.

AF00 Communication error between
UI and MC

Service Only.
Contact BioTek TAC.
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MultiFlo FX Software Error Codes

Generally, these errors are caused by protocol parameters that conflict with the
instrument's onboard settings. The protocol may have been originally created for a
different hardware configuration, the 192-tube wash manifold instead of the 96-
tube, for example.

Error
Code Description Help

6000 General communication error during
download.

See Communication Errors

6001 COM port created by USB converter
no longer active.

See Communication Port

6002 Invalid basecode part number;
instrument is not MultiFlo FX.

Service Only.
Contact BioTek TAC.

6003 Invalid Basecode Data Version;
basecode needs to be updated.

Contact BioTek to obtain latest
basecode.

6004 No rows are selected for the specified
plate type.

Modify the protocol to select a row.

6005 Invalid row selection value (must be
0 or 1).

Contact BioTek TAC.

6006 This instrument can only process 96-
well plates.

The protocol may have been created for
another instrument, change the plate
type or select another protocol.

6007 This instrument can only process
1536-well plates.

6008 The 8-tube Syringe Manifold can only
be used with 96-well plates.

Mismatch between installed hardware
and protocol parameters: change the
plate type or correct the instrument
settings to match the currently installed
hardware.

6009 The 96-tube single wash manifold can
only be used with 96-well plates.

6010 The data is invalid or out-of-range. Service Only.
Contact BioTek TAC.

6011 This step type cannot be
downloaded.

Review the limitations to transferring
protocols to the instrument, See the
LHC Help Topic: Transferring Protocols.
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Error
Code Description Help

6012 Illegal characters in protocol name. See the LHC Help topic: Define a
Protocol.

6013 The protocol name length must be
16 characters or less. 

6014 A 1536 well plate is not supported
by this instrument.

Service Only.
Contact BioTek TAC. 

6015 The specified volume exceeds the
cassette maximum limit.

Modify the volume or change the
cassette type.

6016 The volume is out-of-range. Modify the volume or change the
cassette type.

6017 Invalid flow rate. Learn about the Syringe Dispense Step

6018 Invalid number of
pre-dispenses. Service Only.

Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6019 Invalid horizontal dispense position.

6020 Invalid dispense height.

6021 Invalid plate clear height.

6022 Invalid column selection value
(must be 0 or 1).

6023 Invalid protocol step type.

6024 The Definition String contains
invalid data.

6025 Manifold conflict between protocol
requirements and instrument
configuration.

Change the Washer Manifold or change
the Instrument Setting.

6026 Valve module conflict between
protocol requirements and
instrument configuration.

Make sure the Buffer Switching setting
matches your instrument; see
Instrument Settings.

6027 Syringe module conflict between
protocol requirements and
instrument configuration.

Make sure the Syringe dispenser setting
matches your instrument: see
Instrument Settings.

6028 Filter washer conflict between
protocol requirements and
instrument configuration.

Service Only.
Contact BioTek TAC.

6029 Required cassette does not match Change the cassette type to match the
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Error
Code Description Help

installed cassette.
Using RAD technology cassettes
increases the chance of getting this
error. Be as precise as possible
when using this feature.

protocol requirement and rerun the
protocol.

6030 Invalid cassette type was specified. Service Only.
Contact BioTek TAC.

6031 Cannot use a 96-well plate with a
192-tube manifold.

Modify the Plate Type or Change the
Washer Manifold.

6032 Downloading Protocols is not
supported.

Service Only.
Contact BioTek TAC.

6033 This step is not supported for 1536-
well plates.

Fix the plate type or the Instrument
Settings. A conflict between the plate
type and installed hardware devices has
been detected.
Change the Plate Type to one supported
by the washer/dispenser. Or, click the
Instrument Settings link and make sure
they match the physical hardware: Get
settings from instrument.

6034 The 32-tube Syringe Manifold is
required for 1536-well plates.

6035 The 16-tube Syringe Manifold is
required for 96- and 384-well plates.

6036 The 128-tube Washer Manifold is
required for 1536-well plates.

6037 The 128-tube Washer Manifold can
only be used for 1536-well plates.

6038 This step only applies to 1536-well
plates.

6039 Conflicting column selection. Fix the plate map (selected columns to
dispense to). A protocol parameter may
have been changed after a partial plate
dispense was defined.

6040 Invalid baud rate Service Only.
Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6041 Invalid data bits selection

6042 Invalid stop bits selection

6043 Invalid parity selection
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Error
Code Description Help

6044 Serial port error Fix the COM port setting. Check the
cabling. Click the Port link and use the
drop-down menu to see all active ports.
Customize the Predefined Protocols to
avoid this error in future.
When controlling the BioStack with the
LHC, make sure the instrument's
BioStack setting is Manual.

6045 Serial write error

6046 Serial read error

6047 Checksum error Contact BioTek TAC.

6048 Serial NAK error Make sure the COM port setting is correct
and the cable is properly connected.
Restart the instrument. If error reoccurs,
contact BioTek TAC.

6049 Excess data, or not enough data,
received.

To correct these errors:

l Reset the instrument.

l Check cables, plug in only one
communication cable at a time:
USB or serial.

l Try running a different protocol.
If error reoccurs, contact BioTek TAC.

6050 Invalid message header

6051 Invalid message object

6052 Invalid message body size

6053 Serial message timeout

6054 Port handle error

6055 Read timeout value is invalid.

6056 Unauthorized to open the COM port. Make sure the COM port setting is correct
and the cable is properly connected.
Restart the instrument. If error reoccurs,
contact BioTek TAC.

6057 Out-of-range parameter for the open
port function.

6058 Unable to open the COM port.

6059 Unable to clear the transmission
buffer.

6060 Unable to close the port.

6061 Port is no longer available.

6062 Unhandled exception while
transmitting message.

Contact BioTek TAC

6063 The selected plate type is not allowed
with this protocol step.

Modify the protocol to change the plate
type.
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Error
Code Description Help

6064 The protocol specifies more Peri-
pumps than are available.

The protocol may have been created for a
different instrument. Make sure the
instrument settings match the current
instrument and modify the protocol.

6065 Too few data bytes received from the
instrument.

Contact BioTek TAC.

6067 The type of Syringe pump is not
compatible with the syringe manifold.

Contact BioTek TAC.

6070 Invalid Syringe specified. Service Only.
Contact BioTek TAC.

These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6071 Invalid number of syringe prime
cycles.

6072 Invalid syringe Aspirate Delay value.

6073 Invalid X-axis offset value.

6074 Invalid Y-axis offset value Service Only.
Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6075 Invalid Z-axis offset value

6080 Invalid Peri-pump prime duration Service Only.
Contact BioTek TAC.

These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6085 Invalid minutes:seconds value

6086 Invalid hours:minutes value

6087 'Move carrier home' is required when
duration exceeds 1 minute.

Contact BioTek TAC
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Error
Code Description Help

6088 Invalid Shake/Soak options selected Service Only.
Contact BioTek TAC.

These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6089 Invalid Shake Intensity selected

6090 Invalid Washer buffer selected

6091 Invalid Washer Aspirate Delay value

6092 Invalid Washer Aspirate Travel Rate
value

6093 Invalid Wash Cycles value

6094 Invalid Wash format selected

6095 Invalid Wash Sectors selected

6096  Wash Aspirate Delay value is
required.

6097 Syringe Dispense Volume must be an
integer.

6098 Peri-pump cannot run with the pump
cover open.

Close the pump cover door and rerun the
protocol.

6099 Peri-pump assembly not installed. Physically install the Peri-pump and/or
make sure the instrument settings reflect
the current state.

6160 Strip washer required to perform this
step, but not installed.

Make sure the protocol you are trying to
run is supported by your instrument's
devices.

6161
6162

Strip washer manifold and plate type
are incompatible.
Strip washer doesn't support this
plate type.

Make sure the specified plate type
matches the installed manifold and the
instrument's manifold setting correctly
identifies the installed manifold.

6165 This Peri-pump does not support
single well dispensing.

An external Peri-pump is required for
RAD technology cassettes. Edit the
protocol to use the correct Peri-pump,
i.e. protocols designed for a Primary
pump cannot be run on a Secondary
pump.

6166 This instrument does not support RAD
technology dispensing.

Make sure the protocol you are trying to
run is supported by your instrument's
devices.

BioTek Instruments, Inc.



300 | Appendix A: Error Codes

Error
Code Description Help

6167-
6170

The Syringe manifold does not
support the plate type.

Make sure the specified plate type
matches the installed manifold and the
instrument's manifold setting correctly
identifies the installed manifold.

6171 The installed RAD cassette does not
support this plate type.

Either use a supported plate type, correct
the instrument's cassette type setting or
edit the protocol.
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1536-well plates 98, 134, 165, 168
1536F 134

5

500 nL 105, 155-156

6

6-,12-,24-,48-well plates 134

9

96 Well Cluster Tubes (Corning) 136

A

Accessories 13
Aliquot 153, 222
Aspirate fluid 101

how to delay 144
travel rates 112
Uneven aspiration 279

Assays
Biomagnetic separation 145
Cellular 3, 142
ELISA 3

Autoclave components 190
AutoPrime 178-179

Syringe dispenser 185-186
AutoPrime Interval 179

B

BioStack
Create a protocol 125
How to configure/operate 124
Plates with lids 126, 171

BioStack errors 272
BioTek's Customer Resource Center 26
Bottle holder 60

Bottom Wash 114
BSA 187
Buffer Switching 4

C

Calibration Data 167, 212
Carrier setting 169
Cassette

Calibration 210
Diagram 54
RAD technology 58
Replacement tubing 13
Shorten tubing 61

Cassette Life 19, 22, 199
Cassette Types 19
Cell Wash 111, 142

aspirate rate 112
Strategy to preserve cells 143

Center holder 54
Change

Cassette type 76
Fluids 142
Syringe Manifold 75, 165

Chemiluminescence 3
Cleaning 185, 189, 208

Removing proteins 187
COM Port 73, 120
CW+ Control 142

D

Dead Volume 7, 19, 61, 101, 161
Peri-pump 99

Decontaminate 205
Autoclave 190
Manifold and tubing 208

Deionized water 175, 189
Delay

Protocol 117

Index
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Timer Activated Delay 118
Delay after Dispense 144
Delay Aspiration 144
Delay/pause processing 116
Direct Drain 282
Dispense Cassette 7, 56, 76

diagram 54
Ordering new (PN) 13
shorten tubing 61

Dispense Parameters 103
Dispense Pattern 138
Dispense Precision and Accuracy Test

For 96-tube 253
Dispense Precision Test

For Peri-pump 224
For Syringe dispenser 236

Dispenser comparison 7
Distilled water 175, 189
DNA Probes 3
Download protocols 170
Dripping manifold 282

E

ELISA 3
Error codes 272, 284, 294
Evacuation Efficiency Test

About 250
For 96-tube 254

Evacuation test 254

F

Final Aspirate 101-102
Flanged plates 134
Fluid Leaking 276, 282

G

General Settings 41, 73

H

H2O 175, 189
Half-microliter dispensing 155

Hardware 18
Hardware change detected 96
Highly viscous fluids 162
Hit pick 157
Horizontal aspirate position 278
How it works 153
How To

Change cassette setting 76
Change the plate carrier setting 169
Change the plate clearance setting 170

Humidity limits 18

I

Incubate 117-118
Incubate a plate at room tem-

perature 116
Inline Filter

How to install 71
Instrument Settings

Defining 73
Instrument Utilities 76

AutoPrime 179
IQ-OQ-PQ 13

schedule 217

L

Labware 18
Liquid test solutions 13
Loop 116

Add 116
Low vacuum 278

M

Magnet Height Offset 169
Magnetic bead assays 145
Maintenance 176, 189

Removing proteins 187
Syringe dispenser tubes 185, 202
Wash manifolds 185

Manifold Selection
Syringe 75, 165-166
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Maximum plate height 136
Microplates

supported types 18
Mini-tubes 136

O

Oversized vessels 136

P

Package contents 12
Partial plate 157
Parts listing 12-13
Pause or delay action 116
Pause the procedure 117-118
Perform

BioStack's Nth Plate 127
Perform special process 127
Performance verification

After installation 79
Peri-pump 21

Change the cassette 76
Fixing problems 277
Recommended prime volumes 99
Require specific cassette 155
Reservoir holder 60

Peri-pump Dispense Step 155
Peri-pump Pump Cover 272
Physical Specifications 18
Plate Carrier setting 169

Mini-tubes 136
Plate clearance 136
Plate Clearance setting 169-170
Plate geometry diagram 9
Plate Map 157, 165
Plate Type 9

supported 18
Plates

special handling 134
Plates with lids 126
Port link 120
Power Supply 18

Pre-Dispense 113, 156
Preserve expensive reagents 61, 99, 162
Prevent fluid loss during wash 144
Prime

Peri-pump recommendations 99
Syringe recommendations 101
tips 113

Prime Trough Inserts 59, 186
Priming cups 59
Prompt 117
Protein

Preventing clogging 187
Protocol

dispenser parameters 103
Protocols

Customize 120
Pump Delay 162

Q

QC testing 219
Qualification

Which tests to perform 219
Qualification schedule 217

R

RAD Technology
Cassettes 58
Install 51

Rates
Aspirate travel rate 112
Dispense flow rates 103
Syringe dispenser flow rate 107, 163
Washer flow rates 108

Re-stack plates 127
Recommended priming volumes

Peri-pump 99
Strip washer 99
Syringe 101

Repeat steps 116
Reservoir Holder 60
Residual test 254
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Residual too high 279
Resize 141

window 141
RIA 3
Robotics integrators 125

S

Self-test 218
Serial port 72, 125, 273
Shake intensity 116
Shake/Soak parameters 116
Shipping

Prepare for 210
Size and weight 18
Skip columns/rows 138
Soak 116, 184-185

manifold tubes 185-186
Soak step 116
Solutions

Syringe qualification 236
Special plate carrier 136
Special plate types 9, 134
Specifications 18
Sterilize

autoclave 190
Stop

Control start-stop 116, 118
Storage 210
Strip Washer 20, 23
Syringe Dispense Step 163
Syringe Dispenser

Autoclavable vs. non-autoclavable167
Fixing problems 273
How to set up 68
Recommended prime volumes 101

Syringe Dispenser Settings 166
Syringe Manifold

Change 75, 165
Syringe Prime Step 161
Syringe Settings 75, 165
System Error Codes 284

T

Test solutions 251
Test Solutions

Syringe 236
Tests

which tests to perform 219
Theory of operation 153
Timer 118
Tip guard 54
Tip holder 54
Tip priming 113
Transfer protocols 170
Troubleshooting 272

Instrument Error Codes 284
LHC Error Codes 294
Peri-pump problems 277
Syringe problems 273
Washer problems 278

Tube organizer 54
Tube tensioner 54

U

Upload protocols 170
USB 272
Use BioStack 125

V

Vacuum
Low 278

Vacuum on based on volume 144
Valve module, external

Compatibility with washer models 4
Verification

instrument testing 219

W

Wash
about 141
extra turbulence 114
Gentle, cell wash 142
Magnetic beads 145

MultiFlo™ FX Multi-Mode Dispenser



Washer| 305

Washer
Fixing problems 278
Protocol parameters listing 108
Washer Dispense step 113
Washer Flow Rates 111
Washer Prime step 183

Washer Manifold
AutoPrime 183

Water 175, 189
Well map 157
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MultiFlo FX Chemical Compatibility

Table 1: Material Where Used
# Material Where Used
1 316 Stainless Steel P Steel dispense tips, pump rollers, carrier 

rails, cassette bolts

S 
W

Dispense tubes, syringe piston, cylinder 
head and fittings, check valve spring, 

i t  t b  i t   l  2 Aluminum Instrument main structural plate

P Center Holder, Tube Tensioner, pump 
head, dispense arm

W Aspirate arm

3 Borosilicate Glass S Syringe cylinder, supply bottles 
(autoclavable models only)

4 Brass P Threaded inserts in Center Holder and Tip 
Holder

5 EP (Ethylene 
Propylene)

S 
W

Check-valve o-rings (organic solvent 
tubing set)

6 ETFE (Ethylene 
tetrafluoroethylene)

S Manifold fitting

7 Noryl (PPO) S 
W

Syringe cylinder (non-autoclavable models 
only)

8 Polycarbonate W Plate carrier
P Plate positioning dog, peristaltic pump 

cover latch
9 Polyethylene S 

W
Supply Bottle

10 Polypropylene S 
W

Outlet fitting, fittings in bottles, inline 
fittings

S 
W

Bottle cap and fittings, check valves 
(organic solvent tubing set)

P Molded dispense tips

11 Polystyrene Assay plates

P Peristaltic pump cover

Materials listed as 1-16 in Table 1 are cross-referenced as headings 1-16 in Table 2. Table 1 indicates 
which component contains the material using P for Peri-pump, S for the dual Syringe dispensers and W 
for the washer module.

For your own safety and to ensure the MultiFlo FX’s long life, follow these guidelines when choosing 
compounds to use.

      Important: Avoid continuous contact with harsh chemicals. Best practice is to rinse all components with 
deionized/distilled water after contact with any strong acid, base, or solvent.

P = Peri-pump 
S = Syringe dispensers 
W = Washer 
 



MultiFlo FX Chemical Compatibility Chart

12 PTFE (polytetrafluoro-
ethylene)

S 
W

Syringe seal

13 CPVC (Polyvinyl 
chloride)

S 
W

Manifold

14 Ryton® PPS P Tube Organizer, priming trough, priming 
trough insert, RAD 8-to-1 chute

S 
W

Manifold, manifold plugs, priming trough 
insert

15 Silicone P Tubing
S 
W

Tubing, manifold o-rings, check valve o-
rings

16 Ultem 
(polyetherimide)

P Center Holder, Tube Tensioner, Tip Holder

S 
W

Check-valves

Note: Proper use of vaporized hydrogen peroxide (also known as hydrogen 
peroxide vapor, HPV, and by the trademarked name VHP) in non-
condensing mode is an approved method of decontaminating the 
instrument. 



MultiFlo FX Chemical Compatibility Chart

Table 2: Chemical Compatibility
Key 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
A - No effect 
B - Slight effect

C - Moderate effect

D - Severe effect

ND - No data

Chemical
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Acetic Acid, 5% A B ND D N
D

A A A A A D A D A A A 

Acetic Anhydride A A ND D A ND D D C B D A D A A ND 
Acetonitrile A B A ND C A ND D A A D A D A D* D 
Ammonia 10% A A ND ND N

D
ND A D N

D
A B A B A D D 

Benzyl Alcohol B B A ND B A D ND A A D A D A A ND 
Chloroform A B A B D A D D D C D A D A D D 
Detergents 1% A B A ND A A A A A A A A A A A A 
Dimethylformamide B A A ND B A D D C A D A D A A ND 
DMSO 
(Dimethylsulfoxide) 

A A A ND B C B D A A D A D A C* D 

Ethyl Alcohol 70% A A A A A A A B B A A A B A B A 
Ethylene Oxide B D A D C A A C A D C A C D A ND 
Formaldehyde 37% A B A A A A A A D A ND A A A C A 
Hexane A A A A D A B D A B D A B A D A 
Hydrocholoric Acid 
20% 

D D A D A A A B A B C A A D D A 

Hydrofluoric Acid 
20%

D D ND ND C D C D A A ND A B A D ND 

Hydrogen Peroxide 
10% 

B A A D A A A A A A A A A C A A 

Isopropyl Alcohol 
70% 

A A A A A A A A B A A A B A A A 

Methyl Alcohol 70% A A A A A A A B A A ND A A A A A 
Methylene Chloride B C A A N

D
A D D D B D A D A D D 

Phosphoric Acid 10% D C ND D A A A A A A B A B A C A 

Propylene Glycol B B ND ND N
D

ND ND B A A A A C A A ND 

Sodium Chlorate B C ND ND N
D

A A A N
D

A ND A A A C ND 

Sodium Hydroxide 
20% 

B D A B B A A A A A A A A A A A 

Sodium Hypochlorite 
<20% 

C D A D B A A C A A A A A C B B 

Sodium Hypochlorite 
0.5% 

B D A D B A A C A A A A A C B A 

Sulfuric Acid <10% B B A ND A C A A A A A A A A C A 
Trichloroethylene B D ND ND N

D
A D ND D C D A D A D D 

Virkon 10% A D A ND A ND A A A A A ND A A A ND 

* Exposure to DMSO and Acetonitrile may cause the silicone tubing to 
swell, increasing the volume of fluid dispensed. The magnitude of this 
effect will vary with concentration and exposure. Re-calibration of the 
cassette may be required.
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1-16 represent Materials listed above and in the Where Used List
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